City of Pembroke Pines PL-18-06

Dowling Construction Company

Bid Contact Heywood Dowling Address 905 EAST COAST DRIVE
petedowlingl@comcast.net Atlantic Beach, FL 32233-5425
Ph 904-219-8044

Item # Line Item Notes Unit Price Qty/Unit Attch. Docs

PL-18-06--01-01 Supplier First Offer
Equipment Product
Options: Code:
10mm Sign Make/Model:
Option WATCHFIRE
(Single-
Sided)

$34,997.00 1/each $34,997.00 Y Y

PL-18-06--01-02 Supplier First Offer - $56,302.00 1/each $56,302.00 Y
Equipment Product
Options: Code:
10mm Sign Make/Model:
Option WATCHFIRE
(Double-
Sided)

PL-18-06--01-03 Supplier First Offer
Equipment Product
Options: Code:
15.85mm Make/Model:
Sign Option WATCHFIRE
(Single-
Sided)

$29,485.00 1/each $29,485.00 Y

PL-18-06--01-04 Supplier First Offer
Equipment Product
Options: Code:
15.85mm Make/Model:
Sign Option WATCHFIRE
(Double-
Sided)

$43,857.00 1/each $43,857.00 Y

Lot Total $164,641.00
Item # Line Item  Notes Unit Price Qty/Unit Attch. Docs

PL-18-06--02-01 Total Costof Supplier First Offer - $15,210.00 1/job $15,210.00 Y
Installation of Product
the above Code:
mentioned
Equipment at
the following
sites:
Installation at
Fire Station
79

PL-18-06--02-02 Total Costof Supplier First Offer - $15,210.00 1/job $15,210.00 Y
Installation of Product
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the above
mentioned
Equipment at
the following
sites:
Installation at
Fire Station
99

Code:

City of Pembroke Pines

PL-18-06--02-03

Total Cost of
Installation of
the above
mentioned
Equipment at
the following
sites:
Installation at
Fire Station
69, Fire Dept.
Headquarters

Supplier
Product
Code:

First Offer - $15,210.00 1/job

$15,210.00

PL-18-06--02-04

Total Cost of
Installation of
the above
mentioned
Equipment at
the following
sites:
Installation on
City Right-of-
Way at 129th
Avenue
(Option A)

Supplier
Product
Code:

First Offer - $15,210.00 1/job

$15,210.00

PL-18-06--02-05

Total Cost of
Installation of
the above
mentioned
Equipment at
the following
sites:
Installation at
Fire Station 89
on 129th
Avenue
(Option B)

Supplier
Product
Code:

First Offer - $15,210.00 1/job

$15,210.00

PL-18-06--02-06

3/27/2019

Total Cost of
Installation of
the above
mentioned
Equipment at
the following
sites:
Installation at
the
intersection of

Supplier
Product
Code:

First Offer - $15,210.00 1/job
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City of Pembroke Pines
City Center
Blvd. and SW
103rd Avenue
PL-18-06--02-07 Total Costof Supplier First Offer - $15,210.00 1/job $15,210.00 Y
Installation of Product
the above Code:
mentioned
Equipment at
the following
sites:
Installation at
the Howard C.
Forman
Health Park
Entrance
PL-18-06--02-08 Total Costof Supplier First Offer - $15,210.00 1/job $15,210.00 Y
Installation of Product
the above Code:
mentioned
Equipment at
the following
sites:
Installation at
Pembroke
Lakes Golf
Club
PL-18-06--02-09 Total Costof Supplier First Offer - $11,452.00 1/fee $11,452.00 Y
Installation of Product
the above Code:
mentioned Supplier
Equipmentat Notes:
the following  May vary
sites: depending
Additional on Final
Cost to Contract
provide a Amount.
Payment &
Performance
Bond
Lot Total $133,132.00
Item # Line ltem Notes Unit Price Qty/Unit Attch. Docs
PL-18-06--03-01 Software & Supplier First Offer - $0.00 1/ extended price $0.00 Y
Related Product
Services: Code:
Software
Package Cost
PL-18-06--03-02 Software & Supplier First Offer - $0.00 1/ hour $0.00 Y
Related Product
Services: Code:
Software Number
Design of
Hours: 0
BidSync
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City of Pembroke Pines
PL-18-06--03-03 Software & Supplier First Offer - $0.00 1/ hour $0.00 Y
Related Product
Services: Code:
Software Number
Implementation of
Hours: 0
PL-18-06--03-04 Software & Supplier First Offer - $0.00 1/ hour $0.00 Y
Related Product
Services: Code:
Software Setup Number
of
Hours: 0
PL-18-06--03-05 Software & Supplier First Offer - $0.00 1/ hour $0.00 Y
Related Product
Services: Code:
Software Number
Testing of
Hours: 0
PL-18-06--03-06 Software & Supplier First Offer - $0.00 1/hour $0.00 Y
Related Product
Services: Code:
Software Number
Training of
Hours:0
Lot Total $0.00
Item # Line Item Notes Unit Price Qty/Unit Attch. Docs
PL-18-06--04-01 Software Supplier First Offer - $0.00  1/year $0.00 Y
Support & Product Code:
Maintenance:
Annual
Software
Maintenance
Cost
PL-18-06--04-02 Software Supplier First Offer - $0.00  1/year $0.00 Y
Support & Product Code:
Maintenance: Supplier
Annual Notes: No cost
Customer for annual
Service & software support.
Technical With respect to
Support Cost Customer
Service of the
signs
themselves, non-
Warrenty Work
will be performed
by Local
Watchfire Cert
Tech, Bob Scott,
at a charge of
$375 for the first
2.5HRS + $149
BidSync
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per HR thereafter
plus parts.

Lot Total $0.00

Line Item Notes Unit Price Qty/Unit Attch. Docs

PL-18-06--05-01 Multi-Year Supplier First Offer - 0.00% 1/year 0.00% Y
Customer Product
Service & Code:
Technical Number

Support of
Discount:  Years:0
Customer
Service &
Technical
Support
Discount
Lot Total $0.00
Item # Line Item Notes Unit Price Qty/Unit Attch. Docs
PL-18-06--06-01 Sign Leasing Supplier  First Offer - $0.00 1/year $0.00 Y
Option (If Product
Available): Lease Code:
for Sign at Fire Number
Station 79 of Years:
$0.00
0
Supplier
Notes: No
lease
available
PL-18-06--06-02 Sign Leasing Supplier First Offer - $0.00 1/year $0.00 Y
Option (If Product
Available): Lease Code:
for Sign at Fire Number
i $0.00
Station 99 of Years:
0
Supplier
Notes: NA
PL-18-06--06-03 Sign Leasing Supplier  First Offer - $0.00 1/year $0.00 Y
Option (If Product
Available): Lease Code:
for Sign at Fire Number
i ) $0.00
Station 69, Fire of Years:
Dept. 0
Headquarters Supplier
Notes: NA
PL-18-06--06-04 Sign Leasing Supplier First Offer - 1/year Y
Option (If Product

Available): Lease Code:

for Signat 129th  Number

Avenue of Years:
0
Supplier
Notes: NA
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PL-18-06--06-04-01 Sign Leasing Supplier  First Offer - $0.00  1/year $0.00
Option (If Product
Available): City Code:
Right-of-Way at Number
129th Avenue - of Years:
. ) $0.00
North Side Option 0
Base Item Supplier
Title: Lease for  Notes: NA
Sign at 129th
Avenue
PL-18-06--06-04-02 Sign Leasing Supplier First Offer - $0.00 1/year $0.00
Option (If Product
Available): Fire Code:
Station 89 at Number
129th Avenue - of Years:
, , $0.00
South Side Option 0
Base Item Supplier
Title: Lease for  Notes: NA
Sign at 129th
Avenue
PL-18-06--06-05 Sign Leasing Supplier First Offer - 1/year
Option (If Product
Available): Code:
Roundabout at Number
City Center Blvd.  of Years:
& SW 103rd Ave. 0
Supplier
Notes: NA
PL-18-06--06-05-01  Sign Leasing Supplier First Offer - $0.00 1/year $0.00
Option (If Product
Available): Single- Code:
sided sign at City Number
Center Blvd. & SW of Years:
103rd Ave. 0 $0.00
Base Item Supplier
Title: Roundabout Notes: NA
at City Center
Blvd. & SW 103rd
Ave.
PL-18-06--06-05-02 Sign Leasing Supplier  First Offer - $0.00  1/year $0.00
Option (If Product
Available): Code:
Double-sided sign Number
at City Center of Years:
Blvd. & SW 103rd 0
. $0.00
Ave. Supplier
Base Item Notes: NA
Title: Roundabout
at City Center
Blvd. & SW 103rd
Ave.
PL-18-06--06-06 Sign Leasing Supplier  First Offer - $0.00 1/year $0.00
Option (If Product
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Available): Lease Code:
for Sign at the Number

$0.00
Howard C. of Years:
Forman Health 0
Park Entrance Supplier
Notes: NA
PL-18-06--06-07 Sign Leasing Supplier First Offer - $0.00 1/year $0.00 Y
Option (If Product
Available): Lease Code:
for Sign at the Number
$0.00
Pembroke Lakes of Years:
Golf Club 0
Supplier
Notes: NA

Lot Total $0.00
Supplier Total $297,773.00
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City of Pembroke Pines PL-18-06

Dowling Construction Company

ltem: Equipment Options:10mm Sign Option (Single-Sided)

Attachments

1 TITLE PAGE.docx

2 TAB 1 Table of Contents.docx

4 TAB 2 Letter of Interest P1.pdf

4 TAB 2 Letter of Interest P2.pdf

5 TAB 3 Experience Ability.docx

6 TAB 4 Relevant Similar Projects.docx

7 TAB 5 Firmss Understanding Approach to the Work.docx
8 BID BOND Dowling Const - Pembroke RFPPL-18-06 001.tif
9 DCC Installation Sequence for the Pembroke Project.docx
10 DCC Preliminary Timeline for the Project.docx

11 DCC Vendor Information Form 001.pdf

12 DCC W-9 DOWLING CONSTRUCTION COMPANY 001.pdf
13 Sealed Engineer Drawings - Anchor Rod Theme 190879-003_digsigned.pdf
14 Watchfire Ignite OP Software User Manual.pdf

15 Watchfire Installation Manual.pdf

16 Watchfire LED Comparison to Daktronics.docx

17 Watchfire NTS Testing Report_083016 pdf.pdf

18 Watchfire REFERENCES.xIsx

19 Exceptions, Conditions or Clarifications.docx
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City of Pembroke Pines PL-18-06

Dowling Construction Company

A SIGN SUPPLY & INSTALLATION COMPANY FL STATE CERT CONTRACTOR # CBC006834 / FED GOV CONT # 076772677

TITLE PAGE

RFP # PL-18-06 Digital Signage Fabrication and Installation

March 24, 2019

Dowling Construction Company

Contact Person: Heywood A. Dowling — President
(904) 219-8044 / petedowlingl@comcast.net

905 East Coast Drive, Atlantic Beach, Florida 32233

Phone (904)219-8044 *  Fax (904)247-4936
Email: petedowlingl@comcast.net
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TAB 1-TABLE OF CONTENTS

Tab 2 - Letter of Interest
Tab 3 - Experience & Ability

Tab 4 - Relevant Similar Projects

Tab 5 - Firm’s Understanding and Approach to the Work
Tab 6 — Project Cost (Submitted via BidSync Line Items)
Tab 7 — Other Completed Documents (Uploaded or Filled

10.
11.
12.
13.
14,
15.
16.
17,
18.
19.

and Submitted via BidSync)

Bid Bond

DCC Installation Sequence

DCC Preliminary Timeline
Vendor Information Form

DCC W-9 Form

Sealed Engineering (Preliminary)
Watchfire OP Software Manual
Watchfire Installation Manual
Watchfire vs Daktronics Comparison List
Watchfire NTS Testing Report
Watchfire References

Exceptions, Conditions or Clarifications to our Bid
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City of Pembroke Pines

Dowling Construction Company

A SIGN SUPPLY & INSTALLATION COMPANY FL STATE CERT CONTRACTOR # CBC006834 / FED GOV CONT # 076772677

Letter of Interest

March 23, 2019

THE CITY OF PEMBROKE PINES
Att: Purchasing Division
8300 South Palm Drive
Pembroke Pines, Florida 33025

RE: RFP # PL-18-06 Digital Signage Fabrication and Installation
To Whom It May Concern:

| was initially contacted about this project by Mr. Mark George, former Military Sales Manager
for Stewart Signs and current Sales Consultant for Guthman Signs, a Watchfire Sign Dealer.

When Mark described the scale of this multi-sign job, | was immediately interested because (1)
it’s a good fit for the pace and size of my company, (2) | like contracting with School Districts,
Military Bases and Municipalities and (3) the job is small enough for me to perform the work
mostly with me and a small crew.

Having been a Florida State Certified Contractor (CBC006834) since 1974, we are based in
Northeast Florida, travel to all of our jobs and have managed to fine-tune a logistics plan that
allows us to be competitive with local sign companies.

With nearly 200 LED Signs installed in Florida and on Military Bases throughout the USA, Hawaii
and Puerto Rico over the last 12 years, we are concentrated mostly these days in Florida with
one sign installation coming up in Key West for the Monroe County School District followed by
3 signs for Lucie County Schools and 6 of 30 more Freestanding LED Signs for Pinellas County
Schools.

Sometimes we provide turnkey Sign Contracts including the cost of the sign and sometimes we
only provide installation services. My crew is mostly comprised of family members and others
that have been with me over 25 years. All have been trained by me in OSHA Safety practices
which has led to an excellent Safety Record for many years.

(Continued on P2)
905 East Coast Drive, Atlantic Beach, Florida 32233
Phone (904)219-8044  *  Fax (904)247-4936
Email: petedowlingl @comcast.net
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2

My Personal Credentials are as follows —

Bachelor of Building Construction Degree from the Univ of FL 1973.

30 HR OSHA for General Construction Certificate

OSHA Electrical LockOut / TagOut Certificate

Crane Signalperson & Qualified Crane Rigger Certificate

VOSB - As a Marine Corps Veteran (1967-1970), | currently contract with the DOD via
the System for Award Management (SAM) as a Veteran-Owned Small Business under
DUNS #076772677 [ Cage Code: 6F8A5 / Primary NAICS CODE : 339950.

Note: I did not claim VOSB Preference in this Bid Submittal because | have not registered
also with the Veterans Administration as a VOSB per your requirements.

In addition to my crew, | have trained and built a network of Sign Installation and Maintenance
‘partners’ or subcontractors throughout the state who | can rely on when the case arises.

If we are fortunate enough to be awarded this contract, my Florida State Licensed Electrician
and Sign Repair & Maintenance subcontractor will be Bob Scott, President of Bob Scott Light,
Power and Signs, Inc based in West Park, only 20 minutes from the City of Pembroke Pines. Bob
has been registered & licensed with the City of Pembroke Pines for many years and is a Factory
Certified Watchfire Repair & Maintenance Technician.

Dowling Construction Company has a very good credit rating and my personal FICO score is
around 750. | maintain approximately $ 100,000 in Working Capital to make sure our subs and
suppliers are paid in a timely fashion.

Finally, if we are awarded this job, | will personally commit to performing this multi-sign job
myself with my in-house crew. As the firm’s top level manager, | will be directly accessible by
Mobile Phone or email during and after completion of the contract.

DOWLHNG CONSTRUCTION COMPANY

FL State Lic CBC006834
A Veteran-Owned Small Business
Independent Sign Supplier & Installer

PH (904) 219-8044 / petedowlingl @comcast.net

3/27/2019
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Dowling Construction Company

A SIGN SUPPLY & INSTALLATION COMPANY FL STATE CERT CONTRACTOR # CBC006834 / FED GOV CONT # 076772677

Tab 3 - Experience and Ability

With over 30 years of experience in General Contracting before | entered into the sign
business, we are well-qualified to perform all construction tasks involved in sign installations
from evaluating Land Surveys and Engineering Drawings to Contract Specifications and Permit
Documents.

The Scope of Work specific to this project will require knowledge & experience in site layout,
location of existing underground facilities, formwork & rebar fabrication, excavation, concrete
placement & finishing, installation of the sign itself, activation of the communication system
and connection of the city-supplied electric circuit(s) as well as OSHA-required Maintenance of
Highway Traffic.

The crew | would provide for the this project would be -
Company Staff

Supervisor — Heywood A. Dowling: 40 years experience in all tasks described above.
Lead Carpenter — Mark Bailey: 22 years experience in formwork & concrete work.
Lead Mason — James Mincey: 36 years experience in formwork & concrete work.
Note: In addition to the carpentry & concrete work, both Bailey and Mincey have installed signs
with me for many years.

Non-Staff Support
Electrician (Subcontractor) — Bob Scott: Local Master Electrician & Cert Watchfire Technician
Sign Consultant (Watchfire Factory Rep) — Phil McGary: Watchfire Florida Sales Manager

On this project, Dowling Construction Co would buy the sign from Watchfire and resell it on an
installed basis to the City of Pembroke Pines. Personally, | have installed signs exclusively and
continuously since 2007. One of several people who can attest to that is Mr Mark George,
former Military Sales Manager for Stewart Signs and current Sign Rep for Guthman Signs, a
Watchfire Dealer. Mr George and | worked closely on many sign projects since 2009 or so.

My Sign Manufacturer, Watchfire, has been a US-Based sign manufacturer in Danville, IL since
1932 (87 years total). Their sign diagnostic platform is running 24/7 and their propoduction lead
time from order to delivery is about 5 weeks.

With respect to our proximity to the job, although our home base is not in Broward County,
professional and timely performance of multiple Sign Installations will be just as efficient &
timely as you would see from a local sign installer.

905 East Coast Drive, Atlantic Beach, Florida 32233

Phone (904)219-8044 *  Fax (904)247-4936
Email: petedowlingl@comcast.net
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2

Our record of performance can best be demonstrated by the fact that Dowling Construction Co,
after successfully completing a 4-year, 60 Sign Turnkey Contract for the Pinellas County on
August 2018 for another 2 years with two One-Year Extensions beyond that if needed. | was
and will continue to be personally responsible for all estimating, scheduling, budgeting and
project management of this project.

Finally, our financial stability has been and will continue to be strong for many years. Dowling
Construction Co maintains a strong D & B Business Credit Rating while my personal FICO Score
is about 760.

Prepared by: Heywood A. Dowling —President
DOWLING CONSTRUCTION CO
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City of Pembroke Pines PL-18-06

Dowling Construction Company

A SIGN SUPPLY & INSTALLATION COMPANY FL STATE CERT CONTRACTOR # CBC006834 / FED GOV CONT # 076772677

Tab 4 — Relevant Similar Projects

While we have installed many multiple sign projects throughout the years, most are on military
bases. A few of those are as follows —

1. FtPolk LA - SEVEN Freestanding LED Signs for each of SEVEN Access Control Points
2. Joint Base - Ft Dix / McGuire AFB / NAES Lakehurst NJ — SIX Monument LED Signs
3. Redstone Arsenal AL — THREE Freestanding LED Signs

4. NAS Key West FL — FOUR Freestanding Signs

5. NB San Diego CA — THREE Freestanding Signs

6. NAS Lemoore CA — ONE Monument Sign similar in style to the Pembroke Pines Signs

7. The most relevant and current Project in its fifth year is RFP#18-968-258-SS Electronic
Digital Marquee Signs & Installation for Pinellas County Schools which includes school
signs in St Pete, Clearwater, Largo, Dunedin, Safety Harbor and Tarpon Springs.

Having completed the supply & installation of 60 Freestanding LED Signs for PCSB since
2014, we currently have SIX new signs underway and will soon be awarded SIX more.

Prepared by: Heywood A. Dowling — President
DOWLING CONSTRUCTION CO

905 East Coast Drive, Atlantic Beach, Florida 32233

Phone (904)219-8044 *  Fax (904)247-4936
Email: petedowlingl@comcast.net
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Dowling Construction Company

A SIGN SUPPLY & INSTALLATION COMPANY FL STATE CERT CONTRACTOR # CBC006834 / FED GOV CONT # 076772677

Tab 5

10.
11.
12.
13.
14.
15.
16.

17.

Tab 5 - Firm’s Understanding & Approach to the Work

- Firm’s Understanding and Approach to the Work

Narrative Statement: Please give a brief overview of your methodology and project
implementation plan. What is your standard operating procedure for implementing a
project such as this?

RESPONSE — Aside from negotiating & signing the contract and participating in a pre-
construction meeting with City of Pembroke Project Staff, my SOP for the actual Sign
Installations for ONE Site would be something like this -

GENERAL
Identify a Primary & Secondary City POC with contact info.

Acquire a reliable Land Survey or Plat of the proposed site of the sign from POC..
Acquire the permit.

SITE STUDY & LAYOUT
Meet POCat site and mark the proposed site and sign orientation with WHITE stakes and WHITE spray

paint.

Locate the property line to make sure the proposed site will not be in an unapproved spot on private
property or within a county or state Right-of-Way or Easement.

Meet City Electricians at each site to agree on the details related to the new sign circuit(s).

Order an Underground Locate Ticket (Sunshine 811) to mark all existing underground utilities in the area
of the upcoming foundation excavation.

CONSTRUCTION
Pre-Build formwork assembly with anchor rods, rebar and electrical conduit stub.

Excavate for foundation.

Install formwork assembly.

Call for Foundation Inspection.

Place and finish foundation concrete.

Strip forms and prep for sign set.

Install sign with crane.

Make Final Electrical connections / Energize sign.
Call for Final Inspection.

POST-CONSTRUCTION
Test the sign signal & assist the City Sign Programmer(s) with the Start-Up Process.
Note: Watchfire Rep to oversee this process.

905 East Coast Drive, Atlantic Beach, Florida 32233

Phone (904)219-8044 *  Fax (904)247-4936
Email: petedowlingl@comcast.net
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2. Details and Timeline: Include details of your approach and work plans. Provide a time
schedule that your firm will use to complete the project.
RESPONSE:
Preliminary Timeline for the Project

Based on the assumption that all SEVEN Sites will receive signs, | would schedule the work as follows —

Preliminary Sign Supply and Installation Schedule
WEEK ONE:
1. Immediately upon signing the contract, order all SEVEN Signs. The lead time will be about 9
weeks for each sign to be fabricated and delivered to ONE Staging Area in Pembroke Pines.
2. Have Pre-Construction Meeting with COPP Project Staff.
3. Layout all SEVEN Sign Locations with POC.
WEEK TWO: Get Locates & Install Sign Foundation Alpha.
WEEK THREE: Get Locates & Install Sign Foundation Bravo.
WEEK FOUR: Get Locates & Install Sign Foundation Charlie.
WEEK FIVE: Get Locates & Install Sign Foundation Delta.
WEEK SIX: Get Locates & Install Sign Foundation Echo.
WEEK SEVEN: Get Locates & Install Sign Foundation Fox.
WEEK EIGHT: Get Locates & Install Sign Foundation Golf.
WEEK NINE: Receive Shipment of All SEVEN Signs at Staging area /
/ Install Alpha & Bravo including connections / testing / inspection.
WEEK TEN: Install Charlie & Delta including connections & testing / inspection.
WEEK ELEVEN: Install Echo & Fox including connections & testing / inspection.
WEEK TWELVE: Install Golf including connections & testing / inspection.

- Project Complete -

3. Challenges / Concerns: What are the typical challenges in this type of implementation?
Identify any issues or concerns of significance that may be appropriate.
RESPONSE — My main concern anytime a new foundation is installed is the existence of
a high water table that would create a ‘wet site’ resulting is a cave-in of the excavation
walls. This can easily double the time and cost of foundation work. The existence of
‘wet sites’, clearly an unforeseen condition, will likely result in a Change Order.

4. Product/Market Differentiators: Please describe the product/market differentiators
that distinguish you in the industry and make you capable of competing for this project.
RESPONSE: The Contractor — We stand out because select our projects carefully, we
self-install and are known for meeting customer’s expectations. When
there is a problem, we always solve it fast and keep moving forward.
The Product(s) - The proposed Sign Systems will be fabricated by
Watchfire (LED Signs), WorldWide Signs(Sign Structure) and Gemini
Signs(Channel Letters), three of the highest quality sign manufacturers in
the country.

In addition, please provide a brief statement which explains why your

proposal would be the most effective and beneficial to the City of Pembroke Pines.
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RESPONSE: We would be the most effective because once we are locked onto a project,
we plan, schedule and manage it realistically and enjoy completing it as planned.

5. Platform Technical Requirements:

a. Does the vendor develop and maintain the platform solution in-house or does it resell
another vendor’s solution?
RESPONSE: Watchfire develops all software solutions in house.

b. Where is the cloud-based digital signage CMS software hosted? Is it centrally hosted
or geographically distributed? Please provide a map or list of data center hosting
locations.

RESPONSE: Watchfire uses both Azure and Google server solutions for cloud-based storage.

c. Describe guaranteed availability/up-time. (City desires a 48-hour guarantee to get the
signage back up and running after a failure of any type).
RESPONSE: There are no scheduled downtimes, access will be 24/7.

d. What business continuity/system survivability options are available?
RESPONSE: Need further clarification

e. What happens to service/display screens in the event of a local power or WAN
outage?

RESPONSE: If the sign has power, the last uploaded messages will continue to rotate
through the schedule.

f. Please describe platform security measure. How is call data protected?
RESPONSE: No call data, security is password-based authentication.

6. Platform Maintenance:

a. What is your strategy for upgrades and new releases?
RESPONSE:New release are uploaded to the cloud when available.

b. Is deployment of application changes seamless, non-disruptive, and remote?

Explain the process
RESPONSE:AII releases are automatically uploaded and immediately available to user seamlessly.

d. Please describe remote diagnostics for both the platform and individual client sites.
RESPONSE:Once a day the sign will report back to Watchfire diagnostic server and reports any
failures. If a failure occurs the service provide will be notified.

e. Describe 48-hour guarantee of service and maintenance to restore signage to fully
operational.

RESPONSE: Because our Repair & Maintenance subcontractor, Bob Scott, is based less

than 30 minutes from most of these sign locations, we can respond within 48 hours and

can likely correct a most problems in one trip within that time. However, if the sign
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problem is serious.......... ie lightning strike that fries multiple components, excessive
vandalism, etc........ the restoration process may take longer. For that reason, we cannot
guarantee that every problem can be resolved in 48 hours. As a longtime Factory
Certified Watchfire Technician, Bob maintains a strong inventory of sign parts and he is
prepared to respond as quickly as possible.

Repair & Maintenance Cost - With respect to cost, there will be no charge for problems
covered under the Warranty. For Non-Warranty Service, the charge will be a $375 for
the first 2.5 Hours and $149 per hour thereafter that plus parts.

f. Parts should be stocked for all various components of the digital display locally.
This will ensure repairs or replacement of any damaged parts causing an outage
within 48 hours of the call alerting the bidder for the city of an outage. Are parts
and modules warehoused locally? If not, where?
RESPONSE: Watchfire stocks replacement parts at factory in Illinois. The Local Certified
Watchfire Technician can keep an adequate stock of Spare parts at his shop nearby and/or
the COPP can purchase a back-up set of parts.

g. Is an equipment and software leasing program available?
RESPONSE: No

h. Describe hardware and software upgrade options, and availability and timing.
RESPONSE:Hardware updates not available, software updates available as necessary.

7. Content Management:
a. Please state whether your firm is proposing the Daktronics Venus Control Suite or an

alternate system.
RESPONSE: Alternate system proposed.

b. Is software proprietary or open system?
RESPONSE: software is proprietary.

c. Please disclose any proprietary software used with this installation, and all information
about the software, maintenance and costs. Cost shall also be included in the designated
line item on the BidSync website.
RESPONSE: Watchfire Ignite products are included in sign cost, no ongoing license fees.

d. Please list any industry known third-party control software that the signage hardware is
compatible with, and identify the security protocols available within that software.
RESPONSE:N/a

e. How is the system managed/administered?
RESPONSE:User determines admin on software account.
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f. Please describe Customer Administrator interface.
RESPONSE: When logged into cloud-based account the admin will be recognized
based on their credentials

g. Are there video demos of the user interface that can be provided?
RESPONSE: yes, demos and webinars

h. Is self-service supported?
RESPONSE: yes

i. In the Venus Control Suite (or equal), how are moves, additions, and changes to signage
content performed?

How are these changes tracked and managed based on the users’ levels of security?
. RESPONSE: Alternate software option offered

The City desires to have the ability to assign multiple levels of security to users based on
their assigned roles, to ensure the security of the sign content

J. Please describe real-time reporting options.
RESPONSE: Need clarification.

8. Customer Service and Technical Support:

a. What levels (tiers) of service do you offer and what are the details of each level of service?

RESPONSE: Watchfire does not offer different tier levels of support. Onsite service
providers will be assisted first.

b. Detail the issue resolution process.

RESPONSE: Watchfire technical support, with assistance of our engineering department, when
necessary, to resolve any complex problem.

c. What is your average time to solve a moderate to difficult issue?
RESPONSE: Most issues are resolved same call.

BidSync
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City of Pembroke Pines

THE AMERICAN INSTITUTE OF ARCHITECTS

AIA Document A310

Bid Bond

Bond No.: 346914

KNOW ALL MEN BY THESE PRESENTS, that we Dowling Construction Company

905 East Coast Drive, Atlantic Beach, FL 32233 .
as Principal, hereinafter call the Principal, and Merchants Bonding Company
P.O. Box 14498, Des Moines, lowa 50306-3498

a corporation duly organized under the laws of the State of lowa
as Surety, hereinafter called the Surety, are held and firmly bound unto City of Pembroke Pines FL

as Obligee, hereinafter called the Obligee, in the sum of Five Percent of Bid Amount

Dollars ($ 5 % )
for the payment of which sum well and truly to be made, the said Principal and the said Surety, bind
ourselves, our heirs, executors, administrators, successors and assigns, jointly and severally, firmly by these
presents.

WHEREAS, the Principal has submitted a bid for RFP # PL -18-06 Digital Signage Fabrication & Installation

NOW THEREFORE, if the Obligee shall accept the bid of the Principal and the Principal shall enter into a Contract with
the Obligee in accordance with the terms of such bid, and give such bond or bonds as may be specified in the bidding
or Contract Documents with good and sufficient surety for the faithful performance of such Contract and for the prompt
payment of labor and materials furnished in the prosecution thereof, or in the event of the failure of the Principal to enter
such Contract and give such bond or bonds, if the Principal shall pay to the Obligee the difference not to exceed the
penalty hereof between the amount specified in said bid and such larger amount for which the Obligee may in good faith
contract with another party to perform the Work covered by said bid, then this obligation shall be null and void, otherwise
to remain in full force and effect.

Signed and sealed this 18th day of March 2019 HHX
! ; Dowling Constru'gtion C@ﬁf)aﬁ%
(Witness) & Lj—;? ‘ j (/ /j,:>/’d“\\\

Nori|

Y4 7, T e
f?’(‘ oy f‘&f( F N

Merchants Bonding Company

’z—\/ (Surety) d }Sea/)
I 2

N (Witness)

4 ( Hile B

Benjamin Powell Attorney-in-Faqt

AIA DOCUMENT A3109BID BONDeAIA®® FEBRUARY 1970 ED.® THE AMERICAN
INSTITUTE OF ARCHITECTS, 1735 N.Y. AVE., N.W.,, WASHINGTON D.C. 20006
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Sign Installation Task Sequence (SOP) for a Typical Site

10.
11.
12.
13.
14.
15.
16.

17.

3/27/2019

within the Pembroke Project

GENERAL

Identify a Primary & Secondary City POC with contact info.

Acquire a reliable Land Survey or Plat of the proposed site of the sign.
Acquire the permit.

SITE STUDY & LAYOUT
Meet POC at site and mark the proposed site and sign orientation with WHITE stakes

and WHITE spray paint.

Locate the property line to make sure the proposed site will not in an unapproved spot
on private property or within a county or state Right of Way or Easement.

Meet City Electricians to agree on the details related to the new sign circuit(s).

Order an Underground Locate Ticket (Sunshine 811) to mark all existing underground
utilities in the area of the upcoming foundation excavation.

CONSTRUCTION
Pre-Build formwork assembly with anchor rods, rebar and electrical conduit stub.

Excavate for foundation.

Install formwork assembly.

Call for Foundation Inspection.

Place and finish foundation concrete.

Strip forms and prep for sign set.

Install sign with crane.

Make Final Electrical connections / Energize sign.
Call for Final Inspection.

POST-CONSTRUCTION

Test the sign signal & assist the City Sign Programmer(s) with the Start-Up Process.
Note: Watchfire Rep to oversee this process.
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Preliminary Timeline for the Project

Based on the assumption that all SEVEN Sites will receive signs, | would schedule
the work as follows —

Preliminary Sign Supply and Installation Schedule
WEEK ONE:
1. Immediately upon signing the contract, order all SEVEN Signs. The lead time

will be about 9 weeks for each sign to be fabricated and delivered to ONE
Staging Area in Pembroke Pines.
2. Have Pre-Construction Meeting with COPP Project Staff.
3. Layout all SEVEN Sign Locations with POC.
WEEK TWO: Get Locates & Install Sign Foundation Alpha.
WEEK THREE: Get Locates & Install Sign Foundation Bravo.
WEEK FOUR: Get Locates & Install Sign Foundation Charlie.
WEEK FIVE: Get Locates & Install Sign Foundation Delta.
WEEK SIX: Get Locates & Install Sign Foundation Echo.
WEEK SEVEN: Get Locates & Install Sign Foundation Fox.
WEEK EIGHT: Get Locates & Install Sign Foundation Golf.
WEEK NINE: Receive Shipment of All SEVEN Signs at Staging area /
/ Install Alpha & Bravo including connections / testing / inspection.
WEEK TEN: Install Charlie & Delta including connections & testing / inspection.
WEEK ELEVEN: Install Echo & Fox including connections & testing / inspection.
WEEK TWELVE: Install Golf including connections & testing / inspection.

- Project Complete -
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City of Pembroke Pines PL.18-06
Attachment B

(OFFICE USE ONLY) Vendor number:

Please entirely complete this vendor information form along
with the IRS Form W-9, and upload it to the Bidsync website.

e e 4"
L JOINTS - s-um:nr.x\‘/f\v?;"
winis 404
Y
(7 T\
SR EED >~
=

48 *»
R

Vendor Information Form

Operating Name (Payee) DOWLING CONSTRUCTION COMPANY
Legal Name (as filed with IRS) DOWLING CONSTRUCTION COMPANY
Remit-t) Andress (Fos Payisiits] DOWLING GONSTRUCTION COMPANY
905 East Coast Drive
Atlantic Beach FL 32233
Remit-to Contact Name: Heywood A. Dowling Title: | President
Email Address: petedowling1@comcast.net
Phone #: (904) 219-8044 Fax #
Order-from Address (For purchase orders) | g5 East Coast Drive
Atlantic Beach FL 32233
Order-from Contact Name: Heywood A. Dowling Title: | President
Email Address: petedowling!@comcast.net
Phone #: (904) 219-8044 Fax #
Return-to Address (For product returns) 905 East Coast Drive
Atlantic Beach FL 32233
Return-to Contact Name Heywood A. Dowling Title: | President
Email Address: petedowling1@comcast.net
Phone #: (904) 219-8044 Fax #
Payment Terms: Net 30

Type of Business (please check one and provide Federal Tax identification or social security Number)

[“]1Corporation

[(ISole Proprietorship/Individual
[IPartnership

[CJHealth Care Service Provider

Federal ID Number:
Social Security No.:

LLC - C (C corporation) — S (S corporation) — P (partnership)

[Jother (Specify): l

|

/
/

/

20-0556224

Name & Title of Applicant _HeywoogA. Dowling - P@““M?

Vi 9
7 B / = / /
Signature of Applicant 4 J'\/ Date j /24; / 9
ﬂ P% of 7 Attachment B: Vendor Form and W-9 (Rev. 2018-10)
3/27/2019 : iSyne G



City of Pembroke Pines

on W=9

(Rev. October 2018)

Department of the Treasury
Internal Revenue Service

Request for Taxpayer
Identification Number and Certification

» Go to www.irs.gov/FormW9 for instructions and the latest information.

PL-18-06

Attachment B

Give Form to the
requester. Do not
send to the IRS.

DOWLING CONSTRUCTION COMPANY

1 Name (as shown on your income tax return). Name is required on this line; do not leave this line blank.

2 Business name/disregarded entity name, if different from above

following seven boxes.

[ individual/sole proprietor or O Corporation

single-member LLC

Print or type.

[[] Other (see instructions) »

S Corporation

I:] Limited liability company. Enter the tax classification (C=C corporation, $=S corporation, P=Partnership) »

Note: Check the appropriate box in the line above for the tax classification of the single-member owner. Do not check Exemption from FATCA reporting
LLC if the LLC is classified as a single-member LLC that is disregarded from the owner unless the owner of the LLC is
another LLC that is not disregarded from the owner for U.S. federal tax purposes. Otherwise, a single-member LLC that
is disregarded from the owner should check the appropriate box for the tax classification of its owner.

3 Check appropriate box for federal tax classification of the person whose name is entered on line 1. Check only one of the | 4 Exemptions (codes apply only to

certain entities, not individuals; see
instructions on page 3):

D Partnership D Trust/estate

Exempt payee code (if any)

code (if any)

(Applies to accounts maintained outside the U.S.)

5 Address (number, street, and apt. or suite no.) See instructions.

905 East Coast Drive

See Specific Instructions on page 3.

Requester’s name and address (optional)

6 City, state, and ZIP code
Atlantic Beach FL 32233

7 List account number(s) here (optional)

Taxpayer Identification Number (TIN)

Enter your TIN in the appropriate box. The TIN provided must match the name given on line 1 to avoid
backup withholding. For individuals, this is generally your social security number (SSN). However, for a
resident alien, sole proprietor, or disregarded entity, see the instructions for Part |, later. For other - -
entities, it is your employer identification number (EIN). If you do not have a number, see How to get a

TIN, later.

Note: If the account is in more than one name, see the instructions for line 1. Also see What Name and

Number To Give the Requester for guidelines on whose number to enter.

| Social security number ]

or
Employer identification number |

21 0| -| 0| 5]5|6|2|2|4

Part Il Certification

Under penalties of perjury, | certify that:

1. The number shown on this form is my correct taxpayer identification number (or | am waiting for a number to be issued to me); and
2. 1 am not subject to backup withholding because: (a) | am exempt from backup withholding, or (b) | have not been notified by the Internal Revenue
Service (IRS) that | am subject to backup withholding as a result of a failure to report all interest or dividends, or (c) the IRS has notified me that | am

no longer subject to backup withholding; and
3. lama U.S. citizen or other U.S. person (defined below); and

4. The FATCA code(s) entered on this form (if any) indicating that | am exempt from FATCA reporting is correct.

Certification instructions. You must cross
you have failed to report all interest and di
acquisition or abandonment of secured
other than interest and dividends, yo

t item 2 above if you have been notified by the IRS that you are currently subject to backup withholding because
fden refurn. For real estate transactions, item 2 does not apply. For mortgage interest paid,

contribu an individual retirement arrangement (IRA), and generally, payments
otfrequired i ceytifiedtion, but yO}/m provide your correct TIN. See the instructions for Part Il, later.

Sign Signature of
Here U.S. person b

Lo 178/ >

oaer March 24, 2019

V A
General Instructions )7/

Section references are to the Internal Revenue Code unless otherwise
noted.

Future developments. For the latest information about developments
related to Form W-9 and its instructions, such as legislation enacted
after they were published, go to www.irs.gov/FormWa.

Purpose of Form

An individual or entity (Form W-9 requester) who is required to file an
information return with the IRS must obtain your correct taxpayer
identification number (TIN) which may be your social security number
(SSN), individual taxpayer identification number (ITIN), adoption
taxpayer identification number (ATIN), or employer identification number
(EIN), to report on an information return the amount paid to you, or other
amount reportable on an information return. Examples of information
returns include, but are not limited to, the following.

e Form 1099-INT (interest earned or paid)

e Form 1099-DIV (dividends, including those from stocks or mutual
funds)

e Form 1099-MISC (various types of income, prizes, awards, or gross
proceeds)

e Form 1099-B (stock or mutual fund sales and certain other
transactions by brokers)

» Form 1099-S (proceeds from real estate transactions)

e Form 1099-K (merchant card and third party network transactions)
» Form 1098 (home mortgage interest), 1098-E (student loan interest),
1098-T (tuition)

e Form 1099-C (canceled debt)

» Form 1099-A (acquisition or abandonment of secured property)

Use Form W-9 only if you are a U.S. person (including a resident
alien), to provide your correct TIN.

If you do not return Form W-9 to the requester with a TIN, you might
be subject to backup withholding. See What is backup withholding,
later.

Cat. No. 10231X

3/27/2019
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Citx of Pembroke Pines

PL-18-06

NOTES

* CLIENT - GUTHMAN SIGNS

* 2017 FLORIDA BUILDING CODE 6TH
* 175 MPH WIND SPEED, EXP. C

* (2) POLES, (2) FOOTINGS

CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIO

1.) SEE MANUFACTURERS DRAWINGS FOR
ADDITIONAL DETAILS AND DIMENSIONS.

2.) SIGN CABINET AND CONNECTION
BY GUTHMAN SIGNS.

ED.

NS

AS OUTLINED IN THE 2017 FLORIDA BUILDING CODE (6th ED.) :

CHAPTER 16-LOADS AND FORCES
CHAPTER 17-SPECIAL INSPECTIONS
CHAPTER 18- SOILS AND FOUNDATIONS
CHAPTER 19-CONCRETE

CHAPTER 20-ALUMINUM

CHAPTER 21-MASONRY

CHAPTER 22-STEEL

CHAPTER 23-WOOD

THIS ITEM HAS BEEN ELECTRONICALLY
SIGNED AND SEALED BY DARREN S. ANTLE,
P.E. USING A DIGITAL SIGNATURE AND DATE.
PRINTED COPIES OF THIS DOCUMENT ARE
NOT CONSIDERED SIGNED AND SEALED AND

Digitally

Darren

signed by
Darren Antle
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NOTES

1.) SEE MANUFACTURERS DRAWINGS FOR
ADDITIONAL DETAILS AND DIMENSIONS.
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MONUMENT SIGN (ONE-SIDED) - FRONT ELEVATION

9-3 3/4"
9-0 3/4"
7-6'C-C
| SIGN CLADDING AND
CONNECTIONS TO POLES
BY OTHERS
& \ — HSS 4'x4'x1/4"
~ | g (2 REQD)
N
| | | SADDLEMOUNT
B e S R -~ % SEE DETAILS #2 & 3
1 L SR Y R ON DRAWING 9
z | |
o| & | | — EMCBY WATCHFIRE LED
ol § | |
©| @ | |
\ |
48 [ | V4 ||| EMCCONNECTION
1 % A PO P SEE DETAIL #10N
38 L J B DRAWING 9
| | — HSS 5'x5"x1/4"
| s (2 REQD)
1/8 F —* 1/8 J GRADE
T I e e e e e CTTT——TT]
=l I =] B ElE=
!ﬁ =t ‘@ !ﬁ - Al ANCHOR BOLT
ﬂ: b .  E ﬂ: ? l«/:‘ ] SEE DETAIL #2 ON
Eﬂ “a : 7‘; Eﬂ 4 S DRAWING 8
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R (6) #6 VERTICALS W/ —/| |
3-0'Q #3TIES @ 12" O.C. 3-0'Q
W/ (6) #3 TIES @ 4"
0.C. @ TOP

SCALE: N.T.S.

Citx of Pembroke Pines

NOTES

1.) SEE MANUFACTURERS DRAWINGS FOR
ADDITIONAL DETAILS AND DIMENSIONS.

2.) SIGN CABINET AND CONNECTION
BY GUTHMAN SIGNS.

* CLIENT - GUTHMAN SIGNS

* 2017 FLORIDA BUILDING CODE 6TH ED.
* 175 MPH WIND SPEED, EXP. C

* (2) POLES, (2) FOOTINGS

CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
AS OUTLINED IN THE 2017 FLORIDA BUILDING CODE (6th ED.) :
CHAPTER 16-LOADS AND FORCES

CHAPTER 17-SPECIAL INSPECTIONS

CHAPTER 18- SOILS AND FOUNDATIONS

CHAPTER 19-CONCRETE

CHAPTER 20-ALUMINUM

CHAPTER 21-MASONRY

CHAPTER 22-STEEL

CHAPTER 23-WOOD
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MONUMENT SIGN (ONE-SIDED) - FRONT ELEVATION

9-3 3/4"
9-0 3/4"
7-6'C-C
| SIGN CLADDING AND
CONNECTIONS TO POLES
BY OTHERS
& \ — HSS 4'x4'x1/4"
~ | g (2 REQD)
N
| | | SADDLEMOUNT
B e S R -~ % SEE DETAILS #2 & 3
1 L SR Y R ON DRAWING 9
z | |
o| & | | — EMCBY WATCHFIRE LED
ol § | |
©| @ | |
\ |
48 [ | V4 ||| EMCCONNECTION
1 % A PO P SEE DETAIL #10N
38 L J B DRAWING 9
| | — HSS 5'x5"x1/4"
| s (2 REQD)
1/8 F —* 1/8 J GRADE
T I e e e e e CTTT——TT]
=l I =] B ElE=
!ﬁ =t ‘@ !ﬁ - Al ANCHOR BOLT
ﬂ: b .  E ﬂ: ? l«/:‘ ] SEE DETAIL #2 ON
Eﬂ “a : 7‘; Eﬂ 4 S DRAWING 8
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R (6) #6 VERTICALS W/ —/| |
3-0'Q #3TIES @ 12" O.C. 3-0'Q
W/ (6) #3 TIES @ 4"
0.C. @ TOP

SCALE: N.T.S.

Citx of Pembroke Pines

NOTES

1.) SEE MANUFACTURERS DRAWINGS FOR
ADDITIONAL DETAILS AND DIMENSIONS.

2.) SIGN CABINET AND CONNECTION
BY GUTHMAN SIGNS.

* CLIENT - GUTHMAN SIGNS

* 2017 FLORIDA BUILDING CODE 6TH ED.
* 175 MPH WIND SPEED, EXP. C

* (2) POLES, (2) FOOTINGS

CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
AS OUTLINED IN THE 2017 FLORIDA BUILDING CODE (6th ED.) :
CHAPTER 16-LOADS AND FORCES

CHAPTER 17-SPECIAL INSPECTIONS

CHAPTER 18- SOILS AND FOUNDATIONS

CHAPTER 19-CONCRETE

CHAPTER 20-ALUMINUM

CHAPTER 21-MASONRY

CHAPTER 22-STEEL

CHAPTER 23-WOOD
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Citx of Pembroke Pines

NOTES

9-3 3/4" 1.) SEE MANUFACTURERS DRAWINGS FOR
9.0 3/4" ADDITIONAL DETAILS AND DIMENSIONS.
7-6"C-C 2.) SIGN CABINET AND CONNECTION
BY GUTHMAN SIGNS.
/ SIGN CLADDING AND
CONNECTIONS TO POLES
BY OTHERS * CLIENT - GUTHMAN SIGNS
3 * 2017 FLORIDA BUILDING CODE 6TH ED.
0 I 1 n
o | | ';SF?E‘:;S X1/ * 175 MPH WIND SPEED, EXP. C
” | | = ( ) * (2) POLES, (2) FOOTINGS
‘ J__j /— SADDLE MOUNT CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
j‘_‘Li - e — 71 L:’,: SEE DETAILS #2 & 3 AS OUTLINED IN THE 2017 FLORIDA BUILDING CODE (6th ED.) :
d -4 - [ 4 ON DRAWING 9 CHAPTER 16-LOADS AND FORCES
CHAPTER 17-SPECIAL INSPECTIONS
‘ ‘ CHAPTER 18- SOILS AND FOUNDATIONS
z| . | | CHAPTER 20-ALOMINUM
ol = | \ P EMC BY WATCHFIRE LED CHAPTER 21-MASONRY
S? < CHAPTER 22-STEEL
o| & ‘ | CHAPTER 23-WOOD
\ \
48 [ | Ve || ]| —— EmcconNECTION
1 - e e e SEE DETAIL #10ON
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Citx of Pembroke Pines

10" 9" NOTES
qn g qn 7 1.) SEE MANUFACTURERS DRAWINGS FOR
A BASE PLATE A MATCH PLATE ADDITIONAL DETAILS AND DIMENSIONS.
- \ll\ ul 10510x3/4' T \ll\ u plahunind 2.) SIGN CABINET AND CONNECTION
— C (2 REQ'D) — e (2 REQ'D) :
O O O O BY GUTHMAN SIGNS.
HSS 5'x5'x1/4" HSS 5'x5'x1/4"
z — z P
E ':_) * CLIENT - GUTHMAN SIGNS
Tl ola 3' & ELECTRICAL Tl &~ 2" 3 ELECTRICAL * 2017 FLORIDA BUILDING CODE 6TH ED.
3 HOLE 3 HOLE * 175 MPH WIND SPEED, EXP. C
. * (2) POLES, (2) FOOTINGS
7/8' @ HOLE 78 & HOLE
/ FOR 3/4" 0 F1564 " / FOR 3/4"' @ F1554 CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
O GRADE 36 A.B. 30 O O/ GRADE 36 A.B. 30" é\:,lePuTgr\ﬁD:gAT;::'(\)‘gFlg_ggégA BUILDING CODE (6th ED.) :
: MIN. EMBED. MIN. EMBED. CHAPTER 17-SPECIAL INSPECTIONS
(4 PLCS) (4 PLCS) CHAPTER 18- SOILS AND FOUNDATIONS
/ GUSSET TO PLATE crueren o covcner
GUSSET GUSSET TO TUBE ; 2" CHAPTER 21-MASONRY
SEE DETAIL #5 3/16" 3/16 CHAPTER 22-STEEL
(4 PLCS. ON EACH) TUBE TO PLATE 1/2" i CHAPTER 23-WOOD
TYPICAL BASE PLATE DETAIL (2 REQ'D) 1 TYPICAL LOWER MATCH PLATE (2 REQD) 3
SCALE: N.T.S. SCALE: N.T.S.
) ~=—— GUSSET
3/ ! @ F1 554 E\I 2"X2"X1/ n
GRADE 36 A.B. o'
30" EMBEDMENT
(4 PLCS.) A r MATCH PLATE
\17 / Iy, Q- n c
DOUBLE NUT & _© 9'x9'x3/4 =
WASHER (TYP) O (2 REQD) | /<\
{ HIGH STRENGTH HSS 4'x4'x1/4" 3/8' CHAMFER
X4"X
o " = —
= | = NON-SHRINK GROUT &
|:I—: < |Z_> GUSSET DETAIL (BASE PLATE & UPPER MATCH PLATE) 5
) NS 2" & ELECTRICAL SoME TS
4 e 3 HOLE
2| 5|8
5| 8|2 . 7/8' @ HOLE
E i p LEVELING / FOR 3/4" @ F1554
:(% NUT O O/ GRADE 36 A.B. 30"
— MIN. EMBED.
(4 PLCS.)
DOUBLE NUT W/ GUSSET GUSSET TO PLATE
WASHER (TYP) SEE DETAIL #5 - GUSSET TO TUBE
(4 PLCS. ON EACH) 3/16 TUBE TO PLATE
TYPICAL ANCHOR BOLT DETAIL 5 TYPICAL UPPER MATCH PLATE (2 REQ'D) 4
SCALE: N.T.S. SCALE: N.T.S.
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Citx of Pembroke Pines

EMC & PRE-INSTALLED
ANGLE BY WATCHFIRE LED

3/8" @ THRU BOLT (8 PLACES, 4 ON
/7 TOP AND 4 ON BOTTOM)

\
\
\ 3'x3"x1/4" STEEL ANGLE
g WELDED TO POLE

\ TYP.
|
|

L HSS 4'X4'X5/16"

\/\

ol OVERTURN

HSS 4'X4"'x5/16"

AR

‘ ANGLES

‘\/\/

~——— 2'x2'x3/16"

L— .375" @ THRU BOLT

NOTES

2.) SIGN CABINET AND CONNECTION
BY GUTHMAN SIGNS.

* CLIENT - GUTHMAN SIGNS

* 2017 FLORIDA BUILDING CODE 6TH ED.
* 175 MPH WIND SPEED, EXP. C

* (2) POLES, (2) FOOTINGS

CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
AS OUTLINED IN THE 2017 FLORIDA BUILDING CODE (6th ED.) :
CHAPTER 16-LOADS AND FORCES

CHAPTER 17-SPECIAL INSPECTIONS

CHAPTER 18- SOILS AND FOUNDATIONS

CHAPTER 19-CONCRETE

CHAPTER 20-ALUMINUM

CHAPTER 21-MASONRY

CHAPTER 22-STEEL

CHAPTER 23-WOOD

OVERTURN

2'x2"'x3/16"
/ ANGLES _\
|

.375" @ THRU BOLT

HSS 4'X4'x5/16"

1.) SEE MANUFACTURERS DRAWINGS FOR
ADDITIONAL DETAILS AND DIMENSIONS.

3/27/2019
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TYPICAL EMC ATTACHMENT DETAIL 1 TYPICAL SADDLE MOUNT DETAIL (PLAN VIEW) 2 TYPICAL SADDLE MOUNT DETAIL (FRONT VIEW)
SCALE: NTS. SCALE: NTS. SCALE: NTS. (CABINET REMOVED FOR CLARITY)
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Citx of Pembroke Pines PL-18-06
DESIGN SPECIFICATIONS:
REFER TO SIGN COMPANY'S DRAWINGS FOR MORE DETAILS. NG DATA DEFLECTION ANALYSES NOTES
ALL DESIGNS, DETAILING FABRICATION AND CONSTRUCTION SHALL Buiding Code 2017 Florida Buldir Importance Factor, 1 1o Damping Ratio, B 5005 Deflection Limit H/E0 1.) SEE MANUFACTURERS DRAWINGS FOR
. Wind Load Criteria ASCE 7-10 irectionality Factor, K42 0.85 Natural Frequency, ny 3.73 Hz Deflection at 0.7*W 0.73in .
CONFORM TO Wind Speed,\/t 175 mph 'Il?opt);raphynl/::ctt:r, K: 1.0 Guit Effect?:acto:i G 0.85 Deﬂec:ion Rtatio Qf H/136 ADDITIONAL DETA”-S AND DIMENSIONS
2017 FLORIDA BUILDING CODE 6TH ED. Exposure Category C Base Pressure, y(q,/K; 40.0 psf ASD Wind Load Factor,y® 0.6 5 ) SIGN CABINET AND CONNECTION
AC| Wind Pressure Override per Notes: (1) Loading values in chart below are based upon average K , values for each segment. Actual values are .
AISC Jurisdiction Requirement psf calculated on hidden sheet using derived V-M equations. Chart is provided for information purposes only. BY GUTHMAN SIGNS.
(2) Wind directionality (K ;) factor is 0.95 for Single Pole (Round) segments instead of 0.85. The C ; value
AMERICAN WELDING SOCIETY GEOMETRY INPUT Monument: Yes from Fig. 6-21 has been increased by 0.95/0.85 to account for this variation. '
LOCAL BU|LD|NG CODES & ORD|NANCES No. of Poles 2 No. of Footings 2 _ (3) Wind pressures listed below have u!reac'fy been multiplied by the ASD Wind Load Facrori v.
CONCRETE 2500 PSI @ 28 DAYS Section |Location Type Height | Width ::frs:t Area ;::. Centroid K. G I:'A:z:.:: Trisl.‘::|ppw_‘:hpe‘;lre L‘l’wa::nent Trib. F°°‘;:§:r°a‘::w"mm i CLIENT B GUTHMAN SlGNS
STD. STEEL PIPE SECTION: ASTM A53 GRADE B (Fy=35 KSI), U.N.O. 1t 1t 1t sq ft 1t ft ) psf | Factor | kips kft | Factor [ kips k-t * 2017 FLORIDA BUILDING CODE 6TH ED.
STEEL PIPE SECTION (> 20" @): ASTM A252 GRADE 3 (Fy=42 KSI MIN.) U.N.O. 1 Base | Multiple P;Ies w/ Cabinet | 8.25 | 9.31 76.8 83 45 085 [ 145 T 418 0.7 24 10.9 0.7 24 109 * 175 MPH WIND SPEED, EXP. C
HSS ROUND SECTION: ASTM A500 GRADE B (Fy=42 KSl) UN.O. : Nons oo T 55 T 55 Ton T T 5T oo T oo T oo T oo T oo T o0 * (2) POLES, (2) FOOTINGS
HSS SQUARE/RECTANGULAR SECTION: ASTM A500 GRADE B (Fy=46 KSI) 4 None 00 | 83 | 83 | 08 | 146 | 421 | 00 | 00 [ 00 | 00 | 00 | 00
W SHAPES: ASTM A992 (Fy = 50 KSI) Z :2:: g'g 2'3 2'2 gzz 1-22 2;-1 g-g g-g g-g g-g gg g'g CALCULATIONS INCLUDE THE FOLLOWING CONSIDERATIONS
ANCHOR BOLTS: ASTM F1554 GRADE 36 U.N.O. (ALTERNATES GRADE 55 & 105 7 N 00 [ 53 [ 53 [ oss [ 1as [ 42i [ 00 [ 00 [ 00 [ 00 [ 00 | 00 AT 1L OADS b Foreee o IFPING CODE (61 D)
ONEOTION Bt s ASTer asa ( ) 8 CHACTER 1o10ADS ND FORGES
9 one 0.0 83 8.3 085 | 146 | 421 0.0 0.0 0.0 0.0 0.0 0.0 .
THREADED RODS: ASTM A193 GRADE B7 10 Top None 0.0 8.3 8.3 085 | 146 | 421 0.0 0.0 0.0 0.0 0.0 0.0 8::E¥E: ]g_csg,hfnﬁ'ig FOUNDATIONS
STEEL ANGLES, CHANNELS, STRUCTURAL SHAPES & PLATES ASTM A36 C?"E’“’;He"?"'-: 8-22 ;t Ib5”'"'"°‘{°" bZSEdd“PD" averages “‘{"V'-‘i ;A lg-: :A 1g~: 8:2EEE g?-&%"g"\\“gy
RE'NFORC'NG GRADE 60 ASTM A615 olumn Spacing: 7.50 ft Actual base reactions based upon V-M equations: 4 10. .4 10. CHArTen 22:STEE|_
PROVIDE A MINIMUM OF THREE INCHES OF CONCRETE COVER OVER SUPPORT POLE DESIGN SUMMARY MATERIAL = STEEL - - _ _ ' _ CHAPTER 23-WOOD
EMBEDDED STEEL Base Elev cection A l\{lequlred :;ren' th VTaIues ASE It;lowablensntren gth \;alues AS[I’) Unity Ratios Interaction Ratios ctatus
THE CONTRACTOR (INSTALLER) IS RESPONSIBLE FOR THE MEANS & Kips | fip-ft | ip-fi | Tips | Tips | Kip-fr | bipft | daps | 7V | MM T/Te | PfPe | PM|PMAT
METHODS OF CO(NSTRUCT|C))N IN REGARDS TO JOBSITE SAFETY —0%3 HSSGXGX1/4 Strong | 2.4 1709 | 00 | 07 | 369 175 145 430 | 65% | 62.5% | 0.0% | 1.6% | 64.0% | 0.0% ¥4
NO FIELD HEATING FOR BENDING OR CUTTING OF STEEL SHALL BE. 1.92 11SSAXAX1/4 Strong | 1.9 6.5 0.0 05 283 | 108 9.0 512 | 65% | 601% | 00% | 1.0% | 61.1% | 00% | «
0.00 None Stron, 2.4 10.9 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
ALLOWED WITHOUT THE ENGINEER'S APPROVAL. 0.00 None S:rons 24 103 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
0.00 None Stron; 2.4 10.9 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
WELDING ELECTRODES: E70XX 0.00 None S:rons 24 103 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
. 0.00 None Stron, 2.4 10.9 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
ﬁgléavl\\/llégLﬁoslglzLOiﬁ',Aéin\ll:’i PRESSURE ASSUMED: 2000 PSF 0.00 None S:rons 24 103 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
(PASSIVE PRESSURE) ASSUMED AT 150 PSF/FT OF DEPTH. 0.00 None Strong | 2.4 10.9 0.0 0.7 0.0 0.0 0.0 0.0 00% | 00% | 00% | 00% | 00% | 00% | «
ISOLATED LATERAL BEARING FOUNDATIONS FOR SIGNS NOT ADVERSELY AFFECTED 0.00 None Stong [ 24 [ 109 | 00 07 00 0.0 00 | 00 [ oo0% ] oo% | 0o% [ 00% [ 00% [ o0% [ «
A 1/2" MOTION AT THE GROUND SURFACE DUE TO SHORT TERM LATERAL LOADS ELEMENT DESIGN LOCATIONS, LOADS AND DISPLACEMENTS
SHALL BE PERMITTED TO BE DESIGNED USING TWO TIMES THE TABULATED CODE = Elev. Type v, M, T, P, 0.7°0 | 0.7%5 |, Elev. Type v, M, T, P, 0.7*0 | 0.7%5
VALUES. ft : kips | kip-ft | kip-ft | kips |radians| in | fr —— kips | kip-ft | kipft | kips | radians| in
T 0.00 Base Plate 24 | 109 | 00 | 07 | 00 | 00 3 0.00 | Match Plate 2.4 10.9 0.0 0.7 | 0.000 | 0.00
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Sign Configuration

Follow the Auto Configuration instructions on page 2 to quickly configure Ignite.

Job Site Name:

Sales Order Number:

Sign Model: Matrix: Height Width
Sign Faces: O Red O Amber O Color
Sign Controller Type: [ RWF Radio O Broadband DSL
(Ethernet) (Ethernet)
O High Speed Fiber O RWF Walk-Up WPA2 Key:
(Ethernet) (Ethernet)

O Fiber XVS w/Live Video [ Broadband Wireless
(Direct Connect) (Ethernet)

IP Address:

Sign Controller Model: O Model 86 w/ eFlare [ Model BC550 [ Model BC550 w/ B-Hubs

O Model BC750 [ Model BC750 w/ eFlares [ Other:

Specific Features (installed options are check-marked):

O Temp Sensor (standard)
O Paid Software Training™
O Dell PC & Monitor

O Fiber Crossover cables

O Temp Sensor/Photo cell

Other options:
Total Single-phase Electrical Service: Amps [ 120 Volts O 240 Volts
Service per Face: Amps
Sectional signs: Amps per section: 1: 2: 3: 4.

"Most communication methods are packaged with a separate, more detailed manual.
“Schedule convenient, online training at watchfiresigns.com/ist.

3/27/2019 BidSync p. 170



City of Pembroke Pines PL-18

NOILLYHNDIANOD OLNY
404 dN13sS YDINO

Table of Contents
2 Download Ignite OP Software & EasyArt Libraries
3 Quick Setup for Auto Configuration

5 Before You Begin
Introduction
Helpful Hints
Program Elements

NID34 NOA 340439

“Try It Out” Activity Preview
Setting the Date and Time

12 Making Your First Message

Creating a Text Message

IOVSSIN LSHId
HNOA DNDIVIN

Making a Basic Schedule
Updating Your Sign

22 Making More Messages
Importing Images
Importing Animation

:
=
=
wv
RC\
5
w3
m

EasyArt Messages

31 Advanced Topics
Ignite OPx™
Adding Text Boxes
RSS Feeds
The Counter Button
Using the Graphics Tab
Advanced Scheduling

d3idNYAaQY

49 Utility Programs
Using the File Manager
Message Logging

55 Artand Design Guide

Message Design Guidelines

SINYYD0Ud

Effective Color Schemes
Image Resolution
Creating Custom Content
Software Training

61 Additional Information
Quick Message Guides

34aInD NOSIs3a
ANV LYY

Passwords
Basic Terms
Frequently Asked Questions

TVNoOlLIday

Table of Contents | 1

NOILYWYHO4NI

3/27/2019 BidSync p.




3/27/2019

City of Pembroke Pines

PL-18-06

Download Ignite OP Software and EasyArt Libraries

Watchfire Ignite OP Software is available online at www.watchfiresigns.com/IgniteOP.
You'll need your sales order number and a valid email address to access the software and EasyArt libraries.

Save your access credentials so you can return to the portal to download new EasyArt as it is released.

MESSAGES
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4.3

Follow these instructions to download and install Watchfire Ignite OP and EasyArt graphics for your sign.

1. Besure the sign is powered on and your sign communication hardware is connected properly. If the sign does not have

power, or has not yet been installed, you may continue with the software installation procedure, but you will need to select

“Configure Ignite Manually”in the Auto Configuration Wizard. Refer to the inside cover of this manual for your specific

sign configuration.

2. Visit watchfiresigns.com/IgniteOP to download the Ignite OP Installation Package. Once the download completes, open the

file“Ignite_12_02.exe" by double-clicking on it. This will launch a setup wizard which will guide you through installation.

3. Once theinstall completes, the Auto Configuration Window will appear. If the sign is installed and communication hardware is
connected, select the appropriate sign connection method (included in your Ignite manual) to complete the Auto

Configuration process.

After Ignite is configured and is communicating with your sign, download EasyArt graphics files from watchfiresigns.com/

IgniteOP. Once they have downloaded open each folder and click Setup.exe. Then follow the on-screen prompts to

install EasyArt.

5. New EasyArt will be added periodically. Return to watchfiresigns.com/IgniteOP to access the new files for free.

Sales order number can be found on the inside cover of this manual. Account sign up and acceptance of software license terms is
required. A high speed broadband internet connection is recommended.

2 | watchfiresigns.com  800-637-2645
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Quick Setup for Auto Configuration

The Auto Configuration Wizard attempts to connect to the sign in order to download the configuration details from the
sign controller. Follow these simple steps to configure Ignite and connect to the sign.

1. Be sure the sign is turned on. It should be playing a default message.

2. Install Ignite on the host PC. If the sign does not have power, choose Manual Configuration Page, and refer to the
inside cover for Sign Configuration.
Note: Auto Configuration is preferable. If possible, wait for the sign to be powered on.

3. Watchfire offers many communication options. Choose the appropriate sign communication method from the three
options below and follow those instructions.
Note: For RWF Walk-up radio, please see page 31 of the installation manual or the RWF Radio Walk-Up guide (Answer 1544 on watchfiresigns.com/kb).

a. RWEF Radio, High Speed Fiber or HSR: If the sign has High Speed Fiber, RWF Radios or HSR, connect the
equipment to the host PC at this time. The drivers will install automatically. Click the Click Here link on the Auto
Configuration Wizard. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Host Computer

Fiber Fiber Media
Router Converter

Fiber Cable
+—»

High Speed Fiber

Host Computer RF Receiver

RF Transmitter

RWF Radio / HSR

Quick Setup for Auto Configuration | 3
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b. Broadband Wireless, HSR, High Speed Fiber set to a static IP on the network, or RWF Radios that have
been programmed to a static IP on the network: If the sign has Broadband Wireless, HSR, High Speed Fiber or
RWF Radios that have been programmed to a static IP on the network, click Network Connect Page and enter
the static IP. Click Next. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Cellular Antenna

Host Computer

Internet
Connection

Broadband Wireless

Network

Host Computer RF Receiver

RF Transmitter

RWF Radios/HSR Programmed to Static IP on the Network

Host Computer

Fiber Interface Fiber Cable

High Speed Fiber Programmed to Static IP on the Network

¢. Phone Modem: If the sign has phone modem communication, connect the phone line to the host PC modem and
click Phone Connection Page. Select the modem from the drop down menu and enter the phone number with
appropriate prefix and area code. Click Next. The Wizard will attempt to connect to the sign and download the sign
configuration. If communications are established, the Auto Configuration Successful screen will appear. Click Finish.

The communications are now properly configured to schedule messages and update the sign.

4. Once Ignite has been configured for the sign, install the EasyArt Graphics by inserting the included EasyArt disc. The
correct size of EasyArt will be installed.

If the Ignite Auto Configuration Wizard fails to connect to the sign, the Auto Configuration Failed message will appear.
Check connections and power to the communication equipment and be sure the sign is playing a message before
clicking Retry. If the problem persists, click View Log and review the error messages for possible solutions. View the
“Troubleshooting Auto Configuration” help answer on watchfiresigns.com/kb for further steps.

4 | watchfiresigns.com  800-637-2645
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Before You Begin

Introduction

Helpful Hints
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Program Elements

Message Editor Toolbar

O VW 00 N O

“Try It Out” Activity Preview
11 Setting the Date and Time

QUICKTIPS - Be sure to check this section on each page for even more useful information and time saving tips.

BE AN EXPLORER - Take time to explore each of the sections and experiment with the different features of Ignite so
that creating content for your sign will become an enjoyable experience for you and a key tool
for your organization.

QUICK
TIPS

800-637-2645  watchfiresigns.com | 5
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Introduction

Welcome to Ignite content management system for your new Watchfire® sign. Our powerful, smart Ignite software is an
easy way for you to quickly create your own attractive, professional looking messages and then display them on your sign.
Best of all, computer programming and design experience are not required!

Ignite software helps you to perform three main tasks:

1. Creating and editing messages.
2. Scheduling messages for playback at any time or date.
3. Sending messages and schedules to your Watchfire sign.

Ignite software comes with a large library of professionally designed EasyArt, including graphics, animations and video
clips. This outstanding art collection, available exclusively to Watchfire sign owners, will bring added attention to your
sign, making your business stand out.

Ignite also contains advanced messaging capabilities including importing images and animation files to create your own
custom messages.

This manual is designed to help you to understand some of the basic features of Ignite, and will get you started in
creating quality, eye-catching content for your Watchfire sign.

The Watchfire KnowledgeBase
Our online KnowledgeBase contains many tips, tricks and solutions beyond the scope of this manual. As our experience
grows, we incorporate more content daily. Visit the KB for:

Ignite walkthrough videos

How-to articles on both basic and advanced topics
Troubleshooting guides

Quick access to a Watchfire technician through the Live Chat tab

W=

Visit the KnowledgeBase at watchfiresigns.com/kb.

QUICK
TIPS

6 | watchfiresigns.com 800-637-2645
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Helpful Hints

Congratulations on being chosen to help with the task of putting messages on your Watchfire sign. Before you begin,
here are some helpful hints that will assist you. They will make the time you spend learning how to use your Ignite software
more enjoyable and productive.

Don't worry about whether you will be able to operate your Watchfire sign. It is a lot easier than you think!
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Read the entire manual and follow the “Try It Out” Activities. Our Ignite manual is a quick, easy read and the activities
are easy to follow. If you skip sections, you may miss out on key features of your new sign and Ignite software.

Do the “Try it Out” Activities for each section in order. We have designed them to build on each other.

Experiment with the different tools within Ignite. Hands-on experience is the best way to learn. With a little practice you'll
be on your way to creating a great looking sign in no time!

Once your messages are on the sign, go look at them from several angles and distances if possible. This will give you a
much better idea of what the public sees.

Watch how long each message stays on the sign. Your location and the size of your sign will determine how long someone
passing by your sign will be able to read it. Refer to the Art and Design Guide for useful, time saving guidelines.

Text, graphics and backgrounds will need good color contrast to look their best. The Art and Design Guide will help point
you in the right direction.

As you learn, remember to be realistic and patient. At first you might have success with only basic messages, then build
on your skills through trial and error. You will discover which fonts and graphics communicate well on your sign — and
which don’t. The best way to learn what works is to try something, then update your sign and go have a look.

LET US HELP - Remember, you are not alone. We are here to help if you get stuck.

TECH SUPPORT - e-mail: service@watchfiresigns.com | KnowledgeBase: watchfiresigns.com/kb
Live Chat: watchfiresigns.com/chat

Helpful Hints | 7
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Program Elements

Messages Task List Help Web Help Menu Bar Toolbar
| | | | |
\gnite OP +

poaTs | macs

. MESSAGES
watchfj[g{)

' Quick Start Quick Start ) Cuick Start
T Text Message @ Image Animation
JEERSAGES Messages Buttons
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557y SCHEDULE Crvate @ Open Open
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Message

Message Massage

OPEN RECENT ME5SSAGE
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SIGNS . T|p5
Frant Sign | Back Sign

Messages: Brings you back to the main Messages screen.

Menu Bar: Contains available program commands.

Toolbar: Displays common commands for quick access.

Message Buttons: The six different methods for creating and editing messages are found here.

Task List: Quick access buttons that take you to the three main tasks used for displaying messages on your sign.
Tips: Displays helpful tips to assist in using your sign effectively.

Recent Message Thumbnails: Easy access to your last ten messages.

Help: Opens up the local help topics that came with your software.

Web Help: Brings you to the Watchfire KnowledgeBase on the web. Unlike the internal Help pages, the KB is updated
regularly. The KB offers advanced tips, troubleshooting guides and access to a Watchfire tech through the Live Chat option.

DON'T GET LOST - The Messages, Schedule and Update buttons in the toolbar are always available for you to navigate to these three
main tasks. The name of the section you are working in is displayed just below the toolbar.

HELP IS HERE - Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC has Internet
access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire KnowledgeBase!

QUICK
TIPS

8 | watchfiresigns.com  800-637-2645
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Message Editor Toolbar

This is the toolbar that appears when editing any message.
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m
3
Task List Undo Add Copy to Next Spell Checker =
| =<
o
- I - c
File Edit | View Insert Draw Message Optiong Help o
- - h 4 _H + o — > “:é:: 5
MESSAGE EDITOR |HHAPPY BRTHDAY BILL | EBLOOD DRIVE TOMORROW | Eflew Message 3 %]
) | | | |
Current Message Open Messages Insert Delete Preview Close Current Message

Task List: These buttons quickly take you to any of the three main screens in Ignite.

New: Quickly create a new message. The new message will open in a new tab.

Open: Open an existing message to edit it.

Undo: Undo the last change.

Cut, Copy and Paste: Cuts, copies or pastes a selected frame. The paste function will overwrite the selected frame.
Add: Adds a blank frame at the end of the message.

Insert: Inserts a blank frame above the selected frame.

Copy Down: Copies the selected frame to the frame below.

Delete: Deletes the selected frame.

Spelling: Runs spellcheck. (Only available in 32bit installations of Ignite.)

Preview: Previews all frames of the current message to see how the message will play on the sign.
Help: Opens the local help article for the Message Editor.

Web Help: Opens the Watchfire KnowledgeBase.

Current Message: The message you are currently editing will have a selected tab.

Open Messages: Any open message can be selected by clicking on its tab.

Close Message: Closes the current message.

Message Editor Toolbar | 9
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“Try It Out” Activity Preview

This manual contains a series of “Try It Out” Activities to guide you through your first experiences with Ignite and help you
understand the capabilities of the software. The activities will give you hands-on experience creating and sending messages
to your sign. They are designed to be done in order with new skills building on ones you have just mastered.

Let’s try a sample “Try It Out” Activity on navigating through Ignite.

Navigating in Ignite
There are three main tasks in the Ignite software: Creating (and editing) Messages, Scheduling
IITRY IT OUTII Messages, and Updating your Sign. Each task has a large button in the Task List area. Each task also
has a smaller corresponding task button in the upper left hand corner of the Toolbar that is always
ACTIVITY available at each point in the program. By using the buttons you can seamlessly jump from one part
of the program to another.

1. Click on the large Messages button in the Task List section at the left of the Messages screen. This is Ignite’s
main screen.

E 2. Click on the Messages button in the upper left hand corner of the toolbar. You will notice nothing happened.
This is because the Messages button on the toolbar and the Messages button on the Task List take you to the
same place; the Messages screen. This is also true of the Schedule buttons and the Update Sign buttons.

@ 3. (Click on the large Schedule button in the Task List section. Now click on the small Schedule button on the
toolbar. They also perform the same function.

H) 4 Clickon the Messages button in the upper left hand corner of the toolbar. Anytime you are not sure where
you are, this button will take you to the Messages screen.

@ 5. Click on the large Create New Message button. You will notice the large buttons are now gone. But if you look
on the toolbar in the upper left hand corner, all three task buttons are still available.

It is Safe to Practice
In order for any message to be displayed on your sign you must carry out the Update Sign step. We will not instruct you
to update your sign with the sample messages you create except in the first section entitled Making Your First Message.

Experiment with different kinds of messages, using different Appear Effects and Hold Effects to achieve variety in your
work. Explore the EasyArt library that comes with your sign, and learn how these pre-made graphics, animations and
video clips can help you create eye-catching content for your sign.

If you have a schedule already prepared, see the Frequently Asked Questions section, for guidelines on saving your
current schedule for recall after your practice session. Try the different ways of listing messages (daily, weekly, and

on specific dates) to get a feel for how they interact with each other. When your practice session is done, follow the
remaining steps to recall your original schedule (if necessary).

START FROM MESSAGES - When you begin a“Try It Out” Activity, click on the Messages button in the upper left hand
corner of the screen so you begin each activity from the Messages screen.

DELETING MESSAGES -« See the note in the File Manager section to delete practice messages and any others you may cre-
ate over time after you are done with them.

QUICK
TIPS

10 | watchfiresigns.com 800-637-2645
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Setting the Date and Time
When your Watchfire sign is started up for the first time, the date and time will need to be correctly set.
1. With Ignite open, begin by clicking Tools in the Menu Bar at the top of the Messages screen.

2. Select Tools > Configuration. You will then see the Configuration Summary screen which lists some details of
your Watchfire sign.
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lgnite Settings
Message Folder: E:\Users\Public\Documents\Watchfire Signs\lgnite11\Messages\L32x80\

Maximum Number of Frames: 500

Sign Controller

I Get Sign Controller Status I Password:

Change Date & Time... |

[

Change Date & Time Button

3. Click Change Date & Time.

4. Enter the current date and time, or click the Current Time button (this option will set the time to match the time
on your computer). Then click OK. Your sign’s date and time are now correctly set!

E 5. Clicking the Messages button in the black toolbar will disconnect from the sign and return you to the
Messages screen.

Set Date & Time ?
Date: | 03/09/2015 il

Time: | 1:1411PM 2

-

(] Cancel

TIME SAVER - Once your sign is installed and the date and time are set for the first time, its back-up system will maintain accurate date
and time during short power outages.

Setting the Date and Time | 11
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Making Your First Message

13 Creating a Text Message
17 Making a Basic Schedule
19 Updating Your Sign

QUICK
TIPS

12 | watchfiresigns.com 800-637-2645
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Creating a Text Message

Ignite’s Message Editor can help you quickly create a simple text message. The editor also makes advanced functions and
customizations readily available.

Using the Message Edito.r is as simple as point, choose, and click. In this fir.st “Try I'F Out”Act.ivity, you IITRY IT OUTII
will learn to create your first message. Simply follow the easy step-by-step instructions provided here. ACTIVITY
Let’s get started making your first message.
@ 1. Click on the Create New Message button on the Messages screen.

2. Type the word “WE'RE" in the text box found in the lower left corner of the screen. Your word should appear in

all capital letters in the Preview Window in the center of the screen. This is the default setting in Ignite because
capital letters are much easier to read from farther away. If WE'RE is not in all capitals, go back and change it.
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3. Now look to the right of the text box. You will find a list of text properties you can change. Each item has a
drop down menu that allows you to modify the text’s appearance.

4. Click on the Font menu and choose Standard Narrow. Notice in both the Preview Window and the Frame List,
the text became narrower. A narrow font lets you get more letters on a line by squeezing the letters together.
Try switching to Watchfire Sans. Now select a font of your choice.

@ Ignite OP - TR
File Edit View Inset Draw Message Options Help

Preview Window

L Frames List
Text | Effects | Background | Graphics | window
Text B i O E Eosl AddTextBox | | Utiiies +
WERE Text Box Layout
Fent Wi Standard v Height 45 2 Properties
Size: 18 w| Color: |3g = Width: 1z A
Shadow: Sihoustte-1 v  Color: |pq -v Top: 0=
Spacing: | 1 Z Left e
= Text Box
Done CAP NUM

5. Make sure your font weight is set to bold. Bold is selected when the B button is selected. The only reason to
not use bold is when trying to squeeze extra letters on a line. Even then, you are better off trying to use a
narrower font before turning off Bold. Bold letters, like capital letters, are easier to read.

QUICK START BUTTONS - Ignite’s Quick Start options are shortcuts that open the message editor in a state ready to create
a Text, Image or Animation message.

Creating a Text Message | 13
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QUICK

10.

11.

12.

13.

14.

16.

17.

TIPS

If you like, you can now adjust the color of the text and the color of the shadow (border) by clicking on the
appropriate drop down menu. You will be able to see the difference between each adjustment in your preview
window and in the frames list.

Click on the Left Justification button. Observe how the text shifts.
Click on the Right Justification button.

Set the Justification back to center for this exercise.

Once you are done making adjustments to the text, click on the Effects tab.

Text | Effects | Background | Graphics | Window

Appear: Change v | Hold: Standard v | Exit Blank w Utilties
Direction: None v | Hold Time: 1=z W

Appear Layer. | All v | Hold Layer: |Text v | TopLayer. |Text W

Appear Speed: | Normal W

First set the Hold Time to 1 s (one second) or longer. In the Appear drop down menu, start at the beginning of
the list and preview each option to see what it does in the Preview Window. An Appear Effect will animate the
frame as it comes on the sign.

Note: If you choose Random Effect, you will not be able to set the Hold or Exit effects. They will become random also.

Once you have previewed all of the options, go back and select Wipe.

Go to the Appear Direction drop down menu and again, preview each option. Once you have previewed all
the options, go back and select East.

Note: Some Appear Effects will not have an Appear Direction.

Now preview the options in the Hold Effect menu. Hold Effects will animate a frame while it is on the sign.

Leave the Hold Time set at 1 s.

Click on the Exit Effect and select Move. Move will give your message a nice transition to the next frame

or message.
Note: The Blank exit effect will blank each frame as it transitions to the next. The Stay effect will hold the current frame as the new one

comes in.

. Click on the Background tab. Use the drop down menu to change the background color. The default

background pattern is a solid fill, but this can be adjusted here.
Click on Add in the black toolbar. This will add a second frame to your message.

Click on the Text tab. Type the word ‘OPEN’and then click Preview in the black toolbar. You will notice the
program has set all the effects properties of the new frame to match those you made in the first frame.

UPPER CASE - Avoid mixed case messages and lower case messages. Use upper case letters whenever possible because
they are much easier to read from farther away.

DELETING FRAMES - You can only delete frames using the delete button on your toolbar. Using the delete key on your
computer’s keyboard will not delete any frames.
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18. Click on Add again. This will add third frame to the list.

@ 19. On the Text tab, click on the Time button. In the pop-up window, select the time format you like best and
then click OK. If you click OK before choosing from the options, it will automatically choose 12-hour time, the

default format.
Note: Always use the time, date or temperature buttons if you want the element to update automatically. If you manually type the time,
for example, into the text box, it will not update automatically.

20. You can select different text properties here if you like.
21. Click on the Effects tab. Set the Effects properties as you like.

22. Click on Add one more time.

@ 23. Click on the Date button and add the day of the week. The Date button—Ilike the Time and Temperature
buttons—will create a frame that changes as the date changes. Be sure the font you choose allows you to view
the entire text, allowing for the longest possible date that may be scheduled to appear. Drag the text box to
the upper-left corner of the frame.
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24. Click on the Temperature button.

If your sign has a temperature sensor, leave Sensor at Sign selected.

If your sign does not have a sensor, select NOAA RSS Feed. Click the Enable button to start Data Link with the
default RSS feed settings. Select the closest airport from the Weather Station dropdown list.

From the menu, select how you want the temperature to appear and click OK. The temperature displayed on
your computer will always be 68°, the placeholder value. The sign itself will read the temperature sensor and
display the correct temperature on your sign, but this information will not be relayed back to your computer.
Drag the temperature box to the lower right corner of the frame.

Note on NOAA feeds: Ignite will support one RSS feed per message. If you would like to draw content from another feed, you will have to
deactivate this feature by clicking on Sensor at Sign as the Temperature Source or create another message. The NOAA RSS Feed feature
requires that the computer be connect to the Internet and run Data Link 24 hours a day. The NOAA feed may provide a placeholder other
than 68.0 at times, but it will often be outdated when shown in Ignite.

? ?
Temperature : Temperature :
Temperature Source: (@) Sensor at Sign Temperature Source: () Sensor at Sign
() NDAA RSS Feed (®) NOAA RSS Feed
Sensor at Sign NOAA RSS Feed
Select the temperature format:
2 Weather Station: Danville, Vermilion County Airport. hd

Fahrenheit:

(@830 (esF  (eaF (68 Select the temperature format:
Celsius: (®) Fahrenheit (53.0) () Celsius (20.0)

‘::'ZUD ‘::'ZUC .:.zunc ‘::'ZU
Mote: The temperature that appears in Ignite is a placeholder. The actual temperature will Nl;tE: e e RSk b Rat Rl Dol Sy
be displayed on the sign. ep the temperature on your sign accurate.

Carce e

SENSOR OR FEED? - |[f your sign has a temperature sensor, it's best to use it instead of a NOAA feed. The nearest NOAA
station is often many miles away.

DO I HAVE A SENSOR? - Check the front inside cover of this manual to see if a temperature sensor was ordered with your sign.

Creating a Text Message | 15
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25. Make any desired text property, effect and background changes.

(]

File

Ignite OP
Edit View Inset Draw Message Options Help

0O ? &

PREVIEW | HELP WEB HELP

Text | Effects | Background | Graphics | Window
Text: i

B
MAR 24 o

Font:

L OmE B

Add TextBox | | Utites v

Text Box Layout
W Standlard hd S |
V| coor E—E]
Shadow: Sihoustte-1 v Color m

Spacing: | 1

sze: |16 idth
Top: o=

Left 1B

Far Help, press F1 CAP NUM

26.

Now click Message on the Menu Bar and click Set Thumbnail Frame. The thumbnail will always default to the
first frame unless you set it differently. If the first frame is the one you want, you can skip this step in the future.

27. Click the Save button in the black toolbar.

28. Name your message and give it a description that will help you find it easily in the future. You can further

distinguish your message by assigning it to a category from the list. You can also create your own category by
typing in the Category field.

29. When done, click Save. This will save the WE'RE OPEN message so we can use it in one of the future exercises.

You did it! You just created your first message. It's just that quick and easy to create basic text messages for your Watchfire
sign using the Message Editor. Now that you have created your first message, it's time to see what it looks like on your sign.

COPY CAT - Inthe Message Editor, each additional new frame will have all of the properties copied from the previous
frame.

HOLD THE SYMBOLS - In your message file name avoid using symbols such as: < >/\? *“|.They can cause the message
to either not work or work improperly.

QUICK
TIPS

Before saving the message, click on the frame you would like to set as the thumbnail image from the frames list.
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Making a Basic Schedule

So, you are ready to try out your new message on your sign? Great! Adding messages to the llTRY IT OUT”
scheduler is necessary before you can update the sign. Let’s create a basic schedule and put it to
work on your sign. In a later section we will discuss in detail all the ways you can schedule messages. ACTIVITY

@ 1. Click the Schedule button on the main Messages screen.

This will open the scheduling section of Ignite. There may be some messages in the scheduler as defaults from
the factory or your sign company. If you wish to keep this schedule, refer to the Frequently Asked Questions
section for information on how to save your existing schedule which can be reloaded later.

@ ignite OF g
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O | -
Wamhﬁfe\o SCHEDULE Mon 305 4/ » (]
iy + Add - - .

TASKLIST Mondwy Mamh 9, 2015

Thars At no messages in the scheduls Tour sign wil b blank

i messaces ey e e Wi

2
% SCHEDULE

3‘? UBDATE SIGN

BN

K 2. Click on a Play List name, if one exists, to highlight it. Click the Remove button to remove that file from the
list. Repeat this step as necessary until your schedule window is empty.

+ 3. Click the Add button at the top of the screen to open the Play List Details window.

@ Play List Details - Empty Play List - All Day, Every Day ?
Review Play List | | Add Remave  Removedl | Reviw Qi
. .
Play List Wwhen | Messages | Easpdnt | Options | Section Tabs
Time & Date
Al Day v
12008M 3 12004M 2
Al Dates v
14 142000 12/31/2999 Details

Days of the Week.
Every Day of the ‘wWeek ]

V5un M Mon ¥ Tues [#Wed [V Thus [V Fii V| 5at

Play List

CUSTOM CATEGORIES - You can create your own custom categories like “MY CUSTOM ART” to help organize the messages
you have created. Simply type your new category name in the Category field under the Save step. Your new category will
now appear on the category list any time you go to save a message!

Making a Basic Schedule | 17
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9.

10.

Notice that

The When tab is where you decide when you want to run your messages. For this exercise, select All Day and
All Dates under the Time & Date section and Every Day of the Week under the Days of the Week section. This
will make your messages play 24 hours a day, every day.

Click the Messages tab to display a list of all available messages, including the one you created in your first
“Try It Out” Activity. The messages are shown in the List view by default. Change this to suit your preference.

Click on the thumbnail of the WE'RE OPEN message you created in the last activity then click the Add button
to add it to the Play List at the left of the window. You can also add messages to the Play List by double-
clicking the file name.

Click the EasyArt tab to display the list of available pre-made animated messages provided with your system.

Scroll down the list to find the Clouds message. Double-click the File Name to add it to the Play List. Scroll
back up and do the same for the Act_Now_Stage message.

Click the Save button in the upper-left corner of the window to create this Play List in the scheduler.

You are now back at the Schedule screen.

the three messages you added to the Play List are grouped together under the heading “Play List A" If you

click the Plus Sign (+) next to the Play List name it will reveal the three messages in the Play List. Click the Minus Sign (-)

to hide the

The brown

messages again.

bar across the timeline indicates that these messages will play All Day, Every Day as indicated in the bar’s label.

By double-clicking on a filename in the schedule, you can open that file in the appropriate message editor. If you double-
click the schedule name, it will open the Playlist Details window.

SCHEDULE
+ Add... -

Wed 3/25 4)» H

/ Edit... v X Remove & Move Up ¥ Maove Down

\Wednesday, Mar

[=IPlay List A
WE'RE OPEN

Clouds L48x112 [EasyAr]
Act_Mow_Stage L48x112 [EasyArt]

Every Day: [l Cst=t Il Weskdays: Dated & Weskdsy=: [l oI

ch 25, 2015 12 am 2:00 4:00 6:00 8:00 10:00 12 pm 2:00 4:00 6:00 8:00 10:00 12 am
923

You have now successfully created your first schedule! Now all you have to do is send your new schedule to your sign.
We'll do that in the next step: Updating Your Sign.

e
—
-

QUICK

TIME & TEMPERATURE - It's a good idea to have a time or a time and temperature message in every schedule. They will
help the public get used to looking at your sign whenever they pass by it.
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Updating Your Sign

Now that you have created a schedule, you are ready to connect to the sign. Your schedule will tell ”TRY IT OUT"
it what messages to run and when. If you do not have a schedule ready to put on your sign, refer to

the Making a Basic Schedule section to set up a schedule. ACTIVITY

@ 1. Begin by clicking the Update Sign button found on the main Messages screen.

1. Type your password into the Password Box. If you haven't set up a sign password yet, refer to the Password
Protect Your Sign section on page 63. Using a sign password is a security best practice.

Front Sign
You are about to update the messages on your sign. If your sign requires a password, enter the
password te connect to your sign. Otherwise, leave the password blank.

Last Successful Update: Tuesday, March 10, 2015 at 9:53 AM
Passwaord: |"""|

Remember Password
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Update All Messages | Cancel |

Select the Remember Password checkbox to automatically fill in your password on this PC only.
2. Click Update All Messages to open the communications window and display the progress of the update.

3. When the update is successful, you will see the message below. If an error occurs, the communications
window will stay open.

Update Successful

'Your sign was successfully updated.

Take a moment to view your new messages on the sign. If you notice any errors, you may need to go back and edit the schedule
or an individual file and update the sign again. If you are happy with your messages, you can exit the Ignite program or continue to
work on new messages.

Congratulations! You have now put your schedule of messages on your Watchfire sign. No matter how simple or intricate
your schedule may be, you will always use this same easy method to update your sign. If possible, we recommend looking
at your sign to be sure your new schedule is running the way you want it to.

Updating Your Sign | 19
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Once your sign has successfully updated, a graph of the estimated drive space usage on the controller will appear
automatically. Just like a computer or a digital camera, there is a limit to how much information your sign can hold. The
File System Usage graph will help you keep track of the available space on your controller.

File System Usage - Back Sign

97.7% of the total file system space is still available.

22,919 KB out of a total of 976,982 KB are in use.

Messages &
System Files Schedules Fonts Freeﬁlace
2,837 KB 20,079 KB 2 KB 954,063 KB
0.3% 2.1% <0.1% 97.7%

Show File System Details

The File System Usage graph breaks the drive space usage into four separate categories.
1. System Files: total drive space consumed by all files that are not message, schedule, or font files.

2. Messages & Schedules: total drive space consumed by messages & schedule (this size is determined from the current

schedule not the actual controller itself).

3. Fonts: total drive space consumed by font files (this size is determined from the current schedule not the actual

controller itself).

4. Free Space: total space available on the controller for additional messages, schedules, and fonts.

You also have the option to see a more detailed analysis of how the available space is being used. The File System Details
report displays the messages, schedule, and fonts in each schedule. Each message, schedule and font file in your current
schedule is listed with the file size and the percentage of drive space it consumes, allowing you to make decisions on

content that will maximize your available space.

Messages & Schedules (6)

Name File Size % Used  Total Size Fonts
t60x180.American Flag Loop
TE0x180 1,377 KB 0.1% 1,379 KB 07stndrd
160%180.April TE0X180 1,276 KB 0.1% 1,278 KB 07stndrd
t60x180.Back To Schoal
TEOX180 1,178 KB 0.1% 1,180 KB 07stndrd
t60x180.Bake Sale TE0x180 1,162 KB 0.1% 1,164 KB 07stndrd
t60x180.Movie Reel T60x180 1,055 KB 0.1% 1,057 KB 07stndrd
schedule <1 KB <0.1% <1 KB

Fonts (1)

Name File Size % Used # Msgs Display Name Font Type

07stndrd 2 KB <0.1% 5 Standard Watchfire

QUICK
TIPS

WATCH YOUR SPACE - Not all messages are created equal when it comes to using up space on your sign controller. Messages
that use animation, TrueType fonts, or large size picture files will fill the controller space more quickly than other messages.

TRUETYPE FONTS - Using just a handful of TrueType fonts among all of your messages will save space too. Once a font is loaded
to the controller, it will be shared to every message that uses it. Using many different TrueType fonts will utilize more space.
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To view the File System Details, simply click the red Show File System Details link at the bottom of the File System Graph.

In addition to the File System Graph and File System Details reports, your Ignite software will also issue a warning if a new
message or schedule will exceed the available space on the controller. Any time you click the Update All Messages button,
Ignite will scan the controller and calculate the remaining available space. If a new message or schedule is too large, the
Controller System File Space Warning will appear automatically.

@ Controller File System Space Warning
Print Your scheduled files are larger than your controller's available file system space. Cancel 2
Click "Cancel” to stop the update process. Proceed
Click "Proceed” to continue the update process. If you proceed, some of your messages
or fonts will not be uploaded and will not play on your sign.

m
. = =
File System Usage 2 =
The current schedule is 6,378 KB over the total available file system space. ; E
u <
Lo
Messages & () (=
System Filas Schedules Fonts Free Space m >
3,330 KB 976,232 KB 3,798 KB Hone
0.3% 99.9% 0.4% 0%

To reduce the size of your scheduled files, try some of the following suggestions:

. Reduce the number of true-type fonts used in the messages.

Reduce the number of large animations.

. Use a single font in messages that currently have many.

. Remove messages that are no longer scheduled to play or are scheduled to play in the future.

Bwre

Hide File System Details v

When the warning box appears, you will have the option to Proceed or Cancel. Choosing Cancel will stop the update,
allowing you to modify your schedule to a file size the controller can accommodate. If you choose Proceed, the update
process will continue, but the system will only send the files that will fit on the controller, meaning some schedule files
will not make it to the controller. In this case, the report will track the files that were and were not uploaded, and the
detailed report will show files that failed to upload in red.

TAKE CONTROL - Remember, when a schedule update experiences an error, the File System Graph WILL NOT display
accurate information. The graph is based on the schedule, not what is actually on the controller. Click Update All Messages
again to attempt a successful update, which will provide accurate information.

Updating Your Sign | 21
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Making More Messages

23 Importing Images
25 Importing Animations

27 EasyArt Messages

QUICK
TIPS
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Importing Images

One of the great features of Ignite content management system is the addition of quick and easy importing wizards. You
can easily add pictures, logos and short animation and video clips to your messages. Let’s try importing an image and
making it into a message you can play on your sign.

We will use a picture for this exercise, it could also be a logo or still art you have found or created. IITRY IT OUTII

Note: Compatible file types include Bitmap, GIF and JPG.
ACTIVITY

@ 1. Click on the Quick Start Image button on the Messages screen of Ignite.

2. Choose a picture to import by clicking the Browse... button. The program will go to the last folder you
imported from. Highlight the image you want and click Open.

Import Image ?
File: Mame: -C:\tulips.ipg Browse... k_

|mpart

Browse Button

Color Conversion: Scaling:
True Calor - Halftone ¥ | | Fil entire frame - keep aspect tatio. w ‘Caneel

[W] Transparent background color

Size Haw': 1948253
Irnage: —_—

S3IDVSSIN
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Source Image

Preview Window

3. You now see your Source Image in the main window and a preview of your image at the bottom of the screen.
Also, notice the frame added to the Frames List along the left side of the window.

CROP BEFORE IMPORTING - ltis easier to scale yourimages down and do any cropping in a photo editing program
before you import them. This will also help the graphic’s final appearance on your sign.

DISPLAYING A LOGO - If you want to import graphics, like a logo, you might want to position your image to just cover part
of the preview window, leaving room for adding text later.

Importing Image | 23
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QUICK

10.

11.

12.

13.

TIPS

Leave the color conversion set on True Color - Halftone (or Grayscale - Halftone) rather than True Color - Color
on Color. You may want to test both settings to see which is best for importing your picture.

Note: When scaling images to fit your sign, the Halftone option blends pixels together creating softer edges; Color on Color removes
pixels which creates sharper edges.

We have provided several Scaling Factors to help manipulate your image. Click through each one and watch
how each setting changes your image on the frame preview.

If you move your mouse pointer over the Source Image, you will notice that it turns into a crosshair. You can
left-click and drag your mouse over the Source Image to define a Selection Rectangle. This crops your Source
Image and makes that portion of your image larger in the Preview Window.

The edges of the Selection Rectangle that you created can be adjusted by clicking and dragging the dashed
line. The preview below will update in real time. Try using a combination of the Selection Rectangle and
Scaling Factors to achieve the look you want in the preview window.

Once you're happy with how the image looks in the preview, click Import.

You can position your image by left-clicking anywhere in the Preview Window (your mouse cursor becomes a
crosshair with four arrowheads) and dragging your mouse. For example, if you wanted to add text to the right
half of your screen, you would drag the image to the left so the right half is black in the preview. You can also
adjust the size of your image by left-clicking on any of the eight Image Positioning Marks (your mouse cursor
becomes a crosshair with two arrowheads) and dragging your mouse.

If you would like to add any text, you may do so now. You could also add the Time, Temperature, or Date by
using the appropriate buttons.

Click on the Effects tab and choose your desired effects.
Click Preview in the black toolbar to see how your message would play on your sign.

Once complete, click on Save in the black toolbar. Give your new message a File Name (and Description or
Category if desired). Click Save. Your message is now ready to schedule.

GRAPHICS FOLDERS - Itisagood idea to create a special folder for storing all of your graphics, pictures, logos and anima-
tions. This way you don't have to hunt for them when you get ready to import.

DESCRIBE WELL - The description field comes in handy when your message contains multiple frames and elements. Add
details to indicate what your message contains so you don't have to sit through a preview in order to figure it out later.
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Importing Animations

One of the best things about your Watchfire sign is its ability to show motion or animation. Your Ignite content
management system came with many pre-made EasyArt animations. You may discover many messages that will be
valuable to your schedule. You may also find that you would like to put an animation on your sign that is not available in
EasyArt. We have included Quick Start Animation in Ignite to help import video files, overlay text, and save them to be

used as new messages.

Note: Import Animation requires an appropriate codec to be installed on your computer to support reading video data from the file. In addition to
the codecs Microsoft ships with Windows, many third party codecs are available to support a wide variety of video file formats. Visit article 706 on the
Watchfire KnowledgeBase for a full list of compatible codecs. (Go to watchfiresigns.com/kb and search 706.)

Be sure you have a video file on your computer ready to go. If you need a video file for this activity, " "
one can be found in the Tutorial Graphics folder within your Ignite installation folder. TRY IT OUT

ACTIVITY

@ 1. Click on the Quick Start Animation button on the Messages screen.

2. Choose a video file to import by clicking the Browse... button. If the file you are searching for does not display
in the dialog, try selecting All Files in the file filter dropdown located near the Open button.

3. Highlight the file you want to use and click Open.

4. You can click the Play button to preview the source file. You can also use the Time Slider to “scrub” back and
forth through the animation/video.
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5. Leave the color conversion set on True Color - Halftone (or Grayscale - Halftone) rather than Color on Color.
The halftone setting will provide the best results most of the time.

6. Click and drag over the Source Image to create a Selection Rectangle if you don't want to use the entire
image. Then choose a Scaling Factor that appears the best. You can view the result in the Preview Window.

Adjust these parameters as necessary.

7. Click Import when you are happy with how the preview looks.

IC«—:I 8. You can overlay text, Time, Temperature or Date by using their buttons. For this exercise, click on the Time
button. Select the format you desire, position it and adjust the font.

9. You'll notice that the Time only appears on the first frame of the animation. Because this would only show for
a brief moment, you need to apply this change to all frames of your animation message. Click on the Utilities
button on the Text tab and select Make Multiple Frames the Same Text Properties.

10. You can choose all of the frames or a range. For this exercise, choose all of the frames and click OK. The change
will be applied to all frames.

11. Click Preview in the black toolbar to view the entire animation message.

HIGH RESOLUTION - If you have a high-resolution animation/video, it is a good idea to scale it down before importing it.

Importing Animations | 25
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12. Once complete, click on Save in the black toolbar. Give your new message a File Name (and Description or
Category if desired). Click Save. Your message is now ready to schedule.

Import Animation ?

File Mame: ogram FilesMlgrite] 24T utorial Graphics\wF_lgnite. Samplewmy| | Browse.. ¢———————+——— Browse Button
Color Conwversion: Scaling: I|-n
Lo S R SasElAS port
True Color - Halftone w  Fillentire frame - keep aspect ratio v |——|
[] Transparent background color  Size Huw!: 3605720 o)
[ | Position animation Play Button

Time Slider

A

g

—— Source Image

Sign Preview: —_—

Preview Window

PREP YOURFILES - If you have long animation files or files that need to be cropped, it is a good idea to correct themin a
video editing program before importing them.

e
—
-

QUICK
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EasyArt Messages

Your Ignite software contains a library of pre-made messages called EasyArt. EasyArt messages are a great way to add
interest to your sign. They also serve as a starting point for creating your own customized messages. You will find that many
of these messages will fit into your schedule just as they are. But in cases where they don't quite fit, many of the EasyArt
messages are designed for simple editing. Several ways of working with them are described in detail in this section.

When you click on the Open EasyArt Message button, a window opens as seen below. Click Category to filter
EasyArt messages by theme. The selector box to the right enables you to see a filtered view of stills, animations
or both. The triangular-shaped Sort Indicator will appear in the column headings area. Clicking on the Column
Name will reverse the sort from A — Z to Z - A and vice versa.

While there are multiple views to choose from, the Details view is recommended while you are learning how to make
maximum use of these animations because it provides the most information.

Search Area Sort Indicator View
@ Open EagyArt 7 |
Search: I{ ‘I Search Sign Size: | 48x 112 W
Category. Al Categaries || Shills And Animations ¥ 3 Vi | Detalls v
—
File Marme Drescription ! [ ate Modified Size  Matrin o E
T 1 ydth_Sisle-s A4TH OF JULY SALE with Firewarks [13/09/15 12:59 P KB 48112 )
4TH OF JULY with firsworks and Liberty MO9G1Z56PM 1086 KE 484112 ":2
TR ath of s ATH OF JUILY with firewarks and Liberty M3/09/15 12:56 PM KR 48112 )
E’F‘Iﬁ'{'ﬂ.&ccept Christ ACCEPT CHRIST with sihouette of man and cross 03/09415 1266 P 1.0BEKE  48:112 '."’1'
Hﬁﬁﬂ;&ccept Christ-s ACCERT CHRIST with silhouette of man and cross 03/09/15 12:56 PK TTKE  48x112
Accepting Applications  ACCEPTIMG APPLICATIONS, magnifying newspaper  03/09/15 12:56 PM 1,066 KB 484112
E@!Accepnng Application... ACCEPTIMNG APPLICATIONS, magnifying newspaper  03/09/15 12:56 PM TTKB  48x112
A Ace ACE with volleyball and playing card 03/09/15 12:56 PM 1,066 KB 484112
[0 F e ACE with vollepball and playing card 03/09/15 12:56 PM KD 484112
B ot Mo Stage ACT MW as animated letters with stage curtain MMOE1ZE6 PN B4OKE 484112
R 4t _Mow_Stages ACT NOW as animated letters with stage curtain 03/09/15 12:56 PM KD 484112
W.Adopm Pet ADOPT A PET with paw prints and wagaing tail 03/09/1512:56 PM 1,066 KB 484112
%@?‘Adnptﬂ\ Pet:s ADOPT A& PET with paw prints and wagging tail 03/09/1512:56 PM TTKB  48:112
i Hose Gauge A hose and gauge OIS 1ZEE PN 1OEGKE 484112
2 i Hose Gauge-s Air hose and gatige M3/09/15 12:56 PM TTEE 48112
gy Airport Shuttle AIRPORT SHUTTLE with bus and plane OIG1Z56PM  1086KE 484112 .
b . e o s s e P e e a e Py ST PP
= Oper Cancel

Preview

EASYART IS SAFE - Don't worry! You cannot overwrite the original art in the EasyArt library. Whenever you open an EasyArt
message, a copy is automatically created in your messages folder.

FILE SEARCH - To find a specific word or phrase in the EasyArt list, simply type it in the Search field at the top of the Open
EasyArt window and click Search. If found, you can preview and open it. If not, delete the word(s) from the Search field and
click Search again. This will bring back the full list of EasyArt.
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Types of EasyArt
1. Standard messages are not editable. They incorporate professional effects to create eye-catching messages. This is
the most common type of EasyArt message.

2. Background messages allow you to add your own text over the graphic. Select the Backgrounds option from the
Category drop-down menu to display this group.

You can only change what is not a permanent part of the artwork, so it is important to know the type of message you
are starting with. Using an EasyArt message does not effect its availability for future messages. You can edit and save any
EasyArt message. Even when that message has been deleted, the original EasyArt is still available to you.

There are two basic ways of opening the list of EasyArt. First, from the main Messages screen, you can click on the Open
EasyArt Message button to view the list.

Second, from within the Message Editor, you can click the word Insert in the menu bar at the top and click Import
EasyArt to display the same list of EasyArt messages.

Uses of EasyArt
There are several ways you can use EasyArt as a part of messages you create. Listed here are brief descriptions of the basic
techniques you can use with these messages to add interest and appeal to your sign.

" ” EasyArt For Emphasis
TRY IT OUT You can open or import any message from the EasyArt list to start your message. You can then add
ACTIVITY a frame before or after the EasyArt message to insert your own text. The EasyArt message can act as
the eye-catching element of your message while your added frame provides the information of the

@ message.

1. From the Messages screen click the Open EasyArt Message button, and double click on the file named “OPEN
HOUSE" to open it.
2. Click on the Add button in the black bar at the top of the screen to add a frame at the end. Type the word
“TODAY" in the Text Box. Use the Text Properties to adjust the text size and color to approximate those of the
last few frames of the EasyArt message. Click the Background tab and select a similar color also.

3. Click on the Effects Tab and adjust the Hold Time to 1 s or more to keep the text visible long enough to be
read thoroughly. Make other changes as desired to the Appear and Hold Effects.

4. Click on the Add button again to add another frame and type the words “STOP BY” or something else which
will fit in your sign’s space. Adjust the frame’s hold time and effects as desired.

5. Click File > Save As to save the message. Name your file OPEN HOUSE TODAY, enter a Description and
Category if desired, then click Save at the lower right of the screen.

EDITABLE MESSAGES - While all EasyArt messages can have text added, messages that lack any graphical text are most
compatible with added, custom text.

MORE BACKGROUNDS - To view all files that are intended for use as backgrounds you must set your Category appropri-
ately. From the Open EasyArt window, simply set the Category drop-down menu to Backgrounds.

QUICK
TIPS
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EasyArt as Sentences
Another way of using EasyArt is to incorporate multiple files from the list to form phrases which create the message you
wish to display.

@ 1. From the Messages screen, click the Open EasyArt Message button. Double-click the name “SAVE 20PCT”
to open.
2. Click the Add button on the black bar at the top of the screen to add a frame at the end.

3. Click Insertin the menu bar at the top of the screen and choose Import EasyArt to display the EasyArt list.
Type the word “saturday” in the Search box at the top of the screen and click the Search button to filter the list.

4. Double-click the file named SATURDAY to add this piece of EasyArt into your message.

5. When you're happy with the message click File > Save As. Give your file an appropriate File Name, Description,
and Category.

EasyArt as Backgrounds
Using the Text Ready and Backgrounds groups eliminates the need to delete text before your text can be added. You can
view just the Backgrounds group by changing the Category to Backgrounds.

@ 1. From the Messages screen, click the Open EasyArt button to display the EasyArt list. Change the Category to
Backgrounds. Open any file from the list by double-clicking the file name.

S3IDVSSIN
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2. Add text in the text box and adjust the properties and the positioning as desired.

3. Use the Utilities button to copy your text to all of the frames in the message. Select the second option, Make
Multiple Frames the Same Text Properties. Then select all frames or specify a range of frames for your text.

4.  When you're happy with the message click File > Save As. Give your file an appropriate File Name, Description,
and Category.

ADD A FRAME - When working from an existing message, always add a frame before importing another EasyArt file.
Imports will overwrite the currently selected frame and push subsequent frames down.

HOLD TIMES - Our general recommendation is to hold a frame for one second per line of text. For example, if your
frame has three lines of text, set the hold time to three seconds. That will give passing motorists enough time to read the
entire message.
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Multiple Messages in One

When using an EasyArt file which contains multiple frames, you can create a multi-part message that displays your messages
over time. By having a consistent animated background, your multi-part message will read as a single, unified theme. We
recommend using good color contrast when adding text to an animated background to maintain optimum readability.

@ 1. From the Messages screen, click the Open EasyArt button to display the EasyArt list.
2. Open the file “LINES_DANCING" by double-clicking on the name in the list.

3. Type in the first part of your message, such as“NOW ON SALE,” changing font size and/or style to fit, if
necessary. Click the Utilities button at the lower-right of the screen and click on the second choice, Make
Multiple Frames the Same Text Properties. Change the Last Frame number to 25, and click on OK to change
frames 1 through 25 to your entered text.

4, Scroll down and click on frame 26. Type the message “ALL BOOKS” or something similar. Again click the
Utilities button. Change the First Frame to 26 and the Last Frame to 51 and click OK to copy that text to
frames 26 through 51.
g 5. Use the Preview button on the black bar to judge the effectiveness of your message.

6. If you wish to continue the message by adding more text, click the Add button to add a blank frame at the end.

7. Click Insert in the menu bar at the top of the screen, then click Import EasyArt. Find the same background file
we opened and double-click on it.

8. Now you can put another expression, such as “WED. THRU SAT” in frames 52 through 77 and “UP TO 20% OFF”
in frames 78 through 102.

Use the same file again as needed to display the complete message, being aware of the total time your
message will require to play through.

9. This same idea can also be used to make up effective displays of time, temperature, and date.

By using these variations and experimenting with combinations, you can make EasyArt a major part of your message
presentations. They add interest and variety, both key elements in achieving maximum benefit from your sign.

CLICKTO SORT - Any time your EasyArt sort list seems to be out of order, you can change it back to the normal
alphabetical list by clicking on the File Name column heading on the Open EasyArt screen.

EXPERIMENT . Don't be afraid to experiment. Nothing you create will be displayed on your sign unless you schedule it and
click Update Sign.

QUICK
TIPS
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Ignite OPx ™
Manage sign content from anywhere with our browser-based mobile application.

This revolutionary mobile application puts the power to update sign content in your hands, no matter where you are, no
matter when you need it. You can update playlists, publish content, schedule media, and run sign diagnostics - all from
your internet-connected mobile device. There is nothing to install and all changes automatically sync with your desktop.
Ignite OPx is available with any new Watchfire sign that uses wireless broadband as its communication method.

A Fotiie Run Diagnostics Report
Ny
Ty T W 1 Dy 3
REPORT
AR Dates »
Sehacui Update hagnestes 5 Diaplay Steus
Evvey Day o e Weo > Vi ua
Ootiors. ¥
2 1 » st s o

watchfire~D
N

Access features quickly. Schedule content easily. Run diagnostics on demand.

Getting Started
An Ignite OPx login must be created on a PC with Ignite OP installed. Once created, you can use your credentials to log
into Ignite OPx from any device with a web browser.

(4]0

Mobile Application Overview

Ignite OPx

watchfire<D

For a step by step instructional video on how to setup and use
Ignite OPx, please visit www.watchfiresigns.com/OPxstartup

QUICK
TIPS
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Adding Text Boxes

Creating messages with multiple fonts, text sizes and colors can add an extra level of professionalism IITRY IT OUTII
and eye appeal to your sign. Ignite allows you to easily incorporate several text boxes into a single
frame, with special effects acting simultaneously on all the text boxes. ACTIVITY

@ 1. From the Messages screen, click the Create New Message button to open the
Message Editor.

2. Enter the word “HELLO" in the text box using a font and text size small enough to allow other text in the frame.
Notice that the text auto-centers on the sign image and also appears in the large white text box on the lower-
left of the screen.

it @ MO E 1230 | AdkdTextBox | [ utities = |

HELLO Text Box Layout

Font: M \Watchfire Sans - Height: 85

Sze: 20 - cobor: [30 < | we 2B
Shadow | sihoustte1 | Coor: [o1 [ - 8

Spacing: 1
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3. Now click Add Text Box. A box displaying the word “TEXT” appears directly above our “HELLO” message. Click
and drag the text box to the lower right corner of the frame.

4. Click and hover your mouse over the word “HELLO." Your cursor will change to a four-pointed arrow, indicating
that the word “HELLO" is also a moveable text box. Click and drag “HELLO" to the upper left corner of the frame.

MOVE IT ALONG - Using the Travel Text effect with multiple text boxes allows all text to travel simultaneously. Pick Travel
Text as the appear effect in the Effects tab and set the appear layer to Text. When the message is Previewed, notice that both
boxes travel. You can also apply Travel Text to a multi-line message in a single text box.

Adding Text Boxes | 33
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5. Click “TEXT.” A line around the text shows that this is now the active text box. Go to the white text box and
replace the word “TEXT" with “FANS.” Change the font, text color, and outline color to something other than
those used for “HELLO!"

File View Insert Dra sage Options Help
2 &
[Fes e e [
1::[\]5 . == @B B 12 [AdTedsex
Font  Wi'Walchfire Sans - ngmnx 5
Size 13 - cobor: [+t [ -] | v B
i snadow [ sinouette-1v|  coor: o1 [N -] oo 32
For Help, press F1 CAP NUM
HSIEE 6. Notice that the text box automatically resizes to fit these selections. You also have the option to manually
control the size of the text box by clicking the Auto Size button, positioning the cursor along the edges of the
text box until it appears as a double-sided arrow, and clicking and dragging the box to the size you want.
7.

Click the Effects tab. Try different effects and preview the message to get a feel for how the text boxes work.

You now have a message with different fonts in a single frame!

SHORTCUT - When working with text boxes, don’t forget the handy right-click function. Several of the options
made possible with the Utilities tab, as well as text box placement and cut/copy functions, are available by right-

Y
m clicking on a text box.
=
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RSS Feeds

Ignite has the ability to display dynamic information on your sign using RSS, ATOM, and XML feeds. This powerful feature
allows you to use existing feeds right from the Internet or allows you to use feeds created on your own.

The RSS Feeds feature works with our Data Link product to perform timed updates of RSS messages to your sign. Once
RSS messages are created and scheduled, Data Link will automatically update them.

Setting-Up Data Link
In order for your sign to get updated with dynamic content from RSS feeds you must first have Data Link configured for
that particular sign.

Follow the steps below to setup Data Link:

1. On the Messages screen, select Configuration from the Tools drop down menu.
2. Select the Sign you want to use to display RSS content using the Signs list on the left side of the screen.
3. Choose Ignite Setup from the Task List on the top-left side of the page.

4. You should see a configuration section named Data Link Setup. In this section you want to select Configure
Data Link > RSS Feeds. Click Save.

Data Link Setup

Configure Data Link: |RSS Feeds ﬂ Configure...
Time between updates:|3 minutes

Sign password: |

Schedule: Mon - Fri, Al day Schedule. ..

Save | Reset |

5. After your changes have been saved you are now ready to configure Data Link for updating your sign. Select
the Configure... button in the Data Link Setup section.

6. Set the Time between updates field to define how often the RSS messages will be updated to your sign.

KEEP IT RUNNING - When your sign is actively using RSS Feed messages, those messages must be continuously updated
from your PC. Ensure that the PC has constant access to the Internet and does not sleep, hibernate or turn itself off. These
settings can be adjusted in Windows Power Options.

3/27/2019
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7. Enter the sign password in the Sign Password field.

8.

Data Link Setup
Configure Data Link: |RSS Feeds ﬂ Configure...

Time between updates:|3 minutes

Sign password: |

Schedule: Man - Fri, All day Schedule...

Save| Reset |

To schedule the times when your sign can and cannot be updated by Data Link, use the Schedule... button. The
schedule button will provide a dialog to set the days and times you want Data Link to run. This feature is typically
used when using a paid feed source only.

NOTE: Just because Data Link is NOT running does not mean your RSS Feed messages will not be playing as scheduled. They will still be
playing but the content will not be updated.

‘What days of the week would you like to run Data Link?
| Every day, Sunday - Saturday
@ yeekdays, Monday - Friday

What times during the day would you like to run Data Link?
‘@ All day, 24 hours
| Specific Times: Om:  5:00PM = Offt s0pM =

Creating an RSS Message
Now you're ready to create an RSS message. Go to Messages.

DRTA
LINK

QUICK

1.

2.

TIPS

Click File > Create New Message to start designing a new RSS Feed message.

In the message editor, click on the Data Link button found on the Text tab. This button is used to add RSS

content to the current message.
Note: If the DATA LINK button is disabled, Data Link is not configured to work with the currently selected sign or your system does not have

the proper files installed to use Data Link.

Click the Data Link button to bring up the RSS Feed Wizard. The RSS Feed Wizard allows you to select feeds,
filter feed information and select elements from a feed to display in a message.

When you first open the feed wizard you will not have any feeds available to use. You must add the feeds

you want to use. Feeds can be found on the Internet or you can even create your own.
You can pull a feed from any place with which your computer communicates. This includes the internet, local

file system, network drive, etc.

is3
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4. To Add a Feed, click the Add button. Then enter the Name of the feed and the feed Address.

a. The Name of the feed is defined by you and is only used for your reference to locate the feed.
b. The Address defines the location or URL of the feed. Just copy the URL from the address bar in your web
browser (example: http://www.weather.gov/xml/current_obs/KCMI.xml).

MNarme: NOAA Weather Test

Address:  http:/fwww.weather.gov/xml/current_obs/KCMLxml

o o ]

5. Once you add the feed, Ignite will detect the feed type and place it in the proper list: ATOM, RSS, or XML. Click
on these tabs to find the feed you have just entered.

RSS Feed Wizard

=
Feed Selection m

Use this step to select a feed that will provide the dynamic data for your image.

Display Items

Feeds Channel Infor
S S Name: NOAA Weather Test
HOAA e e Address: http://www.weather.gov/xml/current_obs/KCMILxmi
e ikl e

Last Read: 9/2/2014 3:20:44 M
Refresh Rate: | 608 minutes

Item Node: |<E.ITEI1|;UJJSEI’VE|]UI'I> -

Total Items: 1
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6. Select your newly entered feed and click Next >>. The Item Filtering screen will appear.
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QUICK

7.

TIPS

Item Filtering allows you to define what items from the feed will be displayed on your sign. A feed may contain

multiple items, use this step to refine the items that will get displayed.

NOTE: Items from a feed are displayed one at a time on your sign. If your feed contains 5 items and you choose to display them all it will
take 5 updates of your sign by Data Link before all items will have been displayed.

Item Filtering m

Use this step to filter out items from the feed.
‘ Filtered Items: 1 out of 60 Display All Items: | Display Fltered Items
Play all items in the feed?
© Playtheitematindex: | 18
= 7 Items are sorted from most recent to oldest based
Play through the first ftems in the feed? on the time each it last updated.
_) Play items no more than days old?

[ Filter playing items based on elements?

Play all items in the feed plays every item defined by the feed (no filtering). Each item in the feed will get
displayed on your sign.

Play the item at index allows you to select a single item from the feed to display on your sign. This will only
play one item and the item must exist at the provided index.
Play through the first allows you to set a limit on the number of items that will be displayed from the feed.

Play item no more than lets you display items that are no older than a certain number of days. This option is
only available for RSS and ATOM feeds that provide a publish date for items. Setting this property to 0 means
you will only get items updated on the current day.

Filter playing items based on elements allows you to choose the items to play based on text found in the
elements themselves. This can be useful when you want to display only specific elements.
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8. The last step in the feed wizard is Element Selection. This step allows you to select the text that will be placed
in your message.

Element Selection
Use this step to select slements that will be used as the dynamic text for the image.

Display Items

asun " ‘ M ‘«|Showingitem:luf1\»| H|
leredit_URL =
limage Highlighted Element's Text
'suggested_pickup
'suggested_pickup_p:
(location
'station_id
Ilatitude
Jlongitude - § Selected Elements
‘observation_time Element: current_observation[1]/wind_dir[1]
Jobservation_time_rfi _ | | | Text: Morthwest
lweather ¥ : e e
Rempertire. sting E::{T:ent_ clégenh_ubs«:r\agom_l,jwh id_mph[1]
temp_f
temp_c
relative_humidity
'wind_string
Z'wind_dir
lwind_degrees
Zwind_mph
‘wind_kt
pressure_string
pressure_mb
pressure_in
/dewpoint_string

dewnaint_f
1 ]

Elements List provides a list of elements defined in the feed. You select an element from the list by selecting
the checkbox next to the element name.

Selected Elements shows you what text will be added to your message and the element the text is drawn from.

Highlighted Element’s Text displays the text of the current selected element. This gives a preview of the text so
you can decide if you want to include that element’s text in the message.

9. Once you have at least one element selected, click Finish.
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10. You can add additional text boxes if you like. You can preview the resulting message by clicking the Preview
button. The preview will display the message just like you would see it on the sign.

11. After you have created your RSS message, click Save and return to the Schedule screen by clicking the
Schedule button. Then update your sign.

NOTE: You must leave you computer logged on and running at ALL TIMES in order for the Data Link application to continue to update your
sign. If you log off or shut down your computer Data Link will not be running and your dynamic RSS messages will not be updated.
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3/27/2019 BidSync p. 209



City of Pembroke Pines PL-18-06

The Counter Button

The Counter button is another feature unique to the Message Editor. This option allows you to create a count-up or count-
down that will automatically update, much like the Date, Time, and Temperature.

123| 1. Click the Counter button and set the Start Value to the number from which you want to start counting.

2. Set the Rate to adjust how often the counter will refresh; choose from increments of Second, Minute, Hour,
or Day.

3. Setthe Start Date and Start Time to determine when the counter will begin. The Counter Format allows you
to display your values in terms of numbers, basic currency, or time.

4. Once your values are set, click OK to preview the counter as it will appear on your sign. The font styles, size,
and colors can be adjusted using the text box just like any other message.

Using the Graphics Tab

After you have mastered the basics of creating messages, you should begin to explore the ways
”TRY IT OUT" Ignite will let you create outstanding special effects in your messages. Mastering and using
ACTIVITY techniques made possible from the Graphics Tab while using the Message Editor will open new
doors for you.

@ 1. From the Messages screen, click the Create New Message button to open the Message Editor.

2. (Click the Graphics tab.

Text | Effects | Background | Graphics | window |

= oo o dOB Graphics Tools

B 9 {1 ||

el 0 T 0 0 A [ Color Patett
(] A O olorraletie
[ [ L e e L ]

4

Active Colors

Active Colors
Two color boxes are shown to the left of the color palette. These are the active colors you can draw with. Use the left-click
to draw with the left active color and use the right-click to draw with the right active color.

1. Left-click one of the color swatches in the color palette and you'll notice that the left Active Color box changes.

2. Right-click one of the color swatches and you'll notice that the right Active Color box changes.

z m THUMBNAIL CHOICE - Be sure to choose the frame you want to show up as a thumbnail. This will make it easier for you to
U find your messages in the future. You can set any frame as the message thumbnail. Simply click on the desired frame, then
— m click on Message (top of the screen) and click Set Thumbnail Frame.

=) ==
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Pencil, Eraser, and Line

‘-;? 1. Click on the Pencil button to activate it. You can draw in the message frame one pixel at a time. Left-click to
use the left active color or right-click to use the right active color. You can also click and drag to create a line
which follows your mouse motion.

li? 2. (lick on the Eraser button to activate it. Just like the pencil tool, you can erase the graphics layer one pixel at a
time. Erase some of the Pencil lines that you just created.

\\ 3. (lick on the Line button to activate it. With this tool, you can draw straight lines. Click and drag the mouse to
create the line. To create a straight vertical or horizontal line, hold down the Shift key on your keyboard while
you click and drag.

Rectangles and Ellipses

[ ]| 1. dlickon the Outlined Rectangle button to activate it. To draw an outlined rectangle, place the cursor in the
upper left corner of the rectangle desired. Click and drag the cursor over to the lower right corner. The open
rectangle gives you an easy way of drawing a frame around text.

2. Click on the Filled Rectangle button to activate it. Draw a filled rectangle just as you drew the Outlined Rectangle.

i__1| 3. Trythe Outlined Ellipse and Filled Ellipse buttons.

Paint Bucket Fill

% 1. Click on the Paint Bucket Fill button to activate it. The paint bucket will fill an entire area until it reaches the
edges of that area.
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2. Click on aline or box that you just created. Notice that the paint bucket filled the entire line or box.
If you click in the area that shows the background color, you can fill with your active color.

TOGGLE ON & OFF - When you click on a graphics tool button to activate it, it appears selected on the screen. Don't forget
to go back and click on it again when done to turn it OFF!
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Rotate 90 Degrees
+%| 1. Click on the Rotation button to activate it.

2. Click to move the contents of your frame 90 degrees clockwise.

Move Up, Down, Left, and Right

w==| 1. Thefour double arrow Move buttons to the right of the Rotate button allow you to move the graphics layer
one pixel in either direction with each click.

}} 2. Click any of the buttons to nudge your graphics layer one pixel in any direction.

Custom Colors

1. For full color signs, it is possible to create custom colors under the Graphics tab. You will notice a number of
extra black boxes, or swatches, to the right of the color palette. These are empty color swatches and can be
used to store custom colors.

2. Double-click on one of the empty swatches to display a Custom Color selection window. Slide the three bars of
the primary colors of Red, Green, and Blue to create a custom color which meets your needs. Click OK to make
the new color the left Active Color and to store it in the swatch you started from. You can then put that color
into your message.

3. You can also use this tool to sample any color visible on your computer screen. Double-click another empty
swatch to bring up the Custom Color selection window again.

4. Click the Select button to turn your mouse cursor into an eye-dropper icon. You can move the cursor over any
visible color on your computer screen and you will see it previewed in the selection window.

5. Click on any color you like to sample the color. The color is automatically loaded into the empty swatch.

This is a useful tool if you want to fine tune your graphics. You can sample a color from the image, then use the Pencil tool
to draw over blemishes in an image.

z DON'T LOSE IMAGES - When you rotate your graphics layer 90°, it will crop part of the image off. When you click the
U Rotation button again, you will notice that your image has been deleted. Click the Undo button to bring your image back.
e m

This will also happen when using the move button.
=) ==
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Advanced Scheduling

The time will come when you will want your Watchfire sign to do more than just play a set of messages all day and all
night. Maybe you will want to set up different schedules for different days of the week or have a special set of messages
for a holiday. You might want to set up different messages to run for a few hours during the day. This type of scheduling
involves a little extra time and planning, but the result can make your sign a dynamic and exciting tool.

By adding several entries into your schedule, you are building a series of Play Lists which are set to
play at specific times. You can put multiple messages in a given Play List which will play in a top- ”TRY IT OUT"

down order. Play Lists also play in this order. ACTIVITY

@ 1. Click on the Schedule button on the Messages screen.

+ 2. Click the Add button at the top of the Schedule screen to display the Play List Details window.

@ Play List Details - Empty Play List - All Day, Every Day ?
Rrevien Play List Add Remove | Remove Al Review Qui
1 .
Play List: ‘when | Messages | Easpent | Options| [ Section Tabs
Time & Date
Al Day w
12008 3 12008 2
Al Dates v

14 142000 12/31/2939 Details

Days of the Week.

Every Day of the Wesk v

¥ 5un  [¥|Mon (¥ Tues [¥|'wWed [ Thus [¥Fi | Sat

Play List
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3. SettheTime & Date to All Day and All Dates and set the Days of the Week to Every Day of the Week. This will
make the message play 24 hours a day, every day.

4. Click the Messages tab. This lists all of the messages you have created and saved. Click the name of the WE'RE
OPEN message you created to highlight it.

5. Now click the Add button to put the message into the Play List to the left.
6. Click on the EasyArt tab and add an EasyArt of your choice.

7. Click the Save button in the upper-left corner to save this schedule and return to the Schedule screen.

COLOR CODED - Whenever you add an entry to the scheduler, it will assign a color code to the timeline bar depending on
which settings you've selected (brown: every day, red: specific dates, orange: specific days).
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10.

11.

12.

13.

14.

=+=| 16

QUICK

You will notice the two messages you scheduled have been grouped into Play List A. If you add a single
message at a given time, the message’s name will display here. Notice the brown bar extends from 12:00am to
12:00am to indicate that this message will play all day, every day.

You can click the Plus Sign (+) next to the Play List name to reveal all of the messages contained in the group.

@ Ignite OP SE

File View Schedule Tools Help

5 Mon 3/16 4/ k| E
ﬁrE"EO SCHEDULE on
gite OF + Add.. >~ / Edit.. ~ X Remove 4 Move Up ¥ Move Down

TASK LIST |Monday. March 16, 2015 10:00
9:48

1 = Play List A
WE'RE OPEN
HEZ] messaces Anencan Fag Loos
Every Doy Bl vl Weskssys: Dated & Weskasys B oI
2,
SCHEDULE

3%
Kv UPDATE SIGN

SIGNS

Front Sign
Back Sign

For Help, press F1 NUM

Click the Add button again to add another schedule entry.
Set the Time & Date to Start and Stop Each Day. This activates the Start Time and Stop Time fields below.

Set the Start Time to 11:00am and the Stop Time to 2:00pm. Leave the other field set to All Dates to play
every day.

Click the EasyArt tab this time to display the list of pre-made EasyArt on your system. Find the Clouds
message and double-click it to add it to the Play List.

Click the Save button. You will return to the Schedule screen.

. You will notice that your scheduling window now shows Clouds in a brown bar that only extends from

11:00am to 2:00pm. This is the only time of the day that this message will play on your sign. The brown bar
indicates that it will play every day. Also notice that the message name appears rather than a Play List name.
This is because it is the only message scheduled to play at those specific times.

Now let’s add a message that will only play on specific dates. This is an excellent capability in case you want to
run a specific set of messages over a given holiday or event.

Click the Add button to open the schedule details window.

DOUBLE-CLICK MAGIC - In order to move a message from the messages list into the Play List, you can simply double-click

ml the file name rather than using the Add button.
—
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17. Set the Time & Date to Start and Stop Each Day. Set the Start Time to 8:00am and the Stop Time to 8:00pm.
18. Under Start Time, set the other drop-down menu to Range of Dates to activate the date menus.
19. Enter next Thursday as your First Date and next Sunday as your Last Date.

20. You can leave the Days of the Week set to Every Day of the Week. The date range we just specified will ensure
that our message will only play Thursday through Sunday.

21. Click the EasyArt tab to display the list of EasyArt messages.
22. Scroll down the list and locate the message Clouds2. Double-click it to add it to the Play List.

23. Click the Save button. You will return to the Schedule screen.

E 24. Notice that the scheduler shows the Clouds2 message label in the timeline as grey. This is because we are
not viewing next Thursday. Click the Calendar icon above the timeline and select next Thursday from the
calendar. Click OK to move to that date. Now you will notice that a red bar appears from 8:00am to 8:00pm as
we selected. You can use the Forward and Backward Arrow buttons next to the Calendar button to move one
day in either direction.

The Clouds2 message will have a red bar on Thursday through Sunday only. The red bar indicates that the
message has been set to play on a specific range of dates.

Lastly, we will add a message to play on a specific set of days every week. This allows you to schedule a set of
messages for Monday through Friday and another set for the weekend.

25. Click the Add button to open the schedule details window.

26. Set the Time & Date options to All Day and All Dates.

>
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27. Set the Days of the Week to Specific Days of the Week. This activates the daily checkboxes.

28. Check the Monday, Wednesday and Friday boxes only. Uncheck any others.
29. Click the EasyArt tab and double-click the Flag Waving file name to add it to the Play List.

30. Click the Save button. You will return to the Schedule screen.

PREVIEW OFTEN - Use the Playback Time Indicator to preview what your sign will look like at any given time. Messages will
always run in order from the top of your list to the bottom.
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If you are not on a Monday, Wednesday or Friday date then the timeline label details will appear in grey. Click the
Calendar icon above the timeline and select any Monday, Wednesday or Friday. You can also use the Forward and Back

Arrow buttons.

When you are on one of these days, you will notice the Flag Waving message has an orange bar from 12:00am to

12:00am. The orange bar will only be visible on Mondays, Wednesdays and Fridays indicating that this message is only set

to play on these specific days, every week.

@ Ignite OP ZE “

File View Schedule Teools Help

Frizizo |4 FE

watchfire-) ~ SCHEPULE
write OF + Add.. ~ / Edit.. ¥ X Remove 4 MoveUp * Move Down

TASK LIST |Friday, March 20, 2015 3 0 Zp 20 E 00 8:00
800 | %52 11:00 2:00 8:00

1 HPlay ListA 411 Day, Every Day
MESSAGES [ Clouds L48x112 [EasyAr]
i! [ Clouds2 L48x112 [EasyArt] (8 AM-8 P'M, 3110-3/22

[+ Flag Waving L48x112 [EasyArt] Al Day UL WLF
‘sm{ oy Coo Ml Wesays Cated & Weskiays I o I

2ol
SCHEDULE

3%
L UPDATE SIGN

SIGNS

Front Sign
Back Sign

NUM

For Help, press F1

Other Schedule Setting Options

When you have added messages to your schedule, you probably noticed several more options in each of the drop-down

menus. Below is an explanation of each option.

Time & Date

All Day: This will make your message play from 12:00am to 12:00am on every day that it is scheduled to play. You can

then select from these sub-options:

All Dates: Your message will play all day, every day.

Forever Starting on a Specific Date: Your message will play all day, every day, starting on the specific date you select.

Range of Dates: Your message will play all day, every day, during the range of dates you selected.

Start and Stop Each Day: This will make your message start and stop at the times you select each day it is scheduled to

play. You also have access to the previous sub-options.

Forever Starting at a Specific Time & Date: This will make your message start at a determined time and date then play

all day, every day from then on.

z KEEPING TRACK - When you are setting up messages to run on or through a specific date, it is helpful to put that date at

the beginning of the file name. That way you will know when to take it out of your schedule and when it can be deleted from

! m your message files.
=) ==
Ol
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From Start Time To Stop Time & Date: This will make your message play from a specific Start Time and Start Date to a
specific Stop Time and Stop Date.

Days of the Week
Every Day of the Week: This will make your message play every day of the week within the range of dates you selected
and time frame selected.

Monday through Friday: This will make your message play Monday through Friday within the range of dates you
selected and time frame selected.

Saturday and Sunday: This will make your message play Saturday and Sunday within the range of dates you selected
and time frame selected.

Specific Days of the Week: You now have access to the checkboxes associated with each day of the week. Check the
boxes with each day that you want your message to play. This will make your message play on those specific days
within the range of dates you selected and time frame selected.

The Options Tab
In the Play List Details window you have a tab at the right labeled Options. This tab allows you to set a few specific
characteristics of your Play List if you choose.

Play List Name
This option allows you to manually type in a new name for the Play List you are creating or have created. By default,
Ignite will assign the name Play List A and continue alphabetically.

Override

If you check the box in this section, your Play List will override any other messages that are set to play in that specific
timeframe. By default, Ignite simply adds your new Play List to any other messages that are scheduled to play at the
same time.
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Play One Message per Loop
When this option is selected, only the first message from this Play List will play before moving on to the next playlist.
On the following loop, only the second message from this Play List will display, and so on.

Play Count
If you want the Play List you are creating to play more than once before the next scheduled playlist is seen, enter the
number of repetitions you want here. To play more than once, this must be set greater than one.

ONTIMES - The On Times feature is the best way to schedule your sign to be off at night. On the Schedule page, select On
Times from the Schedule drop down menu in the toolbar. Deselect the “Run the sign 24 hours a day” checkbox and adjust
the On Times. These settings will override all playlists in your schedule.

Advanced Scheduling | 47

3/27/2019 BidSync p. 217



City of Pembroke Pines PL-18-06

Adding and Deleting Existing Messages/Play Lists

K If you want to delete an entire playlist of messages from your schedule, first click on the name of the Play List to
highlight it. Click the Remove button above the timeline. Click Yes to confirm the deletion of the Play List.

If you want to delete an individual message within a Play List, you must first click the Plus Sign (+) next to the Play
List name to reveal the messages within that list. Click on the name of the message you want to delete to highlight
it. Click the Remove button above the timeline. Click Yes to confirm the deletion of the message.

#I"r To delete a single message from a Play List, you can also click the Play List name to highlight it then click the Edit
button above the timeline. This opens the Play List Details window with your Play List of messages on the left.
Double-click the name of the message you want to remove to make it disappear. Click the Save button.

Available Schedule Views

Your schedule now consists of all three types of messages: Every Day, Weekly and Dated. This can become confusing
without a good way to view your upcoming messages. Ignite gives you multiple ways to view

and manage your play lists.

The View Settings in Ignite can provide you with an overall view of an upcoming week or even upcoming month. Let’s
look at how to use the View Settings.

1. With the Schedule screen open, click on the View menu on your Menu Bar at the top of the screen.
2. Click Weekly. Notice that you now can view an entire week’s play list.

3. Click on the View menu again and select Monthly. You can now view the Play List for the next
four weeks.

4. Click on the View menu again and select Play Lists. This menu allows you to view your play lists in a text-
based format. The column headings include the play list Name, When the play list is scheduled to play, and the
Messages contained in each play list.

You can still use your Playback Time Indicator to preview any time on the schedule in either the Daily, Weekly or Monthly
view to see what will be playing at that time on that day.

PUBLIC SERVICE - You will find that your sign can become a great public relations tool by using it to run occasional public

mn service and community interest messages.
—
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Using the File Manager

As you gain experience with Ignite, you might be surprised by the sheer volume of messages you build up over time.
Some will never be needed again after their initial use, while others are seasonal or concern matters that will be repeated

later. Some you need to delete, and some you should save for future use.

Moving and renaming message files is done easily from the File Manager. You can also change the Description and

associated Categories from the File Manager as well.

From the Messages screen, click File in the menu bar at the top of the screen and select Manage Files to display a list of
the messages you have created and saved.

File View Tools Help

2R O e - W 2?8

MESSAGES SCHEDULE UPDATE | BACK FLES HELP WEB HELP

E-Wsers'Public\Documents'Watchfire Signsiignite11\MessagesilL32x50\

watchfire<) MANAGEFILES

nite OF ‘ Open | ‘ Preview | I Copy To... | | Copy From... ‘ ‘ Rename I | Delete | | Properties. .. ‘
TASK LIST  Category: |All Categories - View: |Details =
File Mame Description Date Modified Size Matrix *
i MESSAGES BT Basketball Zoomin  Zooming basketball (text ready) 02/20/13 8:24 AM 1.842 KB 90x252
—WELCOME  REDANDWHTE  (203151032AM __ 2KB dixiad 4
D April 154144 APRIL, Easter eggs, rain 02/20/13 8:23 AM 1535 KB 5dx144
% SCHEDULE % ~merican Flag Loo...  American flag 02/20113 8:23 AM 13,438 KB 208x752
2 2 Hose Gauge t48  Air hose and gauge 02/20/13 8:23 AM 446 KB 48x144
TR 4th of July 154144 4TH OF JULY with fireworks and...  02/20/13 8:23 AM 1535 KB 54x144
I Forty All-s 180x160 3040, 4040 02/20/13 8:26 AM 26 KB 80x160
e UPDATE SIGN I Forty Al 148x96 30-40. 40-40 02/20/13 8:26 AM 916 KB 48x96
e DNA_3D 148x112 J-dimensional representation of ... 02/20/13 8:25 AM 1151 KB 48x112
b 24_Hour_ATM t64x...  24-HOUR ATM with clock 02/20/13 8:23 AM 1.610 KB 64x176
Frontsian TAEE 24 Hour ATM 132 24-HOUR ATM with clock 02/20113 8:23 AM T6KB 32x112
gFuutbaH Short-g I8...  1st down measurement. %A% 02/20/13 8:26 AM 26 KB 80x160 =

Back Sign

Open
If you click on a file name and then click the Open button, the message will load in the Message Editor. You can then edit
your message as desired. Remember to save it when done to keep the changes.

Preview

Click on a File Name and then click the Preview button to see the message play. Click anywhere on the screen to stop

the preview.

Copy To

You may choose to store some messages in a location outside of Ignite. They might be seasonal, such as Holiday
messages, or they might be specific to your type of business or profession but not needed until some future time. You may
also want to save a copy of some messages on a Network Drive, CD or USB drive. To save a copy of a message file to the
desired location, highlight the file by clicking on it, then click the Copy To... button. Click the Browse... button to identify
the intended destination, then click Copy to move a copy of the message file to the new location.

QUICK
TIPS

Description: RED AND WHITE, Date Modified: 02/03/15 10:32 AM, Size: 2 KB, Matrix: 48x144

CLEAN HOUSE - Don't let your list of available messages grow so large that you have trouble locating and scheduling the
messages you use regularly. Delete files that you no longer intend to use on a regular basis.

MOVE 'EM ALL - If you want to copy multiple files at once, click on the first file name to highlight it. Hold down the Control
(Ctrl) key on your keyboard while you click on the other file names you wish to move.
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Copy From

If you have created message files on another computer, you will want to save them to a system that can update your sign.
The Copy From... button allows you to import files from a CD, USB drive, or network location so you can schedule them
to play.

Click the Copy From... button. Click the Browse... button and locate the files you want to bring in. When files exist in the
location you specify they will display in the Copy From... window.

Click the Message Files you want to import, then click the Copy button in the lower-right portion of the Copy From... window.
Your file(s) will then appear in the list of available messages.
Rename

If you only wish to rename a file, click the Rename button. Type the new name in the window that opens. Click OK to
accept the changes.

Delete

To delete a file permanently from your computer, click on the file name to highlight it. Click the Delete button. Files are
placed in the Recycle Bin to avoid accidental deletion. You will then be prompted to confirm the deletion of the file. Click
Yes to complete the deletion.

Properties
To display the current properties of any file, click on the File Name to highlight it, then click the Properties button. The
description and category of the message can be edited here.

Up to five categories can be used for an individual message.

Click OK to accept any changes.
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DROP THE PRACTICE - Most users create a number of messages when first learning how to use the many features of the
Ignite system. Use the Delete instructions here to get rid of them when you have finished those early learning exercises.
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Message Logging

Ignite includes the ability to track and record what messages have played on your sign through Message Logging. This
function is off by default and can be enabled manually. You can generate a simple text-based report, which can be parsed
into a spreadsheet program, or you can generate a more detailed report through Ignite. In order to generate a logging
report, messages must be playing on your sign. There are two types of Message Logging: Simple and Detailed. Their
differences are explained below.

From the Messages screen, click Tools in the menu bar at the top of the screen and select Message Logging to display a
screen which prompts you to first connect to your sign.

Click the Connect button. A window opens which shows that Ignite is connecting to your sign.
A new Message Logging window then displays.

In the Settings section you must first decide if you want to generate a simple or detailed log report. Ignite, by default, is
set to simple, which means the drop-down menu says No. Let’s first generate a simple log.

Simple Message Log

Under the Settings section, make sure the Detailed Message Logging drop-down menu is set to “No” and then click Clear
Log and Start Logging On All Messages. This will send a command to the sign to start tracking what messages have
played. When the window that opens says that the sign was successfully set, click the Close button.

MESSAGE LOGGING

Log File - Back Sign
Current Logging: All Messages - Detailed

Retrieve Logging File (message.log)

Settings
Detailed Message Logging: IYes_]J: Message Log Format

Clear Log and Disable All Logging
Clear Log and Start Logging On § Messages
Clear Log and Start Logging On All Messages

Disconnect J']. Disconnect Button

Wait at least one minute from the time you enabled message logging so a number of your messages will have played. Under
the Log File section click Retrieve Logging File (message.log) to open a window displaying the details of your schedule.

P message.log - Notepad _|o] x|
Eifle Edit Format Yiew Help
L 11/16/06 10:29:31 ;i
NAME START TIME PLAYTIME(S)  OCCURRENCES
TIME-O-~1 11/16/06 10:29:31 18 2
/16/ : 10 2
8 2
8 2
14 2
3 Z
4 ¥
4 1
4 1
4 33
4 15
4 1
4 1
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A Simple Message Log is a plain text file with the .log file extension and is automatically saved in the Ignite folder.

A simple log will have four columns as follows:
Message Name
Message Start Time
Total Message Playtime in seconds
Number of Occurrences the message has played

Be aware that the message name will be truncated to eight characters. Because it is a text file, the simple log can be
parsed into a spreadsheet program for further organization or editing.

Click File then Exit to close the message log.

Detailed Message Log
Now we will set up the system to generate a Detailed Message Log.

Click on the Disconnect button below the Settings section. Once disconnected, click the Connect button again to
reestablish communications with the sign.

Under the Settings section, change the Detailed Message Logging drop-down menu to “Yes.” Click Clear Log and Start
Logging On All Messages to start logging the playlist. Click the Close button on the new window that says, “The sign has
been successfully set” Let the sign play through for a minute or so before trying to retrieve a log. Click Retrieve Logging
File (message.log) to open a window containing the details of your schedule along with a horizontal bar graph of the
time each message has played.

Display Buttons Filter Drop-Down Menus

File View Hep =
EE ol 2| |
| - AllMessages - ] [Aitents - x] [-AiDas =] [-Hews =] |

[Daz | Time | Message| Total Timelhims) | TotalCount
Dec, 2007 Bradley . 7232
Candy 7313
Ciyscape 7anz
Eley ... 72853
Gietty-.. 73043
Getty - 730
Getty - 73054
Getty -1 730z
Salon N 21831 Il
75347 [N
73110 [
0003 [
7230 [
13818 |
211z @l
2133
12702 ||
3214
Eg

Sand &
Splitscr
Tennis
Tiry's P
WFDO
WFDO
WFDO
WFDD

Jan, 2008 Bradey
Candy
Cityseape
Elszn R
Getty -
Gety - f
Gety-F
Getty-L..
Happy .

Saion ... 131547
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For Help, press F1

EASY MATH - If you don't remember how long a particular message is, simply divide the Total Message Playtime by the
number of occurrences. This will give you the message’s duration in seconds.
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A Detailed Message Log will display detailed information regarding your current schedule. You have several options
available to filter the log results including by month, by date, by hour and by message. Use the four Filter drop-down
menus to filter accordingly. You can also use the three Display buttons to change the display detail to month, day or hour.

The Detailed Message Log can only be viewed in Ignite. You can, however, print the log by clicking File then Print, or by
using the Print button on your keyboard.

Click File, then Exit to close the message log window.

Click the Disconnect button below the Settings section to close your communications with the sign.
Click the Edit button in the black bar to return to the Messages screen of Ignite.

Logging a Specific Set of Messages ($ Messages)

You can selectively log messages by using a“$”in front of the message file name. For example, “$ WE'RE OPEN" instead of
“WE'RE OPEN."When you have $ Messages playing in your schedule, you can then select Start Logging On $ Messages on
the Message Logging screen. The other messages in your schedule will not be tracked and the returned results of the log
will only display the messages with a dollar sign ($) in front of them.

This method allows you to designate a specific group of messages to track. If you charge for advertising on your sign, you
can filter out your regular messages and only track the ones you charge money for playing.

z m HELP IS HERE - Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC
U has Internet access, Web Help is best. Watchfire’s customer service department continuously works to improve the Watchfire
e m

KnowledgeBase!
=) ==
Ol
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Message Design Guidelines

The Ignite message editor makes creating content for your sign simple and is easy to use. Designing a message that grabs
the viewers attention can sometimes be complicated however. To assist with this issue, the Watchfire Creative Services
department has assembled a selection of tips and tricks to help ensure that your sign looks as good as possible.

Keep it Simple

The first step to creating an effective message for your sign is to use appropriate text in your message.
Keep the wording concise.
Avoid spelling out complete sentences. Don't use eight words when four will do.
Stick with short, simple words to maximize quick comprehension by passing motorists.

Keep it Clean
Avoid using thin fonts as well as most script fonts. The strokes are simply too thin to maintain legibility on an electronic
sign. Stick with thick, heavy fonts to maximize readability.

In Ignite, it is strongly recommended to keep the bold feature on and to use a black outline around all text when possible.

Use all capital letters whenever possible. Capital letters use more pixels to create the letter which means they are
typically much easier to read from a distance.

BAD GOOD BEST BAY GOOD BEST

sans-serif serif

MESSAGE DESIGN - Message Design in a sentence: Keep it simple, clean and big!
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Keep it Big

Typically, your main audience consists of passing motorists traveling anywhere from 25 to 65 miles an hour. Keep your
text large! Large text allows motorists to see your message from a much greater distance without distracting them from
their main concern: driving. If your text is too small, it will be too hard to read, and your key audience is likely to disregard
your messages entirely! Although your sign is probably capable of much smaller, it is a good idea to use a minimum 12"
character for optimal viewing distances. Use multiple frames if your message won't fit cleanly in one frame.

Bad

SFE AR ER Y fRREW
EFERYTHIMNG T

THE STHRE I5 157
BFF. 50 HIERRY Tk

Too much text and too small. Passing motorists will not be able to read this entire message.

Good

A TURDRY 15 4 OFF

OHLY ! EVERYTHING

Frame 1 Frame 2 Frame 3

By removing some words and spreading the text over multiple frames, you can use larger text so passing motorists will be
able to read your message more easily.

Remember our guideline; set each frame’s Hold Time to at least one second per line of text.
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HOLD TIMES - When in doubt, set each frame’s Hold Time to at least one second per line of text.
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Effective Color Schemes

High color contrast is a key ingredient to a successful message. Just like using large text and capital letters, the right
color combination can make your message readable from a much greater distance. Refer to the samples below for many
of the best text color vs. background color combinations for your electronic sign. As always, a black outline is recommended
to help distinguish the text from its background.

» IEED -
FRcHLN ]

GOOD COLOR
CHOIGES

BOOD COLOR
CHOIGES

GOOD GOLOR
GHOIGES

COMPLEMENTARY COLORS - High contrast color combinations are often called “Complementary Colors.” These colors
are directly opposite of each other on the color wheel.

QUICK
TIPS
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Image Resolution

Image resolution for an electronic sign is dependant upon the total number of pixels in the image. In print, resolution

is dependant upon the DPI (dots per inch) or PPI (pixels per inch). This number has little to no impact when displaying
images on your sign. Instead, you want at least as many pixels in your image as you have in your sign. Having more pixels
in your image allows you to crop more tightly without losing image quality. Watchfire recommends using images with at
least five times as many pixels than your sign has in both height and width.

Creating Custom Content

While the Ignite message editor offers many tools for creating excellent content for your sign, skilled graphic designers
may choose to use third party software to create custom artwork. Here are some recommended formatting guidelines to
ensure your graphics look their best on your sign.

Canvas/Composition Size
From a design standpoint, most electronic signs have very few pixels. However, the imagery looks much cleaner than
expected due to the light diffusion which occurs when the LEDs are illuminated.

For optimum results, create your compositions at least five times the sign’s height and width in pixels. For example, if you
have a 48x112 sign, you would want to create a composition at 240x560. You could even go to 10 times the sign’s size if
you have a smaller sign. The key is to increase in even increments of both the height and width of your sign. Ideally, you
want at least 200 pixels in each direction to work with.

Now when you import your imagery into Ignite, you won't have to worry about cropping or distortion. The image will be
down-scaled perfectly to match your sign.

The same principle applies to video content. Most video content will either be shot in a 4:3 (standard definition) ratio or
16:9 (high definition) ratio. Each size will typically have plenty of resolution for your sign. However, if you decide to scale
down the video content to save file size, remember that you still want at least five times the number of pixels in each
dimension of your sign.

Frame Rates (for animated content)
For XVS signs, create your content at 30 fps (frames per second).
For W-Series signs, create your content at 20 fps.

File Formats
Still images can be imported as JPG (jpeg), GIF, or BMP (bitmap) files. Keep in mind also that they must be in RGB color
format, not CMYK.

Animation and video importing requires an appropriate codec to be installed on your computer to support reading video
data from the file. In addition to the codecs Microsoft ships with Windows, many third party codecs are available to
support a wide variety of video file formats. Visit article 706 on the Watchfire KnowledgeBase for a full list of compatible
codecs. (Go to watchfiresigns.com/kb and search 706.)
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DPI - Most users create a number of messages when first learning how to use the many features of the Ignite system. Use
the Delete instructions here to get rid of them when you have finished those early learning exercises.

OPTIMAL RESOLUTION - For easy image manipulation, create a source image at five times the resolution of your sign. It's
important to understand that the image will be resized for the sign once it is imported.

Image Resolution & Custom Content | 59
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Software Training

Watchfire has developed the most user-friendly software package in the industry. Ignite is set up for quick, easy learning
yet contains enough horsepower to cater to the most demanding content developer. If you ever reach a stumbling block
or would like to go beyond the Ignite manual, you can choose to participate in a web-based training option to take your
content creation to the next level.

Web-based training is an excellent option for users who have access to the internet at their location. A Watchfire trainer
can take control of your computer screen and guide you through the steps of creating content for your Watchfire sign.
We also use this method for general Ignite overview sessions. Attendees from multiple locations can connect to the
same session, which makes this an excellent option for users with employees in remote offices. Audio is handled via

a standard conference call. Watchfire will provide a common phone number for all attendees to dial into. Web-based
sessions are typically 1 to 1% hours in duration. Check the front cover of this manual to see if training was included with
your sign’s purchase.

Schedule convenient, online training at watchfiresigns.com/ist

Minimum internet connection: Cable modem, DSL or better Internet connection
Web browser: Internet Explorer 8 or newer, Mozilla® Firefox® 24 or newer, or Google™ Chrome™ 23 or newer

ONLINE SCHEDULING - Schedule convenient, online training at watchfiresigns.com/ist

60 | watchfiresigns.com 800-637-2645
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Quick Message Guides

Creating a Text Message

@ 1. Click on the Create New Message button on the Messages screen.
2. Typein text and adjust your text properties to your preference.
3. Select the Effects tab and adjust effect properties to your preference.
4. Select the Background Tab and apply background properties to your preference.
5. Save your message by clicking the Save icon on the black toolbar.
6. Give your new Message a name and description that will help you remember it in the future.

7. Click on Save. Now your message is ready for scheduling.

Time and Temperature Messages

@ 1. Click on the Create New Message button on the Messages screen.

'E_:' 2. Click on the Time icon and select your desired setting. Choose your desired text properties.
Adjust the placement of the time on your Frame View.

@ 3. Click on the Date icon and select your desired setting. Choose your desired text properties.
Adjust the placement of the date on your Frame View.

l 4. Click on the Temperature icon and select your desired setting. Choose your desired text
properties. Adjust the placement of the temperature on your Frame View.

5. Select the Effects tab and adjust effect properties to your preference.

6. Select the Background tab and apply background properties to your preference.

7. Save your message by clicking the Save icon on the black toolbar.

8. Give your new message a name and description that will help you remember it in the future.

9. Click on Save. Now your message is ready for scheduling.

z m HELP IS HERE - Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your PC
U has Internet access, Web Help is best. Watchfire's customer service department continuously works to improve the Watchfire
e m

: KnowledgeBase!
—
Ol
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Quick Start Import Image

10.

11.

12.

Click on the Quick Start Import Image button on the Messages screen.

Choose a picture to import by clicking on the browse button.

Highlight the image you want and click Open.

Leave the color conversion set on True Color-Halftone (or Grayscale-Halftone).
Adjust the Scaling Factor based on your preferences.

Import the image.

Add additional text to the image.

Select the Effects tab and adjust effect properties to your preference.

Select the Background tab and apply background properties to your preference.
Save your message by clicking the Save icon on the black toolbar.

Give your new message a name and description that will help you remember it in the future.

Click on Save. Now your message is ready for scheduling.

Quick Start Import Animation

Click on the Quick Start Animation button on the Messages screen.
Choose a video to import by clicking on the browse button.

Highlight the video you want and click Open.

Leave the color conversion set on True Color-Halftone (Grayscale-Halftone).
Adjust the Scaling Factor based on your preferences.

Add text and adjust the text properties to your preference. Use the Utilities button to apply text properties to
multiple frames.

Save your message by clicking the Save icon on the black toolbar.
Give your new message a name and description that will help you remember it in the future.

Click on Save. Now your message is ready for scheduling.

IMAGE FILE FORMATS - Ignite accepts JPG (jpeg), GIF, or BMP (bitmap) files in RGB format. Ignite may also accept more
unusual formats such as ICO.

ANIMATION FILE FORMATS - Ignite accepts uncompressed AVI files along with WMV files as long as the proper codec is
installed. Visit answer 706 on the Watchfire KnowledgeBase (watchfiresigns.com/kb) for more details.

3/27/2019
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How to Create a Basic Schedule

1. Click the Schedule button in the Task List on the Messages screen.

+ 2. Click the Add button to open the message detail window where a new Play List will be created.

3. Select the Date and Time information desired from the drop-down menus and checkboxes.

4. Click the Messages tab or the EasyArt tab and double-click on the file name of choice to add it to the playlist
on the left.

5. Click the Save button to return to the Schedule screen where you will see your Play List created.
6. Slide the Playback Time Indicator over the area your Play List is set to run and watch the Schedule Preview
window at the bottom of the screen to be sure your message scheduling is correct.
How to Update Your Sign
@ 1. Click the Update Sign button in the Task List on the Messages screen.

2. Type you password into the Password Box. If you haven't set up a sign password yet, refer to the Password
Protect Your Sign section on page 63.

3. (lick the Update All Messages button.

4. If the update was successful, the window will close and the screen will say, “Your sign was successfully
updated.”If an error occurs, the window will stay open displaying the error.

5. Check out your messages on your sign.

HELP IS HERE - Help and Web Help buttons give you quick access to tips and information on any topic in Ignite. If your
PC has Internet access, Web Help is best. Watchfire's customer service department continuously works to improve the
Watchfire KnowledgeBase!

QUICK
TIPS
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Passwords

Password Protect Your Sign
Watchfire highly recommends setting a sign password.

1. Click on the Tools menu at the top of the screen and select Configuration.

2. Click Get Sign Controller Status to connect to your sign.
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3. Click the drop-down menu next to Password Protected and select Yes.

4. You will then be prompted to enter a password. After a password has been entered, you will get a warning box
saying that a password is set. Read the warning and click OK.

5. Click the Disconnect button to disconnect from your sign. After you disconnect from your sign, you will

always have to input this password to connect to your sign.

Password Protect Ignite

This password will be required upon opening the Ignite content management system. This feature is helpful when using

Ignite on a shared PC. It's typically not needed if you have a unique Windows login that is password protected already.
1. Click on the Tools menu at the top of the screen and select Configuration.

2. Click on Ignite Setup from the Task List on the left side of your screen.

3. Click the drop-down menu next to Password Protect Ignite and select Yes.

Password Protect Ignite: IND v
Sobodula Woglklhe A - IQun Dot

4. You will then be prompted to enter a password. After a password has been entered, you will get a warning box
saying that password protection has been turned on. Read the warning and click OK.

5. Click Save towards the bottom of your screen. If you do not click Save, the password will not take effect.

WHAT'’S THE PASSWORD? - Be sure to write your password down and store it in a safe place.

CHANGING YOUR IGNITE PASSWORD - After creating and saving a password for Ignite, you will notice a Change button
appears next to ‘Password Protect Ignite’ This will allow you to change your password at any time.

Passwords | 65
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Basic Terms

A few of you may be computer experts and will have no problem understanding the terms in this manual. But for those of
you who are not, we have included the following glossary to help you understand some basic terms you will find in Ignite.

Animation: Moving graphic or video clip. A large number are available in the EasyArt library that comes with Ignite.
Background: The layer of color behind the text and graphics layer.

Codec: A software component used to read audio and video data from files on your computer. Microsoft Windows ships
with codecs for many formats, including Windows Media Video (WMV). Many third party codecs are available to support
a wide variety of video file formats.

Cut/Copy/Paste: Simple tools found on the edit menu in Windows programs to move or copy information from one
place to another. You can also use the following shortcuts in Windows (and in Ignite) to accomplish these tasks once an
item or text is highlighted: Cut: Ctrl + X, Copy: Ctrl + C, Paste: Ctrl +V

EasyArt: The library of pre-made messages that comes with Ignite content management system.

Effects: Effects manipulate the way a frame Appears, Holds and Exits your sign. Clicking on the Effects tab takes you to
this area.

Font: The style of text.

Frame: An individual slice of a message consisting of Text, Graphic, Background layers and Effects. A series of frames
makes up each message.

Global Change: A change made to all frames of a message at one time.

Highlight: Clicking on an item frame, or picture, or clicking at the beginning of text and moving your mouse across while
holding the left mouse button down causing the text to change color.

Import: Inserting images or animations into a message from another source.
JPG/GIF/BMP: Types of photo and/or image files that can be imported into a frame.
Justification: Horizontal text alignment either to the right, left or center.

Layers: An individual frame element that is independently drawn on a single plane. Each frame contains three layers:
Text, Graphic and Background.

QUICK
TIPS
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Menu/Drop Down Menu: A list of choices displayed by clicking on the small triangle button.

Message: A series of frames stored in a file.

Monochrome: A sign that is only one color. Monochrome LED message centers are typically Red or Amber.
Pointer: The little arrow that moves when you move your mouse.

Schedule: Tells your sign what messages to run and when to run them.

Shadow: The border color around text used for accenting and giving the appearance of depth.

Tabs: Label at the top of a window that switches you to another section.

Thumbnail: A small picture showing a preview of what a message looks like. Any frame of a message can be selected as
the thumbnail. If none is selected, the first frame will automatically be chosen.

Utilities Button: The button found on most tabbed sections in the Message Editor. It is used to make Specific, Global or
Default (from now on) changes across multiple frames of your message.

BasicTerms | 67
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Frequently Asked Questions

Can | change a single frame's properties after | have used the Utilities button to change multiple frames?
Yes. Changing multiple properties with the Utilities button only sets the multiple frames to the same thing at that
point. You can then go through your message and make as many further changes as you want.

What if | forget my password or the person who knew it quits?
First, verify that your sign requires a password by trying to update it while leaving the password field blank. If a “Error:
Invalid Password” prompt is received, contact Watchfire Technical Support at 866-637-2645 or visit watchfiresigns.com/chat.

My sign is not working properly. What information do | need to have available before | contact Tech Support?
You need the name of your company, the location of the sign and a basic description of the problem. It's best to have
the sign’s “Sales Order Number” readily available.

How do | change how long a message plays?
You change how long messages play by adjusting frame hold times.

How many different messages can | set up in my schedule?
You can have as many as you need. Different messages can be set up to play every day of the year if you want.

How do | put my logo on my sign?
Using the Quick Start Image feature, import your logo as a compatible file type, such as Bitmap, GIF or JPG.

My sign is blank; what do | do?
Check the preview sign on the Schedule page in Ignite. If blank, schedule messages. Attempt to update the sign once
more. If the sign remains blank, refer to the “Blank Sign Troubleshooting” answer on watchfiresigns.com/kb.

How many frames can each message have?
A single message can contain up to 500 frames.

Most of my messages have disappeared from my message list. What do | do?
Be sure you have your category list set to All Categories.

How do | save and restore my existing schedule?
While in Schedule Mode, click on SCHEDULE at the top of the screen. Click on EXPORT SCHEDULE and choose a
destination for the exported file (the default will be your C: drive and the file name will be C:\signname.SCHED). Click OK.
Change, delete or add to your schedule.

When you are done training, click on SCHEDULE at the top of the screen again, choose IMPORT SCHEDULE, highlight
the file “signname.sched” and click OPEN at the bottom of the screen. Click OK. Your saved schedule is now restored.

For additional information, please go to our online KnowledgeBase at watchfiresigns.com/kb. Here you can search for
answers to questions that we may not have covered in this section of the manual. If you don't find the answer you're
looking for, click on the Live Chat tab for personalized help.

THE KNOWLEDGEBASE - The Watchfire KnowledgeBase, found at watchfiresigns.com/kb, is constantly updated by our
technical staff.

It's full of useful tips, tricks, videos and troubleshooting guides. It's the best and most exhaustive source for “Frequently
Asked Questions.”

QUICK
TIPS
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PC Requirements

A personal computer (PC) is needed to run Ignite, the application used to create and send messages to the sign. A new
sign owner has two choices for a PC to operate their new Watchfire sign:

1. Order New PC From Watchfire®'
All needed hardware & software pre-installed.
Sign & PC tested together prior to shipment.

2. Using An Existing Computer
Below are the minimum required specifications to ensure Ignite operates properly. Our helpdesk can only resolve
compatibility issues with computers provided by Watchfire, but most PCs will work.

Minimum requirements (all models, regardless of PC supplier):

Microsoft Windows 10, 8, or 7 (32 or 64-bit), or Mac OS 10.10 or newer running Parallels Desktop 10.10 or newer (with
one of the previously listed OS’s)

1GB of RAM (2GB+ recommended)

5GB of available hard-disk space

Video card capable of displaying 64,000 colors (1024x768)

Internet Explorer 8.0 or higher

Two available USB ports

DVD-ROM

NOTE: Some sign communication methods add to Minimum System Requirements. Refer to Communication System Requirements below.

Communication System Requirements
The following communication system requirements are necessary in order to communicate with your Watchfire Sign:

1. Network Interface Card
Required for High Speed Fiber, RWF Radio and Broadband communications

2. Standard phone modem
Required for phone communications

3. Video Capture Card
Required for XVS Live Video

' Laptop available; Watchfire part #33989. Not compatible with Live Video or Video Capture.

PC Requirements | 69
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1015 Maple St
Danville, IL 61832
watchfiresigns.com

Sales & Administration
217-442-0611

toll free: 800-637-2645
sales@watchfiresigns.com

Technical Support
watchfiresigns.com/kb
watchfiresigns.com/chat
service@watchfiresigns.com
866-637-2645
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Introduction

Welcome to Watchfire!

Congratulations on your purchase of a new Watchfire sign. At Watchfire, our goal is to provide you with the best product
in the sign industry, and that experience begins with the installation phase. This manual has been designed to help you achieve a
fast, high-quality installation.

There are several ways you can use this manual depending on your experience with Watchfire. If this is your first Watchfire
product, the manual will serve as an excellent how-to guide, from handling the LED modules to setting up the software required
to run the sign. More experienced Watchfire customers will find several changes from previous versions of the installation manual,
including updates on our newest products. We suggest that you look over the entire manual before beginning a detailed review
of any one component.

On the next page, you will find the Installation Checklist. Use it to guide your install and quickly reference sections if you have a
question. The Sign Configuration page at the front of the manual will also be helpful, because it lists details for this particular sign
that you may need to know during installation.

If you purchased a Time and Temperature sign from Watchfire, rest assured these signs are very similar to message centers and
follow the same basic installation procedures. Page 38 details the installation of the GPS antenna for Time and Temperature
signs.

Finally, be sure to review the Maintenance and FAQ sections at the very end of the manual for valuable tips to keep your sign
running smoothly for years to come. If you have additional questions, please visit our online knowledge database, the most up-to-

date reference for owning and operating your new signs, at: http://watchfiresigns.com/kb.

Congratulations again, and enjoy your Watchfire sign.
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Installation Checklist

Complete this checklist while working through the manual and installing the sign.

U Mount Sign

- Follow structural requirements as specified by structure manufacturer (see page 1).

« Follow proper handling instructions (see page 4).

- Ensure proper ventilation (see page 3). Proper ventilation dramatically increases the life of a sign.

« Install conduit where needed - water tight conduit required for connection to electrical box (see page 17).

Q Install Electrical Elements

« Refer to amperage & voltage requirements for the sign(s) as identified on nameplate (see page 13).

+ Route power wires to the terminal block, load center, or disconnect of the sign(s) (see page 15).
DO NOT turn on power at this time!

« Install a ground rod and connect to ground lug inside the sign(s) (see page 14). Ground rods help protect the
sign in the event of a lightning strike.

L Connect Data Cables and Conduits

- For installations with multiple sign cabinets, connect data cables from sign to sign (see page 18).
« Install conduit for exposed data cables. Most signs have outdoor rated cables and do not require conduit (see
page 17).

U Install Temp Sensor (Optional)
« Mount the sensor and route the cable to the twist-lock connector on the back of the sign (see page 20).

U Install Communication Options

« Radio: Install both sign and host radio for line-of-sight communications (see page 21).

« Fiber: Route “long” fiber from the sign to an indoor wall plate. Route “short” fiber from the wall plate
to the indoor PC equipment (see page 23).

» Broadband Wireless: Mount the antenna with antenna pointing toward the sky or towards the ground, on a
metallic surface (see page 24).

« Broadband DSL: Connect the DSL phone line and route 50’ fiber to the sign (see page 25).

+ GPS Time/Temp: Mount and connect GPS antenna to sign controller (see page 38).

O Apply Power
« Confirm proper electrical service and switch the appropriate breaker(s) to the on position (see page 13).

U Connect to Sign
« Install Ignite® on the host PC — not applicable to GPS Time/Temp units (see page 34).

U Schedule Software Training (Optional)

+ You can schedule software training online at www.watchfiresigns.com/ist (see page 36 for
more information).
« Call 800-637-2645 to purchase software training.
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Compliance Information

FCC Class A Compliance

All equipment in use by Watchfire has been tested and found to comply with the limits for a Class A
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial environment.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used

in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area may cause harmful interference in which case the user
will be required to correct the interference at the user’s own expense.

Changes or modifications not expressly approved by Watchfire could void the user’s authority to operate
the equipment.

National Electric Code

Watchfire signs are intended to be installed in accordance with the requirements of the National
Electrical Code, NFPA 70, and any other applicable local codes. This includes proper grounding and
bonding of the sign.

UL / CUL Compliance

.
Underwriters Laboratories (UL) certification is for manu-

facturers of electric signs built in accordance @ . {UL ) \E'gﬁlfllgevd
with the National Electric Code, NFPA 70. UL signs re- ’

quire pre-testing by UL before being allowed to use the LISTED CCR Title 24, Part 6, Section 148
UL mark. All Watchfire LED signs and digital billboards ELECTRIC SIGN ! ! Maximum Allowed Lighting Power
have been UL48 tested and approved. NO. XX 000000 [ 1Specific Lighting Source

Price Watcher™ gas price signs have been UL879 and )

UL879A tested and approved. L000000X0 © Undarwitrs Laboratories In. 2008

UL Energy Efficiency Certification

By marking our signs with the UL energy verified label (also referred to as the UL green leaf label),
Watchfire verifies that its LED signs and digital billboards meet the California Energy Commission
(CEC) 2008 building Energy Efficiency Standards Title 24, Part 6, and Section 148 of the California
Code of Regulation.

Watchfire products meet option B of the standard, the specific lighting approach. The signs use 100%
LEDs for lighting. The LEDs are powered by a power supply that is at least 80% efficient. Efficiency is
defined as the ratio of output wattage to input wattage at 100% load.
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Structural & Mounting Requirements

« Existing Structures: Make sure the structure is engineered The chart below lists suggested upright spacing for large 8" deep

to accept the Weight and wind load of a Watchfire sign cabinets. This may be required to meet local building codes. Refer
. to local code for proper windload requirements.

« New Structures: Make sure structure meets or exceeds
the state’s guidelines and all required regulations.

Wind Speed Upright Spacing
. Cfabine’g drawings inclucjed with.the sign will list the sign 88 mph T
dimensions and mounting locations. 120 mph -
« Install the sign cabinet so that adequate ventilation 150 mph o

is provided. Proper ventilation dramatically increases
the life of the sign. Please see page 3 for ventilation
guidelines.

Cabinet Types

Watchfire Signs come in 3 different styles and each has their
own mounting requirements:

« 5" Deep Slim Cabinet with Front Ventilation (S)
« 8" Deep Cabinet w/ Rear Mounting Track (FV)

Be sure to refer to any labels on the back of sign cabinets for
further details.

Slim Cabinet

All 5" deep Watchfire signs use a track on the back of the
cabinet to hold the head of a 12" bolt that may be used to
attach to a mounting angle. Signs that are less than 10" in
length must use 4 bolts evenly spaced across the top and
bottom of the cabinet. Signs between 10' and 24' in length
will use 5 bolts on top and bottom. These bolts are includ-
ed in a mounting kit that will ship with the sign. The bolt

is inserted in the track using the enlarged opening in the
middle of the track (see Figure 1). The angle is then attached
to the bolt using a nut and washer (see Figure 2). Tighten all Figure 1 « Slim cabinet mounting bolt inserted in track.
bolts to 45-50 ft-Ibs.

gh }

Figure 2 « Angle attached to slim cabinet mounting bolt.
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Structural & Mounting Requirements (continued)

8" Deep Cabinet w/ Rear Mounting Track (FV)

Insert two of the supplied 1/2" bolts into the bolt carriers
and install the carriers into the track (see Figure 1). Slide
the bolt carriers to the proper mounting locations.

Set the Stringer in place, add washers and nuts. Tighten
nuts to 60-70 ft-lbs using a 7/8" impact socket (see
Figure 2)

Figure 2 « Example of 18" Stringer with 1/2" bolts
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Watchfire cabinets are designed to minimize heat and provide durable
protection from the elements. The rear side of our cabinet features mill-finish
aluminum. Contact your Watchfire representative if a painted finish is required.

Ventilation Designs

Improperly ventilated signs risk overheating, which will affect the life and
operation of the sign.

Front-vent Cabinets (Price Watcher Included)

Watchfire front-vent cabinets and Price Watcher models draw air in through
vents on the lower edge of the cabinet. Patented multi-chamber cooling
provides built-in fans to ensure brighter, longer lasting LEDs with no need for
additional wiring or fan kits.

DO NOT BLOCK the air intake, exhaust or LED modules located on the front
face with any part of the metal cabinet or coverings.

Rear-vent Cabinets

Watchfire rear-vent cabinets draw air in through a vent at the bottom of the cabinet’s rear side, and use cooling fans located inside the
top of the cabinet to draw cool air up.

Ventilation must be completely unobstructed by mesh or louvers. To conceal a gap, calculate the open air portion of the concealment
material and (for each cabinet) allow 24 (or more) square inches of total air intake and 24 (or more) square inches of total air exhaust
per foot of cabinet length.

Optimal Ventilation Alternate Ventilation (Single Pole)
For signs 16" in length or longer OR signs with multiple pole installation — For signs up to 16' in length installed on a single pole - allow a minimum
allow a minimum 2" gap above and below the LED cabinet. Although ends 2" gap below the LED cabinet for optimal ventilation. DO NOT SEAL ENDS
may be sealed, it is best to use a loose mesh material or leave area open to if no gap exists above the cabinet.

allow for maximum airflow.
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DO NOT RESTRICT AIRFLOW on the cabinet’s rear side. A minimum 2" gap per face behind each cabinet is necessary. For wall-
mounted rear-vent cabinets, airflow must be unobstructed from top to bottom, in addition to leaving a minimum 3" gap between
the sign and wall.
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LED Module Handling & Addressing

Touching the LEDs can bend and misalign them. Bent LEDs will adversely affect the

display quality of the sign. In addition, bending LEDs can compromise the gel seal around the LEDs.
This can cause moisture to leak through to the circuit board. Touching the LEDs may also leave dirt
and oil which will also affect the display quality.

XYMl DO NOT let the LED modules hang from the cable assemblies. Wires may be pulled loose from the
connectors.

Removing and Replacing Modules (Sectional and Non-Sectional Signs)

1. To remove a module locate the locks and turn them counter-clockwise. See chart below for information on
specific module models.

a. °/3," Hex — Four locks, one in each corner (see Figure 1). Two locks in center of module at top and bottom
(see Figure 2). Turn both locks counter-clockwise.

b. 3mm Hex - Four locks, one in each corner. Turn all locks ¥4 turn counter-clockwise.

2. Firmly pull on module to remove it from cabinet. CAUTION: Water-tight seal on back of module may stick
to cabinet and pulling too hard on plastic louvers can cause them to break.

3. Disconnect both power and data connectors from back of module (see Figure 3).

Reconnect power and data connectors securely to the back of the module. Align the pins on the module
with the holes on the sign face. Tighten all locks clockwise.

Required Tool Sign Model Number of Locks
%52" Allen Wrench All 19mm 2
432" Allen Wrench 8mm, 10mm, 12mm & 16mm 4

Figure 2 « 2 Jocks

Figure 3 « Power and data connectors

Want to know more?
For drilling precautions, see page 17. For basic maintenance, see page 39.
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Removing and Replacing Modules (continued)

Indicates Lock Location

10mm

& NEVER let modules hang from their wires.
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LED Module Handling and Addressing (continued)

Addressing LED Modules

Watchfire LED signs are made up of multiple LED modules. For an LED module to play the appropriate data,
it must store its own unique address.

All modules are factory set with correct addresses prior to shipment. The sign must be re-addressed if a new module is
installed or if modules within the sign are relocated.

Setting Display Module Addresses

1. Ensure all LED modules are connected to the sign. Addressing will not work properly if a module is
not connected.

2. Turn off power to the sign cabinet that will be addressed.
Note: If the controller is a BC550 or BC760, turn off power to the entire sign.

3. Put the sign in test mode:
a. If Automated Diagnostics is enabled, simply cycling power to the sign will address the modules.
b. BC550 - The test/operate switch on the BC550 must be set to Test.
c. BC760 - The test/operate switch on the BC760 must be set to Test.
d

. BC760 with eFlare - The test/operate switch on one eFlare must be set to Test.
*Note: If you have the special set up of BC550 with bHubs- every bHub will need to be set to test to readdress the sign.

e. BC-860 will have eFlares. The test/operate switch on one eFlare must be set to Test.
f. M203 - The test/timeset/operate switch must be set to Test.

Turn power back on.

5. Monitor the sign as it goes through its addressing pattern. This will vary by sign model; some light up modules in a
vertical and horizontal sequence, whereas others show address numbers. The modules
will keep their addresses indefinitely, even during a power outage.

BC550:

The first module in each channel displays the channel number. Every channel displays the same color.
Each module will then display its address numerically.

BC760:

The first module in each channel will count up to the total number of
modules. Each module will then display its address numerically.

M203:

Each module will light up sequentially for each channel until all mod-
ules are on. All modules will briefly go blank and then back fully on.

Figure 1« BC760 Test Switch

Addressing is Complete
1. Wait at least one minute before setting switch back to Operate. You do not need to power off the sign.

2. A module has an incorrect address if it lights up at the wrong time. If that happens, repeat the address
setup procedure.

3. Ifamoduleis still not addressing after the proper test procedures, contact Watchfire Technical Support.
Ensure that the controller is powered up with the toggle switch in Test.
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General Sign Handling Instructions

Lifting straps should always be rated to exceed the load being lifted.
Do NOT attempt to lift the sign in sustained winds over 15 mph.
Tag lines should not be attached to a fixed point at ground level.
Signs must remain vertical at all times.
« Always use all available lifting points.

- Signs equipped with lifting eye hooks (see Figure 1) may utilize straps.
Signs must never be left free-standing.

+ Always have some means of vertical support.
« Larger signs may have sign supports included. If so, be sure to use them.

« Signs equipped with eye hooks or no more
than 2 eye bolts may utilize only straps so long
as the angle of the straps does not exceed 30
degrees offset from vertical.

« Signs containing more than 2 lifting eye bolts
must use a spreader bar.

« Ensure that all eye bolts are tightened into the
sign completely, so that the shoulder of the
eyebolt is in contact with the top surface of
the sign frame. The eyebolt must be installed
in an orientation parallel to the cabinet (see
Figure 2).

Figure 1 « Lifting eye hook. Figure 2 - Lifting eye bolt.

Spreader Bar Lifts

« Spreader bars must be constructed out of
material sufficiently strong to carry the weight
of the sign without any deflection along the
entire length of the bar (see Figure 3).

rrrr

« The length of the spreader bar must be equal to
or greater than 75% of the sign’s overall length.

« Straps between the spreader bar and the sign
must be as vertical as possible over the top of
each eyebolt.

+ All spreader bar straps must be of equal length.
It is best if these straps are as short
as possible.

-

Figure 3 « Properly attached spreader bar.
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General Sign Handling Instructions (continued)

If the sign meets all of the following requirements, it will use
lifting eyes that do not require a spreader bar.

« The sign is manufactured one or two
sections tall.

« Total sign height does not exceed 15 feet.

- Total sign length is between 19 and 49 feet.

Lifting System with No Spreader Bar

- Damage to sign frame can occur if proper lifting
techniques are not used.

« Spreader bar is not required.

« Recommend use of d-ring shackles.

« One strap per lifting eye.

« Straps must be rated for load.

« Leave lifting eye on sign or place in spares box after use.
- When reattaching lifting eyes, torque bolts to 65 ft. lbs.

Recommended strap angle is 60°, minimum of 50°.
Strap length is equal to half of the sign length.

Cabinet must remain upright at all times. Use Brackets to support multi-section signs during

assembly.

WARNING! Do not attempt to lift the sign in winds sustained over 15 mph. Consult the nearest

National Weather Service weather station or an anemometer for wind speed and direction at your
location prior to lifting. Tag lines should not be attached to a fixed point at the ground level.

WARNING! For Interlocking Extrusion Signs: Place the lifting plate or sign mounting hardware
directly in line with the lifting load path. Failure to do so could result in damage to sign frame.

For Interlocking extrusion signs. During installation, only reposition one middle mounting
component at a time. Moving more than one at a time could cause severe damage to the sign
[XTmIE cabinet and cause physical injury.
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Palletized Signs

Signs that are 3 modules or less in height
will be secured together with shipping
caps (See Figure 1). Signs that are greater
than or equal to 4 modules in height will
be crated with a wooden A-frame.

1. Attach lifting straps to the cabinet
that does not have plastic banding
over its hangers or lifting eye-bolts.

2. Remove the A-Frame assembly or
shipping caps along with any band-
ing material securing the first cabinet
to the pallet. Do NOT remove the
banding from the second cabinet
until after the first cabinet is secured.

3. Lift the first cabinet from the pallet
and ensure it is secured so it will not
tip over before going on to step 4.

4. When ready attach the lifting straps
to the other cabinet and remove the
plastic banding from hangers or lift-
ing eye-bolts and lift. Repeat this step
on the third face if applicable.

Non-Palletized Signs

Metal tele-strut feet are bolted to the
track on the rear of the sign. This allows
the sign a larger footprint and less of a tip
hazard. If the sign is shipped on a wood-
en deck trailer the feet may be nailed into
the deck. Do NOT remove the feet from
the sign until it is ready to be secured to
its permanent structure.

1. Attach properly rated lifting straps to
the sign's lifting eyes or eye-bolts.

2. Remove any nails that might have
been used to secure the feet to the
deck of the truck.

Figure 2 « Metal feet shown with sign supports.
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Sectional Sign Handling & Assembly

Signs must remain vertical at all times.
« Always use all available lifting points.

- Signs equipped with lifting eye hooks may utilize straps.

Signs must never be left free-standing.

« Always have some means of vertical support.
« Larger signs may have sign supports included. If so, be sure to use them.

Sign Supports

1.

Evenly place all included sign supports along the back
length of the bottom cabinet.

If the wooden feet are mounted perpendicular to the
sign, they may be left on. If the wood is comprised of
long planks, mounted in line with the length of the sign
(most common on signs shipped in containers), the
wood will need to be removed, though the metal end
caps should be kept in place.

Lower the bottom section of the sign until it is
approximately 3-5 inches above the ground. Place the
T-section of the sign support under the sign until the
short vertical upright is against the back of the sign.
Ensure that the supports are near one of the bolts that
are installed on the back of the sign.

Remove one of the 2" bolts from the top of the section
and bolt the other part of the sign support to the sign
using the 2" bolt. Complete this process with all of

the sign supports. On rear service signs, make sure the
supports are not directly behind any doors. If so, move
the supports to an area of the sign not covered

by doors.

Lower the sign until it is resting on the sign supports.
Make sure that the short vertical piece on the base of
the support is up against the sign.

Tighten the swivel bolt on the top of the section.

Have the crane reduce its load until the load straps just
barely relax. Check the sign to ensure that it is very close
to vertical. Tighten all bolts/nuts to 60-70 ft-lbs on the
sign supports.

Make sure the sign section is stable prior to releasing
the crane.

Figure 2 « Sign support.
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DO NOT allow a stacked sign to freely stand at any time, even if sign supports are still attached.

CAUTION!

Assembling Stacked Sectional Signs with
3 or More Sections

1.

Once the lower section of a sign is properly setup and
able to stand on its own, additional sections can be
stacked on top.

Front Service: Remove the LED modules necessary to
uncover the bolt holes in the top section.
Rear Service: Bolt access is available through rear doors.

If desired, this would be a good time to mount the steel
stringers to the top section, while it is easily accessible.

Place threaded guide pins in the middle hole on each
end of the bottom section.

Place beads of silicone, approximately 1" apart, around
the outer edge on the top of the bottom sectionin a
complete circle.

Raise the upper section and set on top of the lower
section, ensuring that the guide pin enters the middle
hole on each end. At this point, DO NOT place much
weight on the sign. The upper section should be kept
light in order to facilitate the bolting process.

For each set of holes, two bolts and one washer will be
required. Place the bolt with the washer in the hole at
the rear of the sign. It may be necessary to use a tool
such as a spud wrench in order to properly align the
holes. Hand start all bolts in the sign. Drive all the bolts
down until they are finger tight.

Once all of the bolts are in place, the crane can place
most of the weight onto the lower section. Starting with
the front row of bolts, torque them down to 75 ft. lbs.
Then perform the same action on the back row.

Figure 2 « Beads of silicone.
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Sectional Sign Handling & Assembly (continued)

1. Verify that there is no gap between the sections. The gap between the
two rows of modules should not be greater than gap between other
rows in the sign.

Remove the sign supports and attach the lower stringers.

Place a waterproof passthrough in the hole between
the sections, run the data cables through it, and
connect them.

4. Replace all the modules.

Note: If modules are not put in the exact same place they came from, then the
sign will need to be readdressed when it is powered on. See page 6.

. L Figure 1 « Gap between cabinets.
1. To unload from the truck, remove all nails from the shipping feet, at-

tached to the bottom of the lower sign section, prior to lifting.

2. Attach sign support brackets to the lower sign section and set it on the
ground.

3. Remove lifting eyes from the top of the lower sign section and install
guide pins on each end of the sign, middle of sign (when applicable),
and the two inner most lifting eye holes (no pins needed in the outer
two most lifting eye holes). Also install the left and right end alignment
brackets on the top of the lower section.

4. Remove all nails from the shipping feet, attached to the bottom of the
upper sign section, prior to lifting.

5. Lift the upper sign section off of the trailer and remove the shipping feet
by removing the 2" bolts from the rear track. This will require a 74" socket.

6. Remove the necessary doors along the bottom of the upper sign section.
Identify the holes where the shipping feet were installed and remove the
panels above them. Note: Only on signs with three or more sections.

7. Insert the supplied 2" bolts into the bolt carriers and install the carriers
into all tracks. See Figure 2. Two bolts required per top and bottom string-
er, four bolts required per middle stringer. Four bolts required per lifting
plate. One lifting plate or middle stringer is to be placed in line with each
lifting eye.

8. Apply a thin bead of caulk on the top of the lower sign section, approx.
1" in around the entire perimeter of the sign. Note: Not required for
Interlocking Extrusion Signs.

9. Set the upper sign section onto the guide pins until the upper and lower
sign sections touch. Use the cinch tool to pull the top section back flush
with the bottom section.

9a: Install the middle row of mini-stringers and lifting plates using the
provided 2" hardware and tighten with a 75" socket. Start in the
middle and work to the outside in each direction.
Watchfire's stringers must be used.
Using non-watchfire stringers is not permitted.

10. Lift and attach sign to uprights using the clamps. Ensure the clamp is slid
completely against the upright. Tighten the clamp bolts using the 1 %s"
socket. Repeat for each set of clamps.

11. Lift and attach the sign to the uprights using the Mini Stringers. Ensure
the Mini Stringers are slid completely against the uprights. Weld the Mini
Stringers to the uprights.
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12. Interlocking extrusion signs. The middle row of mounting hardware is
what holds the two sign sections together. If the middle hardware needs
repositioned during installation, only reposition one at a time. Moving
more than one at a time could cause severe damage to the sign cabinet
and cause physical injury.

13. Using the provided hardware, secure two beam clamps on the back of
the spare part box. Choose either the right or left side of the box. Install
the spare box on one of the uprights and above the lower catwalk by
tightening the bolts on the beam clamp.

Electrical Installation Requirements

If an electrical disconnect is not furnished by Watchfire, an electrical disconnect must be furnished
by the electrician.

(WARNING!|

Electrical Requirements

Refer to the nameplate on the sign or the Watchfire sales order sheet for the electrical service required for the
sign. The current rating found on the nameplate applies to that cabinet or sectional cabinet only.

Some LED message centers require 120-volt single-phase electrical service, with 2 wires (1 hot leg and 1 neu-
tral) plus a ground. Some very large signs require 240-volt single-phase electrical service, with 3 wires (2 hot
legs and 1 neutral) plus a ground.

Electrical Code Requirements

This sign is intended to be installed in accordance with the requirements of Article 250 and 600 of the National
Electrical Code and/or other applicable local codes. This includes proper grounding and bonding of the sign.

MODEL# WABRILS SERAL/I4oaF24
Refer to the signed quote or the nameplate on each face of " wi 61 S sor 124731
the sign for the required electrical service. Service frequent- DATE 09/15  suntable For Wet Locations
ly must run several hundred feet; a good rule of thumb is to SERVICE:
increase wire size one gauge for every 200 feet. 6 ~120v 1 v 60 w

Determining Electrical Service and Wire Gauge

watchfire-D

Figure 1 « Electrical nameplate.

Want to know more?

For instructions on handling LED modules, see page 4.

For conduit instructions, see page 17.

For instructions on connecting tagged cables, see page 18.
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Connecting Earth Ground & Power

Always follow the National Electric Code. Article 250 of the National Electrical Code describes
general requirements for grounding of electrical installations. Be sure to follow any local codes as well.

CAUTION!

Proper grounding protects equipment from electrical
disturbances such as lightning, line surges, and unintention-
al contact with higher-voltage lines.

1.

Install an 8' long, copper-clad ground rod within 25' of
the base of the sign. Certain environments may require
more than one ground rod due to soil type.

Attach the ground rod to a ground terminal inside the
sign cabinet.

DO NOT depend on the steel sign poles for grounding.
Steel poles may corrode over time and not provide a
good earth ground. Copper-clad ground rods resist
corrosion and retain their grounding properties.

Install the ground rod so its entire length is in contact
with the soil.

Make an electrical connection from the ground rod
to each sign cabinet. Watchfire recommends using
a minimum of 8 AWG wire to make the connection.
Install a separate ground rod for each cabinet if the
cabinets are more than 50' apart.

Securely attach the wire connecting the ground rod to

the sign. Be sure to protect the wire and its connection

points from corrosion. For example, route exposed wire
inside conduit.

Note: GND lug terminal is located about 1'to the right of the
incoming power DIN rail in 5" slim cabinets (See Figure 2).

Electrical Code Requirements: This sign is intended to be
installed in accordance with the requirements of Article
600 of the National Electrical Code and/or other applicable
local codes and ordinances, including proper grounding
and bonding.

Grounding Rod

Grounding
Rod Clamp

Ground Wire to ground terminal
inside each sign cabinet

Figure 1 « Grounding rod connection.

Figure 2 « Ground lug inside sign cabinet.
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120V Terminal Block Signs

Connect incoming power to the bottom of the terminal block
assembly, to the left of the breaker.

1. Connect line wire to the open terminal marked “L".
2. Connect the neutral wire to the open terminal marked “N".

3. Connect the service ground to the internal cabinet
ground lug.

Verify the current rating of the breakers and the conductors
that are supplying power to the sign. The current rating

of the sign is located on the nameplate on the outside

of the sign.

WARNING

AELCLASS T LED PRODUECT
HIGH VOLTAGE

DO NOT LOOK AT POWERED
LEDS AT CLOSE RANGE

o

Figure 2 « Alternate 120V terminal block.

240V Bus Bar Signs

Connect incoming power to the top of the Bus Bar assembly.

1. Connect neutral to the neutral block.

2. Connect line 1 to the left terminal on the bus bar.

3. Connect line 2 to the right terminal on the bus bar.

4 ConneoftI service ground to the internal cabinet _
ground lug. / v i1E

AR S R —

Figure 3 « 240V terminal block.
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Connecting Earth Ground & Power (continued)
Power & Data Surge Protection

240V Disconnect

The picture to the right shows the power connections inside
a standard 240V single phase disconnect. Sectional signs
typically have one disconnect per cabinet. Verify the current
rating for each cabinet; they may not be identical. Refer to
the nameplate for the correct current rating. Connect the
incoming power in the following manner:

« Connect both of the line voltage conductors to each
disconnect terminal block (°/32" Allen wrench).

« Connect neutral to the neutral bus. This is a current
carrying neutral and must be properly connected.

« Connect the ground to the ground lug.

- Verify the correct voltage is stable before turning on
sign disconnects.

Figure 1 « Standard 240V single phase disconnect.

Power Surge Protection

Due to the dangers of lightning and power surges, Watchfire recommends using an adequate power surge
suppressor with all network-connected computers.

Watchfire extends no warranty to any surge protection products. Connecting a suppressor improperly can
adversely affect the performance of the device it is connected to. Consult a qualified electrician for assistance
with properly connecting these devices.

Data Surge Protection

Using a data suppressor in addition to a power suppressor is recommended with outdoor-mounted radio
antennas or if the radio cable runs a long distance in an attic or drop ceiling. The data suppressor ground
must route to the same point as the host system ground via the shortest possible path. Install the suppressor
in between the radio and the POE or the computer as close to the POE or computer as possible. If grounding
points are not available, contact a qualified electrician.

Our RWF radios come standard with a shielded cable between the radio and the power supply.
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Additional Connections & Conduit Requirements

Conduit Installation
« Conduit may be installed in advance to hasten installation when the sign arrives.

+ Signs with a twist-lock data connection will have their connectors on the back
of each cabinet. Temperature sensors and radio connections are also located on
the back of the cabinet (see Figure 1).

« There are at least two holes in the back and/or bottom of each sign cabinet
that are plugged with caps where conduits may be attached. One is located
on the left end of the cabinet near the power terminal block. The other is
located on the right end of the cabinet. If practical, install conduit at these
locations. DO NOT route power and data cables together. If needed, similar
locations are marked on the false back where the back wall can be drilled
through for additional access.

+ Only use conduit fittings suitable for outdoor use. Route all electrical wires and
cables that will be exposed to the outdoors inside properly sized conduit.

Figure 1 « Twist-lock connections.

Drilling Precautions
« Always disconnect power to sign before drilling.

« Whenever possible, use the provided conduit openings in the sign, or drill where the conduit markings
are positioned in the false back inside the sign.

- Take care to avoid electrical components and wiring when drilling.
« Keep metal shavings away from live electrical parts, and remove the shavings when finished.
 Always seal any welds, screws, bolts and holes with an outdoor silicone sealant.

Radio and Temp Sensor

Watchfire radios do not require conduit unless specified by local code. The temp sensor cable is weatherproof
and does not require conduit unless specified. If required for either, conduit must be at least 1",

Fiber-Optic

Use 1%2" conduit. Fiber-optic cable may run in the same conduit as the power cable. Fiber-optic must not be
exposed to sunlight or weather. Make sure no water is in the conduit. When the water freezes it can break
the fiber.

Data Crossover
« Twist-lock data cables are weatherproof and do not require conduit unless specified by local code.

+ If the faces are separated by more than 300 feet a fiber-optic cable will be used for data crossover.
The fiber-optic cable may be routed along with power wiring inside the same conduit.
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Data Crossover Cables (2 options)
The sign ships with several cables labeled with color-
coded tags to assist installation. Match each colored tag

to its partner.

Data Crossover Cables

On multiple face installations where two or more sign
cabinets are used, data crossover cables link the secondary
cabinet to the primary cabinet.

+ Signs with a twist-lock data connection will have their
connectors on the back of each cabinet (see Figure 1).
The data cable will be marked with orange tape. Pull out >
the Ca_ble from the Secondary cabinet.The p”r,nary data Figure 1. Seondary cabinet (left) connected to the primary
cable is 5' long, and the secondary data cable is 35' long. cabinet (right).

Align the white dots on each connector and twist to
complete the connection.

« Large signs may have more than one data crossover cable.
Signs with several crossovers use colored tags to mark the
locations of the cables and their attachment points. These
tags extend past the modules on each face.
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Data Crossover Cables (2 options) (continued)

Data Crossover with Surge Suppressors

If the purchased sign included Watchfire's data crossover with surge suppressor option, then follow the
instructions below to complete installation.

1.

10.
11.
12.

13.

300' of copper cable is included with the sign and should be used to complete the data connection

between sign faces.

Determine what length of cable is needed between the two faces. Cut the cable to length if needed
(ex. If the distance between the two cabinets requires 100' of cable, cut the cable to 100" and eliminate

200' of excess cable).

If the 300' cable was cut to length, cut the insulation back and strip all six small wires so that */1"

of copper wire is exposed on each wire.

Locate the data line surge suppressor in the primary
sign cabinet. Itis a 5" x 2" grey box labeled PolyPhaser
(see Figure 1).

Remove the lid from the surge suppressor box.

Remove the wire grommet and wire tie from inside the
surge suppressor box. Set the wire tie aside;
it will be needed later.

Insert the data interconnect cable through the
grommet. Start inserting the wire on the side of the
grommet with the hook. (If needed, use the assembly
on the right side of the surge suppressor as a reference.)

Connect the six wires to the terminal block on the left.

The terminals are numbered 1 through 6 going from
the top down. Each wire has a different insulation color.
Connect the wires as follows:

« Terminal 1: Brown

« Terminal 2: Brown/White
+ Terminal 3: Orange

« Terminal 4: Orange/White
« Terminal 5: Green

« Terminal 6: Green/White

Figure 1 « PolyPhaser

Seat the grommet securely in the channel on the left side of the metal box.

Make sure the cable’s outer jacket sticks out through the grommet by */+6".

Attach the wire tie on the cable on the inside of the box next to the grommet. The wire tie will act as a

strain relief for the cable.
Re-attach the lid to the box.

Repeat steps 4 through 13 for the secondary sign cabinet.
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Temperature Sensor

A temperature sensor is optional. If the sign does not have
one, skip this instruction. Without a temperature sensor, the
customer can use the RSS temperature feed wizard in Ignite
to display the temperature on the sign.

1.

10.

Mount the temperature sensor in a shaded area if
possible, such as the side of a building or underneath
the sign. If possible, temperature sensors should be
mounted on the north side of a building or the sign.
Refer to the documentation included in the temp
sensor box for assembly instructions.

Mount the temp sensor away from heat sources such
as vents, walls, lamps or large objects that are in direct
sunshine. If possible, avoid mounting the sensor on the
top of the sign or on a roof.

If a hardware photocell is included, it will be on the
bottom of the temp sensor. It must be mounted where
it is not obstructed or in direct light.

Use the supplied bracket and hardware when mounting
the sensor. Supplied hardware includes a ¥4" bolt,
washer and nut. The bracket provides the minimum
spacing needed to reduce heat build-up.

Install the bracket vertically underneath the sign, an
overhang, or building soffit. If mounting to the sign,
drill a %4" hole in the bottom of the cabinet.

DO NOT drill holes in the side of the sign cabinet.

Mount the sensor so air is free to circulate around
the sensor housing. This will prevent heated air
from being trapped around the sensor and causing
a false reading.

Always mount the sensor so the open ends of the
plastic shields point downward.

DO NOT mount the sensor sideways.

The black temp sensor cables and connectors have
a weatherproof outer jacket. They do not need to
be routed in conduit unless specified by local code.

DO NOT cut or splice the cable. DO NOT use wire nuts
to make electrical connections to wires within the cable.
Contact Watchfire for a replacement cable if the cable

is damaged.

Figure 2 « Temperature sensor with horizontal mounting

bracket.
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RWF Radio

+ Two radios are included with your sign: One for the PC
and one for the sign. Both radios are labeled accordingly.
The radios cannot be switched. Doing so will result in
communication failure.

DO NOT cut, splice, or modify the radio cables in any
way. This will void the warranty on all radio parts.

CAUTION!

« DO NOT place anything in front of the radios that could
obstruct their RF signals.

« DO NOT mount the sign radio inside the sign or any
other metal structure.

« Make sure both radios are positioned so their faces are
pointed towards each other.

+ Elevate the radios above any obstructions.

Sign Radio Installation

1. Mount the sign radio so that it will be line-of-sight with
the PC radio. Mount the radio vertically so that the cable
will be pointing toward the ground. Place it above or
away from any obstructions. Both the radio and its cable
are rated for outdoor use.

2. Remove the LAN cover from the bottom of the radio
by pressing in on the tab on the back of the radio and
sliding the cover down.

3. Pull the radio cable out of the back of the sign cabinet
and make the connection to the sign radio.

4. Replace the LAN cover by centering the cable into the
opening and sliding the cover upwards until it "clicks"
into place.
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RWF Radios (continued)

RWF Host Radio Installation

1.

Verify that the radio is labeled “PC Radio." The radios are
not interchangeable.

Mount the host radio:

« Vertically and within clear line-of-sight of the sign radio.

« Place it above or away from any obstructions. The
best signal quality is achieved through outdoor, line-
of-sight placement.

« DO NOT mount the host radio near wifi access
points or wireless routers. It causes interference
issues. These are directional radios. They must
have the faces pointed towards each other to

(LI receive good signal.

« The POE adapter is not rated for outdoor use. If
possible, mount the radio near a window. Both the
radio and its cable are rated for outdoor use.

Route the radio cable from the host radio to the host
PC. Unless required by local codes, the radio cable does
not need to be placed in conduit. Route the 100’ radio
cable. Do not extend the cable - if the cable is not long
enough to maintain good signal strength; you could
put the radio on your network. See instructions in the
RWF manual. Routing the cable through plenum spaces
is not recommended, because the cable is not

plenum rated.

Connect the radio cable to the POE port on the POE
adapter (see Figure 1). The POE adapter is not rated for
outdoor use; it must be placed indoors. This is how the
radio gets power. Do not plug anything except the radio
cable into the POE port.

Connect the AC cable, included with the POE adapter, to
an AC outlet. Plug the other end of the AC cable into the
POE adapter.

Connect the included 3' Ethernet cable to the LAN port
on the POE adapter. Connect the other end to the USB
to ethernet external NIC adapter. Instructions on setting
up the USB to ethernet NIC adapter can be found on
page 33.

ToAC
wall plug

!

LAN to PC

w‘network
Figure 1 « POE adapter.

Only Use
To P P C Provided
Shielded

RWF Data Cables

HOST RADIO
P N. 950302
Slgnal

Point Radios Towards Each Other
Ll C

Figure 2

Figure 3 « LED's on the back of the radio indicate
signal strength.
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High Speed Fiber

High Speed Fiber

*Refer to the High Speed Fiber manual for complete setup instructions.
Connect the long fiber to the BMC in the sign.

2. Atthe sign, the blue connector attaches to RX and the
orange or red connector attaches to TX.

3. Connect the other end of the long fiber to an indoor wall
plate.

4. Connect the short fiber, included with the sign, to the wall
plate. It is very important to use the provided short fiber
and wall plate. Using the short fiber decreases the chances
of damaging the long fiber in the future. It is also important
for TX and RX to be straight through on the wall plate. For
example, the blue long fiber will connect on one side of the
wall plate, and the blue short fiber will connect directly on
the other side of the wall plate.

5. Connect the other end of the short fiber to the included
Media Converter. Connect the blue fiber-optic cable to the
XMT plug and the red/orange fiber-optic cable to the RCV
plug on the Media Converter.

6. Connect the Media Converter AC cable to the Media
Converter. Plug the other end of the AC cable into an AC
outlet.

7. Connect one of the included 3' Ethernet cables into the
network port on the Media Converter. Connect the other end
of the cable to the Media Converter port on the Fiber Router.

8. Connect the Fiber Router AC cable to the Fiber Router. Plug
the other end of the AC cable into an AC outlet.

9. Connect the second 3' Ethernet cable to the PC/LAN port on
the Fiber Router. Connect the other end of the cable to the
USB to ethernet external NIC adapter.*

*If connecting to a LAN, first program the Fiber Router from a PC,
and then connect the Fiber Router to the LAN. See the Network
Configuration section of the High Speed Fiber manual for details
on configuring the Fiber Router for network use. See page 33 for
instructions on setting up the USB to ethernet external NIC adapter.

f B‘J

BaF ELECTROMCS

Figure 5 « USB-to-Ethernet NIC adapter
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Broadband Wireless

Broadband Wireless

The BBW is a high-speed internal cellular communication
unit for the sign. It receives a cellular internet signal through
its antenna and converts it to Ethernet. This enables the
sign to have an always-on internet connection. Depending
on the size and model of the sign there may be a BBW or a
BC760/BBW

Watchfire requires a yearly fee and data plan agreement. If
the data plan expires and has not been renewed, connectiv-
ity to the sign will be impaired. To reactivate service please
contact Watchfire Technical Support at 1-866-637-2645.

Connect Antenna
Here

1. The BBW is a high-speed internal cellular
communication unit for the sign. It receives a cellular
internet signal through its antenna and converts it to Figure 1. BBW
Ethernet. This enables the sign to have an always-on
internet connection. (Figure 2)

2. Theantenna (Figure 2) has a magnetic base. The
antenna must be mounted perpendicular to the
horizon. The easiest way to mount the antenna is by
magnetically attaching it to the stringer on the bottom
of the sign. If that is not an option, the antenna may be
placed on top of the sign, or a metal bracket
may be used.

3. Route the antenna cable inside the sign cabinet and
attached the antenna cable to the “cellular” port as seen
in Figure 1.

4. Power on the sign and check the lights on the BBW
modem (see Figure 3). Figure 2 « BBW Antenna

Figure 4 - BBW Figure 3 - Status Indicators
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Broadband DSL

Broadband DSL

The DSL modem resides in a weatherproof, NEMA-rated
enclosure. In most scenarios and prior to sign shipment,
Watchfire will work with the customer in order to obtain in-
ternet service with a local provider of their preference which
allows the modem to be programmed prior to installation.

DSL Setup

Pictured to the right is the assembly — referred to as an
OA700-DB — which provides all necessary connections for
DSL service and ships housed within the NEMA enclosure.
Please reference the image for assistance with making
connections.

1.

5.

Turn power OFF on the breaker (1) located on the DIN
rail assembly. Three wires bring power into the terminal
block: line (L) - black, neutral (N) - white, and ground

- green, which attaches to the green/yellow terminal.
Connect power.

Connect the DSL phone line running from the
telephone company’s NID (Network Interface Device)
to the top of the RJ-11 surge suppressor (2). Route the
cable via conduit (34"+) through the bottom of the
NEMA enclosure.

Verify the three DSL modem (3) connections. The

phone line connects to the bottom of the RJ-11 surge
suppressor (2) from the “line” port on the DSL modem.
The Ethernet cable connects to any port on the Ethernet
switch (4) from the “ETH” port on the DSL modem.

The DC power cable from the DSL modem connects

to the 12 VDC power supply (5).

Connect the provided 50' dual-strand fiber cable
from the Ethernet switch (6) to the BEF inside the
sign cabinetry.

Turn the power breaker (1) on.

Note: The GFCl electrical outlet (6) is included for troubleshoot-
ing purposes only, and should have no devices connected.

Incoming Phone

Line (DSL) —l

m—— Fiber
BN Ethernet

Incoming Power

I Phone Line
mm——— DC Power

Figure 1« OA700-DB
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RWF Walk-Up Radio
*Please refer to the RWF Walk-Up Installation Guide for more detailed information regarding this option.

RWF Walk-Up Radio

The RWF Walk-Up Radio is a close range wireless option that uses 802.11 WiFi standards. One RWF radio is
mounted at the sign. An internal or external WiFi card can then be used with a laptop to update the sign.

General Mounting Guidelines

+ Do not place anything in front of the radio that could obstruct its RF signal.
« Do not mount the radio inside the sign or inside a metal structure.

+ Elevate the radio above any obstructions.

« Mount the radio so that it will be line-of-sight with the wireless computer.

To Install

1. Mount the sign radio so that it will be line-of-sight with the location you will be updating the sign from.
Mount the radio vertically so that the cable will be pointing toward the ground. Place it above or away
from any obstructions. Both the radio and its cable are rated for outdoor use.

2. Remove the LAN cover from the bottom of the radio by pressing in on the tab on the back of the radio and
sliding the cover down. Pull the radio cable out of the back of the sign cabinet and make the connection
to the sign radio.Pull the radio cable out of the extrusion on the back of the sign cabinet and connect it to
the radio.

3. Replace the LAN cover by centering the cable into the opening and sliding the cover upwards until it
“clicks” into place.

Note: Both the radio and its cable are rated for outdoor use.

Computer Setup
1. Make sure the sign is powered on.
2. If using a built-in Wi-Fi card, click the wireless networks list icon on the taskbar.

3. Ifusing the included external USB Wi-Fi card, insert the driver CD and follow the onscreen instructions.
Plug the USB Wi-Fi card into the computer.

4. Find the network labeled WF012345 (WF followed by the sales order number of the sign) and click
Connect.

5. Enter the security key. The key can be found inside the front cover of this manual or inside the RWF
Walk-up manual.

6. Verify that it connects to the sign. If an exclamation point is located next to the wireless networks list icon,
that’s OK; this indicates there’s no connection to the Internet.
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RWF Walk-Up Radio (continued)

Ignite Setup

1. Insert the Ignite CD into a laptop and follow the on-screen instructions to install Ignite.
2. On the Ignite Auto Configuration page, click Network Connect Page.

3. Enter 172.24.128.1

4. Click Next.

Ignite is configured to communicate to the sign.

Radio Security

The RWF sign radio operates in the 2.4 GHz spectrum using WPA2-AES encryption for communication. The
SSID is exclusive to each sign and is broadcasted so it can be seen from a wireless laptop. Each radio uses a
WPA2-AES encryption key that is generated by Watchfire Signs and is unique to each sign. Watchfire Signs
keeps all encryption keys confidential. Sign communications can only occur with a licensed copy of Ignite soft-
ware. For more information concerning RWF radio security, contact Watchfire Technical Support.

Want to know more?

For the wireless network adapter’s WPA2 key, see the Sign Configuration page at the beginning of this manual.
For conduit instructions, see page 17

For instructions on how to set up software, see page 34.
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Fiber XVS with Live Video

Fiber XVS with Live Video

Watchfire offers two separate Live Video configurations, Live Video Only and Live Video On-Demand, which
enables a sign to feature live video or Ignite message scheduling functionality. Because the computer
connects to and also runs the sign, it must remain powered on at all times.

The Live Video feature allows messages to be displayed in real time on the sign. Data is sent directly from the
camera or video device to the sign without the need for editing, saving or managing. Live Video is not limited
to live action. It is also capable of playing content from a TV, DVD player or other device on the sign.

Be mindful of any copyright on material from these sources.

Live Video Only is attached to a 24/7 video source which fundamentally converts the sign into a video
playback device. Scheduled messages are not capable of playback. It is used only for setup and trouble-
shooting purposes.

Included with Fiber XVS with Live Video:

High-end Dell with video capture hardware computer configured at Watchfire factory (rack-mount PC
available at additional cost)

+ Fiber-optic Cable

video
source
sign controller
/
// .....

'JULI fiber cable
[TTTTTTTTIT

Standard Live Video hardware setup.

watchfire=D)

Setting Up Ignite for Live Video
Ignite needs to be set up to properly work with Live Video.

« Click Tools > Configuration > Sign Configuration. The Sign Controller Type must be set for Direct Connect
Flare-Ethernet, Direct Connect Flare550-Ethernet or Direct Connect eFlare, depending on the hardware
in the sign.

+ Click Tools > Sign For Windows. Click Live Video from the toolbar and select the appropriate video input of
the capture cable.
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Fiber XVS with Indoor Sign Controller

Fiber XVS with Indoor Sign Controller

The Indoor Sign Controller option is best utilized for uploading large amounts of content to be displayed on
the sign. Unlike most controllers installed inside the sign cabinetry, an Indoor Sign Controller takes full advan-
tage of available Ethernet speeds of the customer’s network while converting and transferring data to the sign
via fiber-optic cable. Though this setup is not suitable for Live Video, the very high update speed is perfect for
working with large messages containing custom images and video files. Setting up the Fiber XVS with Indoor
Sign Controller option is simple and easy to do.

+ Because the Indoor Sign Controller connects to and also runs the sign, it must remain powered on at all times.

A separate host PC will be setup to communicate directly to the Indoor Sign Controller via Ethernet using
the Ignite software.

+ Included with Fiber XVS with Indoor Sign Controller
+ High-end Dell Computer (Rack-mount PC Available at additional cost)
+ Fiber-optic Cable

watchfire=D

sign controller

fiber cable

host computer

network _— %

connection / Wy
/ = (e}

(1] E

Standard Indoor Sign Controller hardware setup.

Setting up Ignite to connect to the Indoor Sign Controller

1. The NICin the PCis programmed to use an IP of 192.168.13.100. This can be edited to work on the
customer’s network, the IP needs to be a static IP. The Fiber NIC is used to connect to the sign.
DO NOT change any network settings on the Indoor Sign Controller Fiber NIC. The internal NIC is pre-
programmed to communicate to the sign.

2. Install the Ignite software on the host PC that will be used to update the sign. Follow the Ignite Quick
Setup instructions (page 34) to configure Ignite. Choose the Network Connect Page option and enter
the static IP assigned to the Indoor Sign Controller.
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Webcams

The wide-angle, fixed view camera comes standard with
Watchfire Digital Outdoor signs. The webcam is mounted
on an articulating boom. Its wide-angle lens provides a full
view of the sign. Advertisers can view the sign at any time
through the easy-to-use web interface.

The webcam allows for image capturing as well as monitor-
ing. Frame rate and image quality are factory optimized for
viewing the LED sign.

Mounting the Camera Boom

1. Mount the webcam assembly to the boom arm using
the two provided bolts. To avoid damaging the camera,
do not over-tighten the screws.

2. Determine if the camera will be mounted on the left
side or right side of the sign. Assemble the camera
boom bracket in the proper orientation for bottom left
or bottom right side mounting. Use the L-shaped bolt
alignment plate before attaching the boom bracket to
the back of the sign.

3. Using the hinge bolt provided, attach the boom to the .
bracket. Tighten hardware to 60-70 ft-lbs and insert _
the pin to hold the boom in the proper orientation. / e,
Remove the pin to swing the boom in toward the face RSO Mt

of the sign for servicing. Figure 2 « Boom mounted in interface bracket and
retracted to servicing position.

4. The camera cable and ground wire are outdoor rated
and do not need to be routed through conduit unless
specified by local codes. No tie-downs are included,
as typically, the cable is routed inside the boom. At the
camera end of the boom, ensure a drip loop is made
in the cable and secured to the boom as close to the
camera as possible.

5. When the camera is on the left side of the display:
The camera cable may be installed through a pre-
installed grommet in the back of the sign. The 8-pin
push lock connector will connect directly to the POW-
48 inside the sign cabinet after disconnecting the
extension cable currently connected to the POW-48.

Figure 3 - View of a Watchfire sign, as seen through
the webcam.

6. When the camera is on the right side of the display:
An extension cable should be coiled up in the right side
of the sign. A grommet is provided to seal this to the
pre-drilled hole in the back side of the sign cabinet.
While the cable is weatherproof, the connectors are not
and should always reside inside the sign cabinet.
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HS900 & NEMA Box Enclosures & Spare Parts Box

Mount the NEMA Housing on the Sign Pole

The air-conditioned NEMA box ships with a set of external
mounting brackets used to mount the main housing on the
sign pole. Watchfire recommends using Unistrut framing bars
(see Figure 2) in conjunction with these mounting brackets to
secure the main housing to the sign pole. Apply silicone
sealant to all bolt connections.

s B
o

“Broadband communication equipment, §

»

PC, and Fiber connection to sign

Cabling

Each communications housing is custom built per the

communication option. USB'Monitor for PC, iBoot, Terminal

block and surge protector

+ Route the fiber cable from the fiber input to the sign.
« If using a cellular modem, route the modem’s antenna
cable through the 1" conduit opening and connect it to

the cellular modem. Figure 1 « The communications housing contains three inter-

« If using RWF, route the RWF antenna cable through the nal shelves and the attached air conditioner.
1" conduit opening and connect it to the POE.

+ If using a DSL modem, route the phone line to the surge
suppressor and then the DSL modem.

Connecting Power Figure 2 « Unistrut framing bar and mounting brackets on

The NEMA housing is powered by a 120V terminal block on the !¢ backofthe ACNEMAbox
bottom shelf.

« Route the electrical wires from the main circuit
panel through the predrilled conduit opening in the
NEMA housing.

: Connegt the green groundmg wire to the groundl,ng Iu,g’ Figure 3 « Closeup of the spring nut and bolt used with the
the white neutral wire to the neutral bus and the line wire Unistrut framing bar.
to the line bus.

+ Plug the air conditioner’s power cord into the outlet
provided, and then switch on the circuit breaker.
Spare Parts Box

1. Plan for a suitable location to mount the spare parts box.
Considerations:

a. Box accessibility from the catwalk (see Figure 4).
b. Weight of the box. Figure 4
¢. Box door being able to fully open.

2. Install the included beam clamps to the box: two clamps
on the top and one on the bottom (see Figure 5).

3. Mount the box to the sign structure (see Figures 6 and 7).

Figure 6 Figure 7
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PC Requirements

A personal computer (PC) is needed to run Ignite, the application used to create and send messages to the
sign. A new sign owner has two choices for a PC to operate their new Watchfire sign:

1. Order New PC From Watchfire®'
All needed hardware & software pre-installed.
Sign & PC tested together prior to shipment.

2. Using An Existing Computer
Below are the minimum required specifications to ensure Ignite operates properly. Our helpdesk can only
resolve compatibility issues with computers provided by Watchfire, but most PCs will work.

Minimum requirements (all models, regardless of PC supplier):

Microsoft Windows 10, 8 or 7 (32 or 64-bit), or Mac OS 10.10 or newer running Parallels Desktop 10.10
or newer (with one of the previously listed OS's)

1GB of RAM (2GB+ recommended)

5GB of available hard-disk space

Video card capable of displaying 64,000 colors (1024x768)
Internet Explorer 8.0 or higher

NOTE: Some sign communication methods add to Minimum System Requirements. Refer to Communication System Requirements below.

Communication System Requirements

The following communication system requirements are necessary in order to communicate with your
Watchfire Sign:

Network Interface Card
+ Required for High Speed Fiber, RWF Radio and Broadband communications

Video Capture Card
+ Required for XVS Live Video

! Laptop available; part #33989. Not compatible with Live Video or Video Capture.

Want to know more?
To set up software, see page 34.
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Setting up the USB to Ethernet External NIC Adapter

The USB to ethernet external NIC adapter can be programmed to
a static IP address that is able to communicate with the RWF radio,

high speed fiber router, or live video computer.

1. Connect the external USB/Ethernet NIC to an available USB port

on the computer.

2. Go to the Network and Sharing center of the computer.*
Start Menu > Control Panel >Network and Sharing Center >

Change Adapter Settings

3. Right-click the adapter labeled Local Area Connection 2 or

ASIX. Select Properties.

4. Highlight Internet Protocol Version 4. Select Properties.

Select Use the following IP. Set the IP address to 192.168.20.5.
Set the Subnet mask to 255.255.255.0. Click OK.

Note: For an Indoor Sign Controller set up, the static IP address
will be used during the configuration process on the host PC.

*If you cannot find the Network and Sharing center try this: Select

Figure 1 « USB-to-Ethernet

NIC Adapter.
'? » Control Panel » MNetwork and Internet + MNetwork Connections » - {i, ‘ ‘ Se.
r Disable this network device Diagnose this connection Rename this connection

Local Area Connection | Local Area Connection 7
tomnet.com %  Network cable unplugged
Realtek PCle GBE Family Controller (3§ @7 ASIX A &

Disable
Status

Diagnose

& Bridge Connections

the Start Menu and type "ncpa.cpl” in the Quick Search field. Press EH‘ Shorteut
Enter. & Rename
‘ % Propertics
Steps 2 &3
U Local Area Connection 7 Properties u Internet Protocol Version 4 {TCP/IPv4) Properties M

Networking | Sharing

Connect using:
‘ \EF‘ ASIX AX88772 USB2.0to Fast Ethemet Adapter #5

This connection uses the following items:

% Client for Microsoft Networks

381 \itual PC Network Fiter Driver

4= QoS Packet Scheduler

481 File and Prirter Sharing for Microsoft Networks

& [ntemet Protocol Version 6 (TCP/IPv6)

+ <ifm
& Link-Layer Topology Discovery Mapper 1/0 Driver
-&. Link-Layer Topology Discovery Responder

Install... Uninstall
Description
Transmission Control Protocol/Intemet Protocol. The default

wide area network protocol that provides communication
across diverse interconnected networks.

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@) Use the following IP address:

1P address: 192 .168. 20 . 5§
Subnet mask: ps5 . 255.255. O
Default gateway: ‘ ‘ ‘

Obtain DNS server address automatically
@ Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[] validate settings upon exit

ok J[ Cancs ]

Step 4

Step 5
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Quick Setup for Auto Configuration

The Auto Configuration Wizard attempts to connect to the sign in
order to download the configuration details from the sign controller.
Follow these simple steps to configure Ignite and connect to the sign.

To get to the Auto Configuration Wizard in Ignite, click on Tools >
Configuration > Add Sign.

1. Be sure the sign is turned on. It should be playing a default
message.

2. Install Ignite on the host PC. If the sign does not have power,

File View | Tools | Help
i g Configuration
: Message Logging

Sign For Windows

Font Editor

Font Settings

Windows Explorer B

choose Manual Configuration Page, and refer to the inside cover

for Sign Configuration.

1i MESSAGES

Note: Auto Configuration is preferable. If possible, wait for the sign to be powered

on.

3. Watchfire offers many communication options. Choose the
appropriate sign communication method from the three options

below and follow those instructions.

Note: For RWF Walk-up radio, please see page 26 of the installation manual or the
RWF Radio Walk-Up guide (Answer 1544 on watchfiresigns.com/kb).

File View Tools Help

watchfire<D)

ignite OF

TASK LIST
Configuration Summary
Sign Configuration
Sign Controller Setup
Ignite Setup
Import Configuration

Leiele =100

CONFIGURATION SUMMARY

Sign Configuration - Sign 4

MName: Sign 1

Time-O-Matic Order Number:

Model- Watchfire W35 - 35mm, W46 - 46mm

Matrix: Height x Width: 16 x 64 (pixels)

MNumber of Faces: 2

EasyArt Installed: Yes Update EasyArt From DVD

Sign Controller Type: Ethernet Communications to Sign Controlle
Sign Controller Model: Model BC550

Data Wiring Scheme: Standard

3/2F420Ne8d help? Contact support at watchfiresigns.com/kb or 1-866-637-2645 BidSync
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Quick Setup for Auto Configuration (continued)

a. RWF Radio, High Speed Fiber or HSR: If the sign has High Speed Fiber, RWF Radios or HSR, connect the
equipment to the host PC at this time. The drivers will install automatically. Click the Click Here link on the Auto
Configuration Wizard. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Host Computer

Host Computer RF Receiver

Fiber Fiber Media
Router Converter

RF Transmitter
Fiber Cable
+—»

High Speed Fib
igh Speed Fiber RWF Radio / HSR

b. Broadband Wireless, HSR, High Speed Fiber set to a static IP on the network, or RWF Radios that have
been programmed to a static IP on the network: If the sign has Broadband Wireless, HSR, High Speed Fiber or
RWF Radios that have been programmed to a static IP on the network, click Network Connect Page and enter
the static IP. Click Next. The Wizard will attempt to connect to the sign and download the sign configuration. If
communications are established, the Auto Configuration Successful screen will appear. Click Finish.

Cellular Antenna

Host Computer

RF Receiver

Host Computer

RF Transmitter

Internet
Connection

Broadband Wireless RWF Radios/HSR Programmed to Static IP on the Network

Host Computer

Fiber Interface Fiber Cable
] -—»

High Speed Fiber Programmed to Static IP on the Network

4, Once Ignite has been configured for the sign, install the EasyArt Graphics by inserting the included EasyArt disc. The
correct size of EasyArt will be installed. If the EasyArt was installed before the configuration was set in ignite, it will
need to be reinstalled. The default location for where the EasyArt is installed, can be found here: C: > Program files >
Ignite12 > MsxArt

If the Ignite Auto Configuration Wizard fails to connect to the sign, the Auto Configuration Failed message will appear.
Check connections and power to the communication equipment and be sure the sign is playing a message before
clicking Retry. If the problem persists, click View Log and review the error messages for possible solutions. View the
“Troubleshooting Auto Configuration” help answer on watchfiresigns.com/kb for further steps.
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Ignite® Software Training

Watchfire has developed the most user-friendly software package in the industry. Ignite is set up for quick, easy
learning yet contains enough horsepower to cater to the most demanding content developer. If you ever reach a
stumbling block or would like to go beyond the Ignite manual, you can choose to participate in a web-based training
option to take your content creation to the next level.

Web-based training is an excellent option for users who have access to the internet at their location. The software
trainer will allow you access to view their computer screen with Ignite configured to match your sign, and they will
guide you through the steps of creating content for your Watchfire sign. We also use this method for general Ignite
overview sessions. Attendees from multiple locations can connect to the same session, which makes this an excellent
option for users with employees in remote offices. Audio is handled via a standard conference call. Watchfire will
provide a common phone number for all attendees to dial into. Web-based sessions are typically 1 to 1 %2 hours in
duration. Check the front cover of this manual to see if training was included with your sign purchase.

Schedule convenient, online training at watchfiresigns.com/ist. If you would like to purchase Ignite software
training please call Watchfire Technical Support at 1-866-637-2645. Training is good for the life of the sign, and
you can schedule training as often as needed.

Please select a training type:

Ignite OP Group Webinar (Desktop)
Ignite OP v12 (Desktop)

Group webinars are offered once a week. This one and a half hour webinar includes up to three users. A presentation covers
basic and advanced functions. The webinar ends with a question and answer session °

Note: Group trainings are typically unavailable when there are many available individual training slots. If you have a group of
users at one location, please sign up for the individual training instead.

Ignite Software Training

Ignite QP and OPx2 Software Training.
Each is available in three formats: Full Training, Just the Basics, and Advanced Training only. °

This option should also be used for a single company with multiple users at one location.

OPx2 Group Training (Cloud)

lgnite OPx 2 (Cloud-based)

Group webinars are offered once a week. This one and a half hour webinar includes up to three users. A presentation covers

basic and advanced functions. The webinar ends with a question and answer session. o

Note: Group trainings are typically unavailable when there are many available individual training slots. If you have a group of
users at one location, please sign up for the individual training instead.

Minimum internet connection: Cable modem, DSL or better Internet connection
Web browser: Internet Explorer 8 or newer, Mozilla® Firefox® 24 or newer, or Google™ Chrome™ 23 or newer

Check out our new online tutorials at www.watchfiresigns.com/kb. Click on OP VIDEQOS or OPX 2 VIDEOS,
whichever is relevant to your configuration.

WatChﬁl'E‘O Search...

# TOPICS OPVIDEOS OPX 2 VIDEOS
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Automated Sign Diagnostics

Automated sign diagnostics help technicians and
customers identify and solve problems faster and more
effectively than ever before. The sign diagnostics report can
be accessed on the left side of the home screen in Ignite.

+ Note the Sales Order number displayed at the top of the
window. This number allows Watchfire technicians to
quickly locate any prior service information relevant to
the sign.

« Sign diagnostics displays the report in both text and
graph format. The graph representation of the sign

ROER 1475
it W o vectons
Bx 1 (HaW) pon-criticad mastuncions)
24 x 24 M)

Tah 1 240 () |

P

highlights malfunctioning LED modules (see Figure 1).
- Modules highlighted in red have critical malfunctions,

Figure 1 « Graphic diagnostic display.

which can likely be seen on the sign. Modules high-
lighted in yellow have non-critical malfunctions, which
may not be visible on the sign.

+ Click a highlighted module to see details of the
malfunction. The location and type of error will assist the
technician during troubleshooting.

- The red modules display a window of error details.
First Detected is the first time the diagnostic program
detected the malfunction. Last Detected is the last
time the software detected the error. Elapsed Time
is the difference between the two.

- The yellow modules display a graph of the module

COMPONENTS

D e e ]

MALFURCTIONS
L1 L] i .! b " Bam
i

UPTIME LOG.

Buagn 47 Aleuatn 11 Ercimn 3T Clps, 1 Mt 41 Hiwten. & Setimn
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divided into individual pixels. Malfunctioning pixels
are highlighted. Hover the cursor over malfunctioning
pixels to display the details of the malfunction.

+ Below the diagnostics report graph are text tables which
display similar information (see Figure 2). View the details
of these reports by clicking the + next to the error type.

« Below the diagnostics table is the uptime log. Whenever
the controller turns on or off, the log creates an entry.
If the controller ever loses power, or is restarted for any
reason, it will register in the log.

Figure 2 « Text table diagnostic display.
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Time & Temperature Signs

GPS Antenna

The GPS antenna receives time signals from one or more GPS satel-
lites. It amplifies those signals, then relays them through the cable to
the GPS receiver inside the control unit chassis. For best operation,
please follow the guidelines and installation instructions listed below.

Guidelines

For maximum sensitivity to the satellite signals, mount the antenna
in full view of the sky. The antenna works best when there is a
direct line of sight from the antenna to the satellite.

Mount the antenna so the flat portion is level with the horizon.

If the antenna is mounted on top of the sign cabinet, use silicone
to seal the area around the mounting hole. It is very important to
prevent water from entering the sign cabinet.

The GPS antenna cable is 16' long. Select an antenna location
within reach of the cable.

Installation

1.

An L-shaped steel mounting bracket is supplied with the GPS
antenna. The GPS antenna is magnetic. Mount the antenna on a
flat metallic surface outside the sign cabinet (see Figure 1).

Route the antenna cable through the small hole on the mounting
bracket. The bracket may be fastened to either side of the sign
with the screws provided with the bracket. Two threaded holes
are located on either side near the top of the sign. These holes are
used to hold the lifting eye hooks; the lifting eye hooks may be
removed after the sign is mounted.

If it is not practical to use the threaded holes, mount the bracket
securely on a flat surface. If using the bracket is not practical, the
antenna may be mounted directly on a flat surface. The bottom of
the antenna has an adhesive strip. Peel off the protective backing
before permanently mounting the antenna.

Route the antenna cable inside the sign to the M203 controller.
Use a cable grip to seal the opening in the sign cabinet. If a hole
must be drilled in the sign to get the cable inside, use the cable
grip to hold the cable in place and to help seal the hole. The cable
grip requires a ’/3" diameter hole. Route the GPS antenna cable
through the cable grip and then tighten it securely to the sign
cabinet. Be sure to use outdoor silicone sealant to seal the hole.

Connect the cable to the small connector on the bottom of the
M203 GPS receiver (see Figure 2).

The connector snaps into place.

Want to know more?

For drilling precautions, see page 17.
For electrical wiring instructions, see page 13.

Figure 1 « Antenna attached to bracket.

{

Figure 2 « M203 controller.

For conduit instructions, see page 17.
For ventilation requirements, see page 3.
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Sign Maintenance

Watchfire signs have been designed and manufactured to provide years of trouble-free operation. This section
describes some preventive maintenance steps that may be needed from time to time.

Ventilation and Fans

Ensuring proper ventilation is the single most important factor in increasing the life of a LED mes-
sage center. It is good practice to check the fans and ventilation any time the sign is being serviced.

CAUTION!

In order to help extend the life of the sign, it is important to keep the internal cabinet temperature as cool as pos-
sible. Watchfire signs have temperature sensors in the sign controllers that monitor internal cabinet temperature.
If the internal temperature reaches 67°C (152°F) the display is turned off, which stops the heat generation by the
electronics. This over-temperature condition may occur if the sign installation has compromised the ventilation or
if an excessive number of fans have failed. Ventilation can also be compromised by rodents, insects and birds.

Checking for Leaks

It is very important to keep water from entering the sign cabinet. Check the cabinet for signs of leakage, pay-
ing special attention to any holes, like those for mounting poles, where water may leak in. Reapply a silicone
sealant periodically as needed.

Surge Protection Faulty

Good Q Q i
Check all internal surge suppressors when a sign is being serviced. Surge sup- | £
pressors are installed on all power DIN rails throughout a sign. A faulty surge . ..
suppressor will have a red or orange indicator. A good surge suppressor will = é‘

SPE 1T 136V TRA

have a clear window as seen in the picture to the right. If a faulty surge suppres-

::Wus@'.
sor is found, obtain a replacement by contacting Watchfire Technical Support.

Cleaning Louvers and LED Modules

Special care must be taken when cleaning your sign. please see kb for proper technique.
More information at www.watchfiresigns.com/kb article 167.

Powering Down

DO NOT turn the sign off or put it on a timer.

The sign is designed to have power supplied to it at all times, except during maintenance or service. Do not
shut the sign down overnight, on weekends, or during other times of disuse. The sign uses very little electricity
when not playing data, and allowing it to continue to run — although blank — keeps the fans running and
avoids moisture build-up, protecting the electronics inside the sign.

To make the sign go blank, update the sign with an empty schedule.

To schedule the sign to go blank on a regular basis, use the On Times feature in Ignite. On the schedule page,
select the schedule dropdown and click On Times. For more information regarding the cleaning and mainte-
nance of the sign, contact Watchfire at 866-637-2645.
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FAQs & Additional Troubleshooting

The following are several steps that are useful when troubleshooting your Watch-
fire sign. Check out our KnowledgeBase at http://watchfiresigns.com/kb to find
more FAQs, How-to's, and contact information. Dealers can request access to spe-
cially tailored dealer content by clicking “Request Dealer Access.”

IGNITE ERROR CODE 12029
12029 is an error code meaning the computer did not communicate with the controller.

A. Check the settings of the USB to Ethernet NIC adapter. If the setting is "obtain IP address automatically,"
it will cause this error. See page 33 for instructions.

B. Check the communication at the computer. Open a web browser (i.e. Internet Explorer, Google
Chrome, or Firefox.) In the URL bar enter the IP of the communications. Typically this is 192.168.20.1.

C A [ http//192.168.20.1]

This should bring up a login page. If it does not, power cycle the communications and make sure every-
thing is connected properly (e.g. RWF POE adapter, High Speed Fiber Router, and media converter.) If you
are still unable to get a login page in the web browser, contact Watchfire Technical Support for assistance.

C. Make sure the sign is powered on. Try power cycling the sign and attempt communication in Ignite
again. If you are still getting 12029 please contact Watchfire Technical Support for further troubleshooting.

I. DISPLAY ISSUES - Nothing playing on the sign, cannot communicate:

The controller stores data without constant communication from the PC. If nothing is playing and the sign
cannot communicate, the controller is not operating properly.

A. Much like a desktop PC, the controller’s reboot takes 1-2 minutes. Allow plenty of time before assuming
there is a problem after a power outage or after performing any updates that require a reboot. Wait at
least 2 minutes for the controller to reboot, and then try again.

w

Confirm there is power to the sign. The fans should be running and the display should be lit on
the controller. The sign should briefly light when power cycled.

Remove enough modules to be able to see the small display on/in the controller.
Confirm that the switches on the controller and flares, if any, are set to Operate.
Turn the power off, wait at least 1 minute, and turn the power back on.

Watch the display on the controller. i.e. BC550, BC760, BC816 etc. The display should be counting down
or displaying a series of codes.

mmo N

1. If the countdown freezes for more than 2 minutes, or if the display is frozen on .8; the controller did
not complete the boot-up procedure. Turn off the power, wait 1 minute, then reapply power. Allow
at least 2 minutes for the system to complete the reboot. If it still freezes, contact Watchfire Techni-
cal Support.

2. Once the countdown has completed, the controller should display H for ethernet (RWF, HRS, high
speed fiber, broadband wireless). If the messages begin playing, go on to Section lIl.

3. If the controller is displaying the right code but the sign is still blank, try to communicate and send
it a schedule. If the sign cannot communicate, contact Watchfire Technical Support.

Il. DISPLAY ISSUES - Software communicated successfully, but:
A. Signis still blank.
1. Search watchfiresigns.com/kb for “blank sign troubleshooting” for more information.
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FAQs & Additional Troubleshooting (continued)

2.

5.
6.

For the software to communicate successfully, the controller must have power, the controller toggle
switch and flare switches must be set to Operate, and the controller should be sending data to the
sign.

a. Inlgnite, double-check the schedule to confirm it actually should be playing a message.
On the schedule page in Ignite, make sure the virtual sign at the bottom of the page is
displaying a message.

b. Re-send the schedule.

Try deleting the entire schedule, and then create a fresh new message e.g. just the time and sched-
ule it to play all day-every day. Send the schedule to the sign by using the Update Sign button.

Click Tools > Configuration > Get Sign Controller Status. Verify that the date and time are correct,
and check Schedule Entry to confirm that a message is scheduled to play.

Confirm the data cables are all plugged into the controller properly.
Call Watchfire Technical Support for additional assistance.

B. Only the primary face is playing the message.

1.

3.
4.

Confirm the secondary face has power. Check the wiring and ensure the fans are running and
the breakers are switched on. Cycle power to the secondary face and watch the modules.

a. If the modules don’t show anything when the power is cycled, then the modules are not get-
ting any power at all.

i. Check that power is coming to the secondary face from the primary face or from the
main service.

ii. Confirm the breaker is on inside the secondary face.
iii. Contact support if there still is no power to the modules.
b. If the modules play codes but then go blank, the face has power but isn’t receiving data.

Confirm the data crossover cables are plugged into the controller according to the instructions, and
not accidentally plugged into the wrong port.

Confirm the data crossovers are plugged in at the secondary face correctly.
Contact Watchfire Technical Support for further assistance.

C. Entire face displays scrambled data.

1.

3.

Re-address the sign. See Addressing LED Modules (page 6) for details. Be sure to return the
switch to Operate and allow the sign time to reboot.

The problem may be a damaged fiber. Contact support and ask to borrow the fiber-optic test kit to
check for data loss in the cable.

If the cable is fine and the problem persists, call Watchfire Technical Support.

D. Sign keeps lighting whole modules one at a time or shows a number and counts up, but will not play
any messages.

1.

2.
3.
4.

The sign is probably in test mode, addressing. Move the controller’s switch, along with every flare
into the Operate position.

Confirm it is now displaying the desired data.
Make sure the sign isn't being readdressed from the software
If the problem still exists, call Watchfire Technical Support.

E. One or more lines, one or more columns, or most of a line, not displaying data or scrambled data.
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FAQs & Additional Troubleshooting (continued)

Confirm that each module’s data and power cables are properly attached.

2. Inlgnite, confirm that the message being sent is the proper size. (The sign'’s size is listed on the
Sign Configuration Page on the inside front cover of this manual.)

3. Inlgnite, click Tools > Configuration > Sign Controller Status, and make sure the configuration
is correct for this sign.

Re-address the sign as covered in Addressing LED Modules (page 6).
Check data cables are plugged into the proper ports on the controller and/or flares.

If any of the ports on the controller or eFlare were accidentally unplugged, the cable may have
been plugged into the incorrect output. Contact Watchfire Technical Support to confirm which
plug needs to be moved.

7. If the last line of the sign is not working and the data seems to be “pushed up” the sign one row,
the data crossover cables are off by one. Unplug the first data cable and move it over one, and so
on.

8. Ifthe bottom line or lines are not working, the sign’s configuration may be wrong. Check in Sign
Controller Status for the proper sign size.

9. Sometimes one module will have problems with its data input or output port, affecting the rest of
that line.

a. Totest the data input, switch the first module that is not working with the far right module in
that row. If the rest of the row now plays except that last module, contact Watchfire Technical
Support about exchanging the module.

b. If the problem remains in the same location and still includes only a portion of the row,
switch the last module that is working with the far right module in a different row.

i. If this solves the problem, attach a note to the back of the moved module indicating
“To be used in the far right column only.” Then readdress and close up the sign.
[See Addressing LED Modules (page 6).] The module will operate in this position.

ii. If the problem moves with the module, contact Watchfire Technical Support to exchange.
F.  One or more individual module(s) not displaying or scrambling data.
1. Confirm that all cables are properly attached to the module and the modules on each side of it.
2. Readdress the sign. [See Addressing LED Modules (page 6).]

3. If the module is completely blank, disconnect and reconnect the power cable from the back of it.
Watch to see whether the module’s LEDs light when you reapply power.

a. Ifitlights any LED’s during boot up, the module itself has power but may not be receiving valid
data. Repeat the tests in Section Il, Part E, above.

b. Ifitdoes not light any LED’s during power up, then the module, the power supply or the power
cabling is bad.

i. Exchange this module with the nearest module.
ii. Ifthe problem goes with the module, contact Watchfire Technical Support about exchanging it.

iii. If the problem remains, contact Watchfire Technical Support about the power supply or
cable.
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FAQs & Additional Troubleshooting (continued)

lll. DISPLAY ISSUES - The original (shipping) message is playing, but the software cannot communicate
with the sign:

A. Confirm the communication method is properly installed and operational per its individual instructions.
1. RWEF: See page 21
2. High Speed Fiber: See page 23
3. Broadband Wireless: See page 24

B. If an Invalid Password or Access Denied error is received and the sign has no password, be sure the
password field is empty when attempting to communicate. Contact Watchfire Technical Support for a
password reset.

IV. Temperature Issues:
A. No temperature displayed:
1. Confirm the sign controller is receiving temperature data from the sensor:
a. Click Tools > Configuration > Get Sign Controller Status.
b. Check for an actual temperature listed under Temp.

c. If atemperature is displayed, then data is being received; if not, see below at Section IV, part A,
item 2. Go to Scheduling and confirm the message is set to play the temperature.

i. View the preview at the bottom of the screen, and confirm it shows 68° (the placeholder
for temperature).

ii. Check the scheduling to ensure the message is actually scheduled to play at this time
of day. If the problem persists, contact Watchfire Technical Support.

2. If the temperature sensor is not being recognized, then the field will contain only a question mark
(7). Make sure the temperature sensor cable is plugged into the controller. Unplug and re-plug
the temperature sensor. Allow 2 minutes, and then get sign controller status again..

3. Check that the connector joining the sensor to the cable is properly protected. Check for water or
corrosion and that the twist catch is secure. This connector must be indoors or inside a conduit.

4. If the problem persists, contact Watchfire Technical Support.
B. Temp always displays 68°:

1. If Ignite always displays 68°, but the sign displays the proper temperature, there is no problem.
Ignite doesn’t know what the real outdoor temperature is, and so 68° is utilized as a placeholder
to show where the temperature will be displayed. To confirm the actual outdoor temperature,
follow Section IV, part A, item 1, above, to connect to the sign controller and read the actual
temperature.

C. Temp always displays —50: Contact Watchfire Technical Support.

D. Temperature is consistently wrong by the same amount: Before adjusting the temp, use a quality
thermometer to check the temperature several different times of day to confirm the problem is
consistent. If the sign is always off a few degrees, adjust the temp offset from the configuration
summary page within Ignite. See Section IV, part A, item 1 above.

E. Temperature is wrong by varying amounts: If the inaccuracy varies throughout the day, it is most likely
a problem with the location of the temperature sensor installation. This could cause false readings,
such as picking up heat off the street or from a nearby air conditioning vent.
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FAQs & Additional Troubleshooting (continued)

1. Try adjusting the installation to move the sensor away from blacktop, roofs or other heat sources.
2. If the installation location does not fix the issue, contact Watchfire Technical Support.

F. If the temperature sensor cable is cut or the temperature sensor has physical damage or water damage,
contact Watchfire Technical Support regarding replacing the cable. These cables cannot be spliced.

V. Time Issues:

A. Daylight savings time issues: Watchfire signs default to having the time change automatically with
daylight savings time. Signs shipping to areas known not to follow daylight savings ship with this
option off. If for any reason the daylight savings option needs to be turned either on or off, contact
Watchfire Technical Support for assistance in correcting the daylight saving setting.

B. Time is off by a set amount: The controller has an internal clock and does not retrieve time data from
the host PC. In the unlikely event the controller loses or gains time:

1. Click Tools > Configuration > Get Sign Controller Status.
2. (lick Change Date & Time. Adjust time as needed.
3. The sign will have to reboot for the time correction to take effect.

C. Time zone change: If the sign is relocated to a new time zone, the Ignite software will need to tell the
sign controller the new location. Contact Watchfire Technical Support to assist in changing the time
zone settings within Ignite. To protect the sign from accidental changes, a service password is required
to access this data.

VI. Time & Temp Issues, Time/Temp L203 Signs:
A. Setting the time manually: If the GPS has been turned off for any reason, the time can be set manually:
1. With the power On, move the operate/ time set/ test switch to Time.
2. When the desired time displays, move the switch back to operate.

B. Setting the temp offset: The temperature offset allows the user to adjust the temp displayed on the
sign up or down the same number of degrees at all times. If temp is wrong by varying amounts,
see IV. Temperature Issues, part E.

1. With the power Off, move the switch to Time.
2. Turn the power On.

3. The sign will continually display the temperature. It will slowly cycle from its lowest possible
adjustment to the maximum.

4. When at the desired temperature, put the switch to operate.
C. M203 display: This display shows some key data, as follows:
1. One dash, then programming settings.

2. Two dashes, then number of GPS receivers recognized (0-9, E for Error if no antenna found,
or F for Fault if antenna is not sending data).

3. Three dashes, then temperature offset (-5 to 5), then current dimming (0 = night, 1 = twilight,
2 =day).
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Warranty

WATCHFIRE SIGNS, LLC - TERMS OF SALE

NOTE: The following Terms of Sale are subject to change. All transactions for all products sold by Watchfire are subject to the latest published Terms
and Conditions and to any special Terms of Sale which may be contained in applicable Watchfire quotations and acknowledgements.

QUOTATIONS: Quotations shall be valid for no more than ninety (90) days from their date, unless otherwise stated in the quotation. All quotations are
subject to change by Watchfire at any time upon notice to Buyer. It is Buyer’s obligation to review the quotation carefully and to immediately advise
Watchfire of any discrepancies Buyer has so any necessary changes may be made. Changes to the System after acceptance of the quote are valid only
when accepted in writing and signed by both Watchfire and the Buyer.

Terms of Payment - Upon Buyer’s acceptance of a System quote, the Buyer shall make a non-refundable minimum deposit of one-half of the System
Price. When applicable, taxes, crating, transportation, delivery charges, and any other related expenses shall be included in the System quote. The
remaining balance must be paid by the Buyer three (3) days prior to Watchfire's shipment of the System. The System Price does not include costs of
any construction or installation of the System and is solely the responsibility of the Buyer. Systems delayed in shipment at the request of Buyer are
subject to annual interest charges of 18% on the remaining balance, which must be paid by Buyer prior to shipment.

Shipment - Watchfire will retain title and all risk of loss or damage in transit until the System is received by the Buyer at the shipping designation.
Any damage during the unloading of the System is at the Buyer’s sole risk and shall not be considered shipping damage. Buyer shall have the
responsibility of inspecting the equipment for apparent shipping loss or damage immediately upon its arrival. In the event of shipping loss or
damage, Buyer shall note each exception on Buyer's delivery receipt provided by the carrier at the time of delivery at the shipping destination and
shall provide a copy to Watchfire within 14 calendar days of delivery. All loss or damage claims must be accompanied by clear photographs depicting
the loss or damage while in the presence of the carrier driver. In the event of concealed damage which occurred during transit and is discovered by
Buyer after delivery, Buyer shall report such damage immediately, but in no event later than 21 calendar days after delivery. If such notification is

not made, Watchfire shall not be liable for loss or damage in transit. Buyer shall give Watchfire, and its agents, a reasonable opportunity to inspect,
test and repair or replace the System or portions thereof. Buyer’s exclusive remedy against Watchfire for physical damages during shipping, and
Watchfire's only liability for shipping damages, shall be replacement or repair of such System or parts damaged as determined by Watchfire. Watchfire
shall be entitled to immediate exclusive possession and control of such portions of the System repaired or replaced. Buyer must return such goods to
Watchfire and accept delivery of the replacement goods.

Driver Detention - Fees for up to two (2) hours of detention time, per load, are included in the System Price. In the unlikely event that the driver is
delayed or detained beyond two (2) hours following arrival at the shipping destination, detention fees will be accrued by the hour. If these delays are
a direct result of issues with preparedness of the installation team and/or jobsite readiness, these fees will be invoiced to the Buyer in a timely manner
and will not exceed $75.00/hour.

Force Majeure - Watchfire shall not be liable for any damages as a result of any delays due to any causes beyond Watchfire’s control, including,
without limitation, telecommunications failures, technology attacks, epidemic, embargos, quarantines, viruses, strikes, labor problems of any type,
accidents, fires, war, acts of terrorism, material unavailability, natural disaster, transportation failures, instability and unavailability of the Internet, and
acts of God, etc. In the event of such any such delay, the date of delivery shall be extended for a period of time reasonably necessary to over the effect
of such delay.

System Warranty - When used properly under normal use and normal environmental conditions, and subject to the exclusions set forth herein,
Watchfire warrants its manufactured goods, and the System against material defects in material and workmanship for five (5) years from the date

of shipment from Watchfire's dock. Watchfire warrants the Price Watcher product series against material defects in workmanship for two (2) years
from the date of shipment from Watchfire’s docks. During the warranty period, Watchfire's only obligation and liability is to repair or replace (at its
option) those part(s) of the System which prove to be defective and not merely worn out (e.g., aged LEDs). Repaired or replaced parts provided within
the original warranty period shall have the same warranty for the balance of the original warranty period. Part(s) replaced or repaired outside of

any warranty period shall have a warranty of replacement only for material defects in material or workmanship for one year from date of shipment.
Any parts not manufactured by Watchfire, but which are added to the System manufactured by Watchfire, are covered only by their original
manufacturer’s warranty, if any. Watchfire is not responsible for telecommunications or Internet services being unavailable, or for limitations caused
by environmental conditions or incompatibilities with other systems.

Limitations - Buyer's exclusive remedy for Watchfire's breach of this Agreement as to any term hereof, and Watchfire's only liability for any such
breach, shall be replacement or repair of the System and its parts actually delivered to Buyer in Watchfire's sole discretion. IN NO EVENT WILL
WATCHFIRE BE LIABLE TO BUYER FOR LOSS, DAMAGE, OR INJURY OF ANY KIND OR NATURE ARISING OUT OF THIS TRANSACTION IN EXCESS
OF THE SYSTEM PRICE. The Buyer agrees that these limitations on liability and remedies are independent of the agreed remedies under this
Agreement. Significant surge protection is included in the signs. However, very high electrical surges can damage electronic LED sign systems and
are not covered by warranty. Proper installation to allow for adequate ventilation as detailed in the Installation Manual S-1504 is required to
keep the warranty in force. Power must be applied at all times except for during service incidents. Power outages for more than three (3)
days require notice to Watchfire Service to keep the warranty in force.
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Warranty (continued)

Intellectual Property - As to the equipment proposed and furnished by Watchfire, Watchfire shall defend any suit or proceeding brought
against Buyer so far as it is based on a claim that such equipment constitutes an infringement of any copyright, trademark or patent of the

United States. Watchfire retains ownership of intellectual property in any materials, goods, software and production process which may be
developed under this Agreement.

Use of System Image - Buyer agrees that Watchfire, without compensation to Buyer, may use Buyer's name along with photographs and images
of the System in Watchfire's advertising and promotional materials in any media worldwide without the prior written consent of Buyer.
Watchfire agrees that such use shall not imply any endorsement of Watchfire by Buyer.

License for Software Use and Warranty - "Software" as used herein includes software distributed on a media (like a CD, DVD or flash drive),
software hosted on a server and accessed through a web browser, and software running on the System controllers. Media does not apply to
Ignite OA. This license covers end-user applications such as Ignite OP, Ignite OPx and Ignite OA. The Ignite OP software is a single station
license. Additional station access is available at additional cost. Excluding Third Party software, Watchfire warrants that: (1) the media (if
any) on which Software is provided shall be free from material defects for sixty (60) days after shipment by Watchfire; and (2) Software
substantially conforms to the documentation that accompanies it. Watchfire hereby grants the Original End User a limited, non-exclusive
personal, non-transferable and non-assignable license to use the Software. This license terminates upon violation of any provision of this
License, and Watchfire reserves the right to electronically disable the Software upon such violation. The software is copyrighted by Time-
O-Matic and buyer shall not permit the software to be copied (except for backup purposes), transferred, distributed, disassembled,

reverse engineered, decompiled or tampered with. Watchfire does not warrant that the media and Software is completely error-free,

will operate without interruption or is compatible with all equipment or software configurations. Watchfire may charge additional fees

for any upgrades or modifications to the Software.

Third Party Software - Operation of the sign is supported only with Watchfire software and Watchfire qualified versions of approved third party
software. Installing un-supported software on sign controllers could lead to non-operational signs. Service charges for troubleshooting and
returning to operation will apply.

BUYER AND ORIGINAL END USER HOLD WATCHFIRE HARMLESS AND INDEMNIFIED FOR ANY CLAIMS BY THIRD PARTIES. INCLUDING
WATCHFIRE'S ATTORNEY'S FEES. THAT THE USE OF THE SOFTWARE OR SYSTEM INFRINGES ANY INTELLECTUAL PROPERTY RIGHTS OF ANY
THIRD PARTY DUE TO AN IMAGE DISPLAYED ON THE SYSTEM BY THE BUYER.

Warranty Service - Defective media or Software may be replaced during the warranty period unless damaged by accident or misuse.
WATCHFIRE'S ENTIRE LIABILITY SHALL BE THE REPAIR OR REPLACEMENT OF THE DEFECTIVE MEDIA OR SOFTWARE WHEN TIMELY
RETURNED TO WATCHFIRE. Any replacement media or Software has the same sixty (60) day warranty. Warranty service for the System

and the Software are expressly conditioned on Watchfire's prior receipt of all payments due under the License, including System

Price. Buyer shall contact the Watchfire Technical Support for warranty service. ltems determined defective by Watchfire will be replaced at
its option with new or like-new part(s). No credit is given for such items. Watchfire will pay for outbound shipping and return ground
freight for items repaired/replaced for its manufactured goods. Buyers must pay all duties and taxes for items shipped to

destinations outside of the continental United States. Buyer shall pay for the installation of repaired/replaced item and updates to

the software. In the event of any delay in Watchfire's performance beyond Watchfire's reasonable control, Watchfire shall have

additional reasonable time for performance. Buyer shall pay for all maintenance services.

Exclusions - The above warranties do not apply if the System or Software are damaged due to improper or unreasonable use, modification,
repair, service, installation, or environmental conditions or if they are reversed engineered, de-compiled or used to create derivative works.

WATCHFIRE'S LIABILITY TO BUYER UNDER THESE WARRANTIES FOR THE SYSTEM AND SOFTWARE IS LIMITED AS SET FORTH HEREIN,
WHETHER IN CONTRACT, TORT, OR ANY OTHER THEORY OF LIABILITY, INCLUDING BUT NOT LIMITED TO FRAUD, MISREPRESENTATION,
BREACH OF CONTRACT, PERSONAL INJURY, PRODUCTS LIABILITY OR ANY OTHER THEORY, AND WATCHFIRE SHALL NOT BE LIABLE FOR
ANY SPECIAL, DIRECT, COMMERCIAL, EXEMPLARY, DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR PUNITIVE
DAMAGES, OR DAMAGES FOR LOSS OF USE, LOSS OF ANTICIPATED PROFITS, INCOME, OR ECONOMIC LOSSES OF ANY KIND.
WATCHFIRE'S LIABILITY UNDER ANY WARRANTY HEREUNDER, WHETHER EXPRESS OR IMPLIED, SHALL NOT EXCEED THE COST OF REPAIR
OR REPLACEMENT OF DEFECTIVE PARTS OF THE SYSTEM AND SOFTWARE. BUYER MAY NOT BRING ANY ACTION UNDER THESE
WARRANTIES MORE THAN ONE YEAR AFTER THE CAUSE OF ACTION HAS ACCRUED.

Miscellaneous - Should any part of this Terms of Sale be found invalid, the other parts shall remain unaffected and shall be enforceable.
This Terms of Sale shall be governed by the laws of the State of Illinois. Any litigation shall be exclusively in Vermilion County, in the State

of lllinois or the U.S. District Court for the Central District of lllinois.

Privacy Policy - See http://www.watchfiresigns.com/privacy-policy for details.
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Notes
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LED Display — Comparison of Watchfire vs Daktronics Signs

LED Manufacturer Qualifications: Watchfire LED vs Daktronics

Note: All Comparisons are underlined and are presented in BOLD font.

Differences in Watchfire LED vs Daktronics are noted where applicable with asterisk™®

1) LED Display Manufacturer shall:

a) Have been in the business of manufacturing permanently mounted outdoor LED displays for a
minimum period of 10 years prior to the contract bid date. An “LED” display shall be defined as a
display that contains pixels constructed solely of high-intensity discrete LEDs.

*Watchfire has been a US based sign manufacturer in Danville, IL since 1932 (87 years total).

* Daktronics was founded in Brookings, SD in 1968 (51 Years total)

b) Have in operation a minimum of 20 large outdoor permanently mounted LED displays as
defined above. Each of these LED displays shall have operated successfully for a minimum
period of one (1) year prior to the contract bid date.

*Watchfire has been manufacturing "LED" displays since 1998 and we have over 65,000 displays

installed across the world.

*A Listing of Over 20 Successful Watchfire Installations in the South Florida area alone has been

provided with each display’s number of years duration in the field noted.

c) Have been in business under the same corporate name for a period of no less than 10 years
prior to the contract start date.

Time-o-matic trademarked the name Watchfire in 2004.

d) Provide a toll-free help desk number that will be staffed to mirror the City’s operational
hours, Monday to Thursday from 7am to 6pm EST, and a 24-hour emergency contact number.

Toll Free help desk number (staffed Monday to Friday 7am to 6pm): 800-637-2645

24-Hour Emergency Local Hotline Contact Number: 941-357-0791

*In addition: OPX2 Software will monitor each sign’s diagnostics 24 hours a day with automatic email

notifications of any technical support issues sent immediately to local service provider who will have
replacement parts inventory on-hand to provide maximum 48-hour service and support guarantee.

*Daktronics does not provide this level of automatic real time remote monitoring, and on-site service

response to their displays.

2) Experience with manufacturing the following types of electronic sign products shall not satisfy the
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requirements of this LED display specification:
a) Indoor displays of any size or type.
b) Back-lit displays.
c) Any type of matrix displays that cannot be programmed to show a nearly infinite quantity of
messages.
E) Warranty
1) The bidder shall provide an all-inclusive five (5) year non-prorated warranty on all parts and labor
provided by the bidder, whether bidder manufactured or subcontracted. Bidder must itemize and
identify any additional material, labor or parts which would incur any separate costs and list these costs
to the city. If there is an option for the city to purchase an extension of the warranty, please identify the
length of additional warranty available to the city and terms and conditions and costs associated with
such an extra, (up to an additional five (5) years).

Watchfire LED 5-Year Parts Warranty, and 10-Year Parts Warranty Options are Provided.

2) Provide a toll-free service coordination/help desk number that will be staffed to mirror the City’s
operational hours, Monday to Thursday from 7am to 6pm EST, and a 24-hour emergency contact
number.

Toll Free help desk number (staffed Monday to Friday 7am to 6pm): 800-637-2645

24-Hour Emergency Local Contact Number: 941-357-0791

3) Provide a 48-hour guarantee to get the signage back up and running after a failure of any type.

OPX2 Cloud Based Software will monitor each sign’s diagnostics 24 hours a day. Automatic email
notifications of any technical support issues are sent immediately to local service contractor who will
have a full replacement parts inventory on-hand to provide 48-hour guarantee to have the signage up
and running should any failure occur.

1.3.2 PRODUCTS
A) Cabinet

1) Display housing dimensions shall not exceed 40.5” tall x 111.75” wide. The front to-back housing
depth shall not exceed 17.375”. The final dimensions will be based on the size of the digital display that

will be installed in the housing.
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The displays are 41"h x 111"w x 5" deep. This dimension includes airways for front ventilation
specifically designed for monument sign applications.

2) Display shall operate from the following power sources: 120/240 VAC, 60 Hz single-phase,
including neutral and earth ground.

The signs are 120/240V, 60Hz, single phase, including neutral, earth ground. They UL Energy Efficiency
Verified (Green Leaf Certification).

These signs also contain built in surge protection on the incoming power.

3) Display shall operate in a minimum ambient temperature range of 22°F to 176°F (- 30°C to +80°C)
and to a 100% humidity.

Displays will operate between -40F and +140F. There is an over temperature feature built into the sign
to shut down at 149F to prevent damage to the LED diodes Tested per ASTM B-117 to a continuous 95
°F (35 °C), 7.2 pH SALT FOG.

4) Internal display component hardware (nuts, bolts, screws, standoffs, rivets, fasteners, etc.) shall
be fabricated from stainless steel, aluminum, nylon, or other durable corrosion-resistant materials
suitable for the signage application.

Watchfire and Daktronics are identical in these specifications.

5) Electrical display components shall be 100% solid-state.

Watchfire Electrical Components are 100% solid state.

6) The presence of ambient radio signals and magnetic or electromagnetic interference, including
those from power lines, transformers, and motors, shall not impair performance of the display system.

Radio signals and electromagnetic leakage shall not affect Watchfire LED display performance.

Complies with FCC Part 15 regulations for Class A devices

*Watchfire was the first company to lead the industry with this qualification.

*Daktronics followed afterward.

7) The display shall contain a full LED matrix measuring a minimum of 108 (H) pixel rows high by
288(W)-pixel columns wide, depending on the configuration and size of the digital display the City
chooses. The LED display shall display messages that are continuous, uniform, and unbroken in
appearance.

*The 10mm display face shall be 90-pixel high x 270 pixel wide

*The 16mm display face shall be 54-pixel high x 162 pixel wide.

* Daktronics displays specified are slightly different due to the lack of evenly distributed pixel

matrices, according to standard measurements (feet and inches).
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B) Housing Frame
1) Display materials shall use marine grade aluminum and have a protective coating on the inside and
the outside of the structure, so they shall be anti-corrosive and not degrade or oxidize.

Extruded Marine Grade Aluminum cabinets with mitered corners and solid weld corners with
protective weatherproof baked enamel coating.

2) Adequate ventilation shall be provided through convection without the need to provide extra
space around the sides or behind the display.

Watchfire LED displays are front ventilated. No spacing at top, bottom or sides of the display is
necessary for proper ventilation to occur. Displays are also front serviceable to expedite any quick and
seamless maintenance required.

3) Steel mounting points that can be used for mounting purposes shall be provided with the display
and have the ability to be adjusted for alternative mounting methods. Separation of ferrous and non-
ferrous metals must be provided within the structure.

Watchfire LED includes both mounting points and alternative mounting methods (see engineer
drawings and shop drawings). Ferrous and non-ferrous metals are provided within the structure.

4) Shall include lifting supports that can be removed after installation.
Included.

5) Sign shall be engineered to meet or exceed all applicable building codes, including all hurricane
wind codes for each sign location.

Watchfire LED displays are certified UL 48, ULC 48; Comply with FCC Part 15 regulations for Class A
devices. Sealed engineer drawings (sealed specific to each installation site address) for the entire sign
with LED displays integrated are provided with this bid. Sealed by FL Licensed Engineer.

C) Exterior Finish
1) The exterior sign cabinet of the monument sign that holds the LED digital display shall be of the
design supplied by the city. (See Attachment P, Digital Display Specification Drawing.)

Please refer to sealed engineer drawings provided.

2) The LED display frame and border pieces shall be coated with an automotive-grade acrylic poly-
urethane paint.

Watchfire LED Display cabinets are coated with automotive-grade acrylic poly-urethane paint in
multiple coats that are baked on then tested for durability at in-factory testing laboratories prior to

shipment.
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D) Front Face Construction
1) To meet the display readability requirements, the front face must be constructed in such a manner
that it provides high contrast, low sunlight reflection and durability in all weather and site conditions.

Watchfire LED displays provide high contrast and low sunlight reflection through patented louvre
technology surrounding each individual pixel/diode. The louvres also serve as a protection against
damage or vandalism. Durability for the most extreme weather conditions are tested for each
individual sign at industry leading in-factory testing laboratories.

2) Minimum features of front face shall:

a) Provide UV resistance to prevent discoloring. RFP # PL-18-06 SECTION 1 —INSTRUCTIONS Page
10 City of Pembroke Pines

Included.
b) Include louvers for contrast enhancement.

Included, see above in D section 1.

c) Use surface materials in the active LED area, such as metal, plastic, or other face materials,
designed for low sunlight reflectivity.

Matte finish polymers are used to dissipate any sunlight reflectivity and allow for greater
contrast.

d) Sign shall be engineered to meet or exceed all applicable building codes, including all
hurricane wind codes for each sign location.

Sealed Engineer Drawings are Provided. (Sealed specifically for each address included in the
bid by a Licensed FL Engineer)

1.3.3 DISPLAY COMPONENTS

A) LED display modules shall be constructed for good readability, long life, and ease of service. Each
display module shall be constructed as follows:

1) Each module within the product family shall be designed with the same physical footprint of 12.5”
x 15.75” or similar sized modules, depending on the size and configuration of the chosen digital display.

Watchfire LED Displays are built to standard measurement size. Each module is exactly 12"’ X 12"’ per
module’s physical footprint.

2) All modules and their components shall be fully encapsulated and sealed to meet IP-67 standards.
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Watchfire LED Displays Modules are encapsulated in a bed of Silicone Gel to meet IP 67 Standards.
(other manufacturers will provide conformal coating which is less effective at avoiding water

infiltration).

3) An LED module shall consist of LEDs with all drive electronics mounted on a single Printed Circuit
Board (PCB).

Watchfire LED modules are smart modules and each has its own IC chip. This allows for real-time
remote monitoring and diagnostic capability, color calibration, and basic control at the module level.

The modules are UL 48, ULC 48 (wet listed); Complies with FCC Part 15 regulations for Class A devices

4) LEDs shall be auto-inserted in order to maintain quality and uniformity of the LEDs within each LED
module.

All Watchfire LEDs are Auto-inserted at factory in Danville, IL.

Pick and Place equipment is used for LED insertion

5) All PCBs shall be wave-soldered to ensure uniformity, quality and durability.

All Watchfire LEDs are wave-soldered at factory in Danville, IL.

6) All PCBs shall be cleaned in a manner so as not to contain more than 2 parts per million
contaminants.

All Watchfire LEDs are cleaned and tested at in factory laboratory in Danville, IL to certify less than 2
PPM contaminants.

7) Module signal and electrical connections shall be of the positive locking and removable type.
Removal of a module from the display shall not require a de-soldering operation.

Weather proof automotive grade pin connecters used for connecting power and data to each module.

8) Data to the modules shall be redundant in that the signal can reach the module from multiple
directions in the event of a loss in signal path from either direction.

Included.

9) All LED display modules in a single display shall be identical in construction and interchangeable
throughout the display with the ability to be field calibrated.

Equivalent.

10) All module rows shall include continuous louvers over the LEDs for sunlight shading and enhanced
contrast.

Equivalent.

11) Modules shall be individually attached to the cabinet frame.

Equivalent.

12) Removal of one or more modules shall not affect the display’s structural integrity.
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Equivalent.

13) The distance from the center of one line or column of pixels to the center of all adjacent lines or
columns shall be approximately 10mm, or 15.85mm both horizontally and vertically. Cost proposal as
outlined in Attachment A should include pricing for a 10mm and a 15.85mm option.

*True pixel pitch 10mm and 16mm discrete resolution are being quoted. The actual CENTER TO
CENTER distance on the 10mm is 10.13 and the 16mm is 16.9mm.

*Notice: Other companies may quote definitions based on distance BETWEEN pixels.

14) The failure of a single pixel, module or power supply shall not cause the failure of any other pixel,
module, or power supply in the display.

True.

15) All modules shall have no less than a 140° horizontal half-intensity viewing angle and a readability
angle of 160° horizontal.

True.
16) The transition of the viewing intensity shall be consistent throughout the viewing cone.
True.

B) Pixels shall be constructed with discrete LEDs, and these discrete LEDs shall conform to the following
specifications:

*Watchfire used SMD construction for 10mm resolution signs and discrete (thru hole) LED

construction for the 16mm resolution signs.

* Daktronics used discreet LEDs on their 10mm displays which is older technology with lower contrast

than surface mount diodes (SMD).

1) LEDs shall be non-diffused, ultra-bright, solid state light emitting diodes.
True.

2) The red LEDs shall be constructed of AlinGaP technology and the green and blue LEDs shall be
constructed of InGaN technology (or approved equal).

Equivalent.

Watchfire tests incoming LED for performance using a 2000 hour, 85 C and 85% humidity to ensure
that they will meet the 100,000 hour half-life specification we use.

3) Each color of LEDs used in all LED displays provided for this contract shall be from the same bin.
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Watchfire bin codes incoming LED's and replacement modules that are used for warranty parts are
manufactured from the same batch as the original sigh modules.

These modules/diodes are tagged and kept in inventory for 10 Years from date of installation.

4) LED half-life shall be an estimated minimum of 100,000 hours.
True.

Watchfire tests incoming LED for performance using a 2000-hour, 85 C and 85% humidity to ensure
that they will meet the 100,000-hour half-life specification we use.

5) Display shall have a minimum intensity of 10,000 cd/m2 for RGB maximum light output, 4,500
cd/m?2 for Red maximum light output, and 6,000 cd/m2 for Amber maximum light output.

Equivalent.

C) Power Supply

1) All power supplies shall be regulated, auto-ranging AC to DC power, with protection for the LED
pixel, LED display and driver circuitry in the event of power spikes or surges.

Watchfire power supplies are rated for UL 48, ULC 48 (wet listed); Complies with FCC Part 15
regulations for Class A devices. Tested per ASTM B-117 to a continuous 95 °F (35 °C), 7.2 pH salt fog.

2) Each power supply and their connectors shall be fully sealed to protect from corrosive
environmental factors meeting IP-67 standards.

Watchfire power supplies are rated for UL 48, ULC 48 (wet listed); Complies with FCC Part 15
regulations for Class A devices. Tested per ASTM B-117 to a continuous 95 °F (35 °C), 7.2 pH salt fog.

*Exceeds IP-67 Standards.

D) Internal Wiring

1) Wiring for LED display modules and other internal components shall be installed in the housing in
a neat and professional manner.

Equivalent.

2) Wiring shall not impede the removal of display modules, power supplies or other display
components.

Equivalent.

3) Wires must not make contact with or be bent around sharp metal edges.
Equivalent.

4) All wiring shall conform to the National Electric Code.

True.
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1.3.4 DISPLAY PERFORMANCE
A) Display Capability

1) The display shall contain a full LED matrix measuring a minimum of 108 (H) pixel rows high by 288
(W) pixel columns wide, depending on the size and configuration of the chosen digital display.

Equivalent.
2) The LED display shall present messages that are continuous, uniform, and unbroken in appearance.
True.

3) The LED display shall be capable of producing 281 trillion colors for RFG and 4096 shades of color
for monochrome red or amber at all dimming levels.

*Watchfire displays are capable of producing 1.2 quintillion colors which is the largest color capability

in the industry.

*Daktronics color capability is inferior at 281 trillion colors.

4) Each display pixel shall be composed of one each — red, green and blue LEDs or one red or one
amber.

True.
5) The LED display shall be capable of displaying all true type fonts.
True.

6) The display shall be able to display messages composed of any combination of alphanumeric text,
punctuation symbols, graphic images, and pre-canned video files.

True.
7) Video and message files shall have up to a 30 frame per second play back capability.

True.

B) Controller

1) The display’s controller shall be able to run independently from a controlling computing device
allowing the display to operate even when the controlling device is unhooked or turned off.

True. The software is cloud-based and all of the end user's signs can be run and controlled from the
password protected cloud-based location.

2) Communication protocol shall support other matrix products from the vendor such as other
outdoor or indoor displays of varying sizes and/or colors.

True.
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3) Each controller shall be connected to a light sensor allowing each LED display to automatically
adjust brightness according to display direction and lighting conditions. Unit shall be capable of
controlling overall night time brightness to operate effectively at 0.3% of daytime brightness.

True. There will also be an optical sensor connected to control brightness in accordance to ambient
light levels.

4) The controller shall allow connection to a temperature sensor that provides accurate site
temperatures.

True.

5) Active presentation, stored presentations, schedules, display configuration, time and date shall be
stored in non-volatile memory. No external power or battery backup will be required to maintain this
data.

True.

C) Control and Communications

1) The display controller should be DHCP-enabled and allow for static IP addressing.
True.

2) Each single-face display shall be controlled and monitored by its own LED controller.

True. Double sided signs have been quoted to run same content on both sides.

3) The LED controller shall be able to receive instructions from and provide information by accessing
the Venus Control Suite (or equal) using the following communication modes:

Watchfire OPx2 proprietary cloud-based software will be used to run the signs.

a) Daktronics Verizon Modem w/ Lifetime Data (or equal)

There will be a lifetime Verizon data plan, antenna, and modem supplied with each sign.

1.3.5 CONTROL SOFTWARE

Displays shall be controlled by the Daktronics Venus Control Suite (or equal). Vendor shall disclose to the
City of Pembroke Pines any proprietary software used with this installation, and all information about
the software maintenance and costs, as part of this submission. Vendor should list any industry known
third-party control software that their signage hardware is compatible with, and identify the security
protocols available within that software.

Displays will be controlled by Watchfire OPx2 software. There are no licensing fees and there will be
unlimited upgrades as they become available.

Watchfire will provide unlimited software support and training via interactive webinar for the life of
the signs.
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Li® NTS watchfireD)

Testing the Value of Quality LED Signs AL

National Technical Services (NTS) in Palatine, lllinois, an independent laboratory facility, recently tested LED sign modules from 3
different manufacturers (Watchfire, Competitor A and Competitor B). With 3 new functional modules (samples 1, 2 & 3) from each
manufacturer as test specimens, the lab used a luminance device to measure reliability of the LED components and power supplies.
Samples 2 and 3 were then run in a temperature and humidity chamber set at 85°C and 85% relative humidity for 1,000 hours, fol-
lowed by a second functional test. Samples 2 and 3 were placed back into the temperature and humidity chamber for an additional
1,000 hours. A third and final functional test was conducted after a combined total of 2,000 hours in the temperature and

humidity chamber.

COMPETITOR A - Widespread LED Failures

Watchfire Modul Competitor A Modul

LED Failure % Pobbbbipreed

| | 2,000 Hours i 303 b b

® Red ® Green ® Blue Overall Brightness » ol s
Watchfire 0% 0% 0% 83%
Competitor A 0% 7% 61% 85%

0% LED Failure 23% LED Failure

COMPETITOR A ANALYSIS: Significant color distortion occurred as a result of widespread blue LED failures and, to a lesser extent,
green LED failures. Failure of these colors also leads to an overall pinkish hue on all non-red colors in a display.

COMPETITOR B - Loss of Brightness and Image Color Shift

LED Failure %
1

| | 2,000 Hours
® Red ® Green ® Blue Overall Brightness
Watchfire 0% 0% 0% 83%
Competitor B 0% 0% 0% 65%
Watchfire Competitor B

Watchfire - 85°C / 85%RH Competitor B - 85°C / 85%RH

Red LED Brightness Green LED Brightness
Blue LED Brightness == (Overall LED Brightness

COMPETITOR B ANALYSIS: Color accuracy is dramatically impacted by the inconsistent dimming of overall brightness (white), and
individual red, green, and blue LEDs on Competitor B’s modules. After 2,000 hours in the temperature and humidity chamber, overall
brightness diminished by 35%, double that of Watchfire’s modules.
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Job Name Sign Specification Age Address

Clear Channel Outdoor 19mm 13x45 5 years Palmetto Expressway Miami Gardens

Clear Channel Outdoor 19mm 13x45 4 years Palmetto Expressway Miami Gardens

McDonald's 19mm 3x8 8 years 7155 W 4TH AVE, HIALEAH, FL, 33014

The Palm's at Town / Country 19mm 12 x 21 9 years 8390 Mills Rd. Miami, FL

Palm Beach St. College 19mm 3x11 8 years 300 Palm Beach State College Blvd, Boca Raton, FL
Tamarac Sports Complex 12mm 3x6 1year 9901 NW 77th St, Tamarac, FL, 33321

City of Tamarac 12mm 3x6 1year 7525 NW 88th Ave, Tamarac, FL, 33321
Tamarc Community Center 12mm 3x6 1year 8601 W Commercial Blvd, Tamarac, FL, 33321
Festival Marketplace 16mm 5x10 2 years 2900 Sample Road, Pompano Beach

Clear Channel Outdoor 19mm 13x45 4 years 8600 Northwest South River Drive

Univeristy of South FL 10mm 5x8 1years USF Tampa main entrance

WINK News Ft. Myers 12mm 10 x25 3 years 2824 Palm Beach Blvd. Ft. Myers

Central Florida Chrysler 19mm 8X32 6 years Sand Lake / John Young , Orlando, FL
Reningers Flea Market 19mm 8x20 6 years 195 Melbourne, FL

Hill Kelly Dodge 19mm 6X16 6 years 6171 Pensacola Blvd, Pensacola, FL 32505
ESPN Zone 19mm 4 x 22 3 years 700 Victory Way, Orlando, FL

Winter Haven Airport 10mm 4x8 3years Winter Haven, FL

Melbourne International Airport 19mm 3 x10 7 years One Terminal Parkway, Melbourne, FL

Florida Fine Cars 16mm 5x9 8 years 21151 nw 2nd Ave. Miami Gardens

Dr. LeStrange 16mm 3x8 1year 1600 S. Federal Highway, Pompano, Beach, FL
Mid Florida Credit Union 10mm 3 x9 3 years 2636 4th St. N., St. Petersburg, FL
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Exceptions, Conditions or Clarifications of our Bid Submittal

1. Insurance: The Gen Liability and Commercial Truck coverage we provide
exceeds FL State Licensing requirments. This bid does not include any
other types of insurance coverage, such as but not limited to, Cyber
Liability coverage, Pollution coverage, Prof Liability / Errors & Omissions
coverage, Crime coverage, etc.

The cost of any special coverages other than Gen Liability, Comm Truck
and Workers Compensation coverage will have to be negotiated and
added to the Bid Proposal or Contract Amount.

2. Electric Service to each Site: This bid is contingent on the COPP
supplying the electric circuit(s) all the way to the site of each sign.

3. Sign Installation Exclusions: This bid excludes all costs related to
correcting or otherwise dealing with unforeseen conditions, such as but
not limited to, an inability to get heavy equipment to the site, ground
water, underground riprap or abandoned underground facilities or old
pavement or any other unforeseen condition. -

4. Performance & Payment Bond: The cost of this premium will be added
to the Contract Amount.

5. Permits: The cost of all permits, engineering fees or inspections fees
imposed by the city, county or state will be added to the Contract
Amount.
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CONTACT INFORMATION FORM

IN ACCORDANCE WITH “PL-18-06 titled “Digital Signage Fabrication and Installation” attached
hereto as a part hereof, the undersigned submits the following:

A) Contact Information

The Contact information form shall be electronically signed by one duly authorized to do so, and in case signed
by a deputy or subordinate, the principal's properly written authority to such deputy or subordinate must
accompany the proposal. This form must be completed and submitted through www.bidsync.com as part of the
bidder’s submittal. The vendor must provide their pricing through the designated lines items listed on the
BidSync website.

COMPANY INFORMATION:

COMPANY:: Dowling Const Co
STREET ADDRESS: 905 East Coast Drive
CITY, STATE & ZIP CODE: Atlantic Beach FL 32233

PRIMARY CONTACT FOR THE PROJECT:

NAME: Heywood A Dowling TITLE: President
E-MAIL: petedowlingl@comcast.net
TELEPHONE: 9042198044 FAX:

AUTHORIZED APPROVER:

NAME: Heywood A Dowling TITLE: President
E-MAIL: petedowlingl@comcast.net
TELEPHONE: 9042198044 FAX:

SIGNATURE: Heywood A. Dowling
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B) Proposal Checklist

Did you make sure to submit the following items, as stated in section 1.5 “Proposal Requirements” of the bid

package?

[ Title Page Yes []
Tab 1 - Table of Contents Yes [
Tab 2 - Letter of Interest Yes []
Tab 3 - Experience and Ability Yes []
Tab 4 — Relevant Similar Projects Yes []

1. Attachment M - References Form Yes
2. Project details as outlined in Tab 4, section 2. Yes []
3. List of ongoing contracts/projects Yes []
Tab 5 - Firm’s Understanding and Approach to the Work Yes []
1. Narrative Statement Yes []
2. Details and Timeline Yes []
3. Challenges / Concerns Yes []
4. Product/Market Differentiators Yes []
5. Platform Technical Requirements Yes []
6. Platform Maintenance Yes []
7. Content Management Yes []
8. Customer Service and Technical Support Yes []
Tab 6 - Project Cost Yes []
1. Attachment A -Contact Information Form Yes
2. Platform Maintenance Costs Yes []
3. Additional Costs, if applicable Yes []
4. Extended Warranty, if applicable Yes []
Tab 7 — Other Completed Documents Yes []
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1. Attachment B - Vendor Information Form Yes []
W-9 (Rev. October 2018) Yes

2. Attachment C - Non-Collusive Affidavit Yes
3. Attachment D - Sworn Statement on Public Entity Crimes Form Yes
4. Attachment E - Local Vendor Preference Certification Yes
5. Attachment F - Veteran Owned Small Business Preference Certification Yes
6. Attachment G - Equal Benefits Certification Form Yes
7. Attachment H - Vendor Drug-Free Workplace Certification Form Yes
8. Attachment I - Vendor Certification Regarding Scrutinized Companies List Yes
9. Attachment J - Proposer’s Completed Qualification Statement Yes
10. If your proposal exceed $200,000 for this construction project? Yes []

Note — If so, please include a Proposal Security (Bid Bond or Cashier’s or

Check) along with a separate line item to provide a Payment and Performance

Bond. Please see SECTION 4 - SPECIAL TERMS & CONDITIONS of N/A [

this RFP for additional information.

Proposers must also submit their original bid security (bid bond form or

cashiers check) at time of the bid due date, or they may be deemed as non-

responsive. The original Bid Bond or Cashier's Check should be in a sealed

envelope, plainly marked “BID SECURITY - RFP # PL-18-06, Digital

Signage Fabrication and Installation” and sent to the City of Pembroke Pines,

City Clerk’s Office, 4th Floor, 601 City Center Way, Pembroke Pines,

Florida, 33025.

Proposers must submit a scanned copy of their bid security (bid bond form or

cashiers check) with their bid submittal through BidSync.

Tab 8 — Business Structure, Licenses and Professional Registration Certificates Yes []
1. Any applicable city, county, and state professional licenses Yes []
2. Business tax receipts. Yes []

Note — If claiming Local VVendor Preference, the business must attach a
current business tax receipt from Broward County or the city within Broward
County where the business resides along with any previous business tax
receipts to indicate that the business entity has maintained a permanent place of
business for a minimum of one (1) year.
Are all materials, freight, labor, engineering and warranties included? Yes
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City of Pembroke Pines

The following sample price proposal is for information only. The vendor must provide their pricing
through the designated lines items listed on the BidSync website.

Equipment Options (Includes all costs for LED Digital Display Hardware, Fabricated Housing,
Foundations and Footers, etc.)

Item # | Item Description Unit of Make / Model Unit Price
Measure
1) 10mm Sign Option (Single-Sided) Each To be Submitted | To be Submitted
Via BidSync Via BidSync
2) 10mm Sign Option (Double-Sided) Each To be Submitted | To be Submitted
Via BidSync Via BidSync
3) 15.85mm Sign Option (Single- Each To be Submitted | To be Submitted
Sided) Via BidSync Via BidSync
4) 15.85mm Sign Option (Double- Each To be Submitted | To be Submitted
Sided) Via BidSync Via BidSync
at the following sites:
Item # Location Total Cost
1) Fire Station 79 - 19999 Pines Blvd. Price to be Submitted
Via BidSync
2) Fire Station 99 - 16999 Pines Blvd. Price to be Submitted
Via BidSync
3) Fire Department Headquarters/Fire Station 69 - 9500 Pines Price to be Submitted
Blvd. Via BidSync
43) | City Right-of-Way at 129" Avenue (North Side Option) Price to be Submitted
Via BidSync
4b) | Fire Station 89 at 129" Avenue - 13000 Pines Blvd. (South Price to be Submitted
Side Option) Via BidSync
5) The south or southeast corner of the roundabout at the Price to be Submitted
intersection of City Center Blvd. and SW 103" Avenue Via BidSync
6) Howard C. Forman Health Park Entrance Price to be Submitted
Via BidSync
7) Pembroke Lakes Golf Club - corner of Taft St. and NW Price to be Submitted
1015t Ave. Via BidSync
8) Additional Cost to provide a Payment & Performance Bond Price to be Submitted
Via BidSync
Note: The contractor is responsible for obtaining building department permits for each site. The City will
provide a Permit Allowance for this project. (Refer to Section 1.4 in the RFP document.)

Software & Related Services (Design, Implementation, Setup, Testing, Training)

3/27/2019
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Item # | Description Number of hours Cost per hour Total Cost
1) Software Package Cost N/A N/A To be Submitted
Via BidSync
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2) Design To be Submitted To be Submitted Extended Price
Via BidSync Via BidSync
3) Implementation To be Submitted To be Submitted Extended Price
Via BidSync Via BidSync
4) Setup To be Submitted To be Submitted Extended Price
Via BidSync Via BidSync
5) Testing To be Submitted To be Submitted Extended Price
Via BidSync Via BidSync
6) Training To be Submitted To be Submitted Extended Price
Via BidSync Via BidSync
Software Support & Maintenance
Item # Description Total Cost
1) Annual Software Maintenance Costs Price to be Submitted
Via BidSync
2) Annual Customer Service & Technical Support Costs Price to be Submitted
Via BidSync

If discounts are available for multi-year Customer Service & Technical Support agreements, please

provide this information regarding the length of term and the net discount percentage.

Item # | Description Length of Term Net Discount Percentage
1) Customer Service & Technical To be Submitted Via To be Submitted Via
Support Discount Option BidSync BidSync
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Sign Leasing Option (If Available)

Provide a yearly cost for leasing of these signs and a time duration of the lease with possible extensions to the
lease being made which would include updates to the digital hardware and software at scheduled intervals,

(minimum of six (6) year intervals).

Item # | Sign Location Lease Duration Yearly Cost
10mm | 15.85mm

1) Fire Station 79 - 19999 Pines Blvd. To be Submitted Price to be Submitted Via
(double-sided) Via BidSync BidSync

2) Fire Station 99 - 16999 Pines Blvd. To be Submitted Price to be Submitted Via
(double-sided) Via BidSync BidSync

3) Fire Department Headquarters/Fire To be Submitted Price to be Submitted Via
Station 69 - 9500 Pines Blvd. Via BidSync BidSync
(double-sided)

4a) City Right-of-Way at 129t Avenue To be Submitted Price to be Submitted Via
(North Side Option) (single-sided) Via BidSync BidSync

4b) Fire Station 89 at 129" Avenue - To be Submitted Price to be Submitted Via
13000 Pines Blvd. (South Side Via BidSync BidSync
Option) (single-sided)

5a) Roundabout at City Center Blvd. & To be Submitted Price to be Submitted Via
SW 103" Ave. (single-sided) Via BidSync BidSync

5b) Roundabout at City Center Blvd. & To be Submitted Price to be Submitted Via
SW 103" Ave. (double-sided) Via BidSync BidSync

6) Howard C. Forman Health Park To be Submitted Price to be Submitted Via
Entrance (single-sided) Via BidSync BidSync

7) Pembroke Lakes Golf Club - corner of | To be Submitted Price to be Submitted Via
Taft St. and NW 1015t Ave. (single- Via BidSync BidSync
sided)

3l | 4l
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City of Pembroke Pines Attachment C

NON-COLLUSIVE AFFIDAVIT

BIDDER is the Heywood A. Dowling - President DOWLING CONSTRUCTION CO,
(Owner, Partner, Officer, Representative or Agent)

BIDDER is fully informed respecting the preparation and contents of the attached Bid and of all pertinent
circumstances respecting such Bid,;

Such Bid is genuine and is not a collusive or sham Bid;

Neither the said BIDDER nor any of its officers, partners, owners, agents, representative, employees or
parties in interest, including this affidavit, have in any way colluded, conspired, connived or agreed,
directly or indirectly, with any other BIDDER, firm or person to submit a collusive or sham Bid in
connection with the Contract for which the attached Bid has been submitted; or to refrain from bidding
in connection with such Contract; or have in any manner, directly or indirectly, sought by agreement or
collusion, or communications, or conference with any BIDDER, firm, or person to fix the price or prices
in the attached Bid or any other BIDDER, or to fix any overhead, profit, or cost element of the Bid
Price or the Bid Price of any other BIDDER, or to secure through any collusion conspiracy, connivance,
or unlawful agreement any advantage against (Recipient), or any person interested in the proposed
Contract;

The price of items quoted in the attached Bid are fair and proper and are not tainted by collusion,
conspiracy, connivance, or unlawful agreement on the part of the BIDDER or any other of its agents,
representatives, owners, employees or parties in interest, including this affidavit.

Printed Name/Signature Heywood A DOWLING

Title President

Name of Company Dowling Construction Company
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City of Pembroke Pines Ataenment.[)

SWORN STATEMENT

ON PUBLIC ENTITY CRIMES
UNDER FLORIDA STATUTES CHAPTER 287.133(3)(a).

This sworn statement is submitted by Dowling Construction Co (name of entity submitting sworn
statement) whose business address is 905 East Coast Drive, Atlantic Beach FL 32233 and (if
applicable) its Federal Employer Identification Number (FEIN) is 20-0556224. (If the entity has no
FEIN, include the Social Security Number of the individual signing this sworn statement: .)

My name is Heywood A. Dowling and my
(Please print name of individual signing)

relationship to the entity named above is President.

I understand that a "public entity crime" as defined in Paragraph 287.133(1)(g), Florida Statutes,
means a violation of any state or federal law by a person with respect to and directly related to the
transaction of business with any public entity or with an agency or political subdivision of any other
state or with the United States, including, but not limited to, any bid, proposal, reply, or contract for
goods or services, any lease for real property, or any contract for the construction or repair of a
public building or public work, involving antitrust, fraud, theft, bribery, collusion, racketeering,
conspiracy, or material misrepresentation.

I understand that a "convicted" or "conviction" as defined in Paragraph 287.133(1)(b), Florida
Statutes, means a finding of guilt or a conviction of a public entity crime, with or without an
adjudication of guilt, in any federal or state trial court of record relating to charges brought by
indictment or information after July 1, 1989, as a result of a jury verdict, nonjury trial, or entry of a
plea of guilty or nolo contendere.

I understand that an "affiliate" as defined in Paragraph 287.133(1)(a), Florida Statutes, means:
1. A predecessor or successor of a person convicted of a public entity crime: or

2. An entity under the control of any natural person who is active in the management of the
entity and who has been convicted of a public entity crime. The term "affiliate" includes
those officers, directors, executives, partners, shareholders, employees, members, and
agents who are active in the management of an affiliate. The Cityship by one person of
shares constituting a controlling interest in another person, or a pooling of equipment or
income among persons when not for fair market value under an arm's length agreement,
shall be a prima facie case that one person controls another person. A person who
knowingly enters into a joint venture with a person who has been convicted of a public
entity crime in Florida during the preceding 36 months shall be considered an affiliate.

I understand that a "person" as defined in Paragraph 287.133(1)(e), Florida Statutes, means any
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natural person or any entity organized under the laws of any state or of the United States with the
legal power to enter into a binding contract and which bids or applies to bid on contracts let by a
public entity, or which otherwise transacts or applies to transact business with a public entity, or
which otherwise transacts or applies to transact business with a public entity. The term "person"
includes those officers, directors, executives, partners, shareholders, employees, members, and
agents who are active in management of an entity.

7. Based on information and belief, the statement which I have marked below is true in relation to the
entity submitting this sworn statement. (Please indicate which statement applies.)

A) Neither the entity submitting this sworn statement, nor any officers, directors, executives,
partners, shareholders, employees, members, or agents who are active in management of the entity,
nor any affiliate of the entity have been charged with and convicted of a public entity crime
subsequent to July 1, 1989.

[1 B) The entity submitting this sworn statement, or one or more of the officers, directors,
executives, partners, shareholders, employees, members, or agents who are active in management
of the entity, or an affiliate of the entity has been charged with and convicted of a public entity crime
subsequent to July 1, 1989, AND (Please indicate which additional statement applies.)

[[] B1) There has been a proceeding concerning the conviction before a hearing officer of
the State of Florida, Division of Administrative Hearings. The final order entered by the
hearing officer did not place the person or affiliate on the convicted vendor list. (Please
attach a copy of the final order.)

[[] B2) The person or affiliate was placed on the convicted vendor list. There has been a
subsequent proceeding before a hearing officer of the State of Florida, Division of
Administrative Hearings. The final order entered by the hearing officer determined that it
was in the public interest to remove the person or affiliate from the convicted vendor list.
(Please attach a copy of the final order.)

[1 B3) The person or affiliate has not been placed on the convicted vendor list. (Please
describe any action taken by or pending with the Department of General Services.)

Heywood A. Dowling Dowling Construction March 21,2019
Company
Bidder’s Name/Signature Company Date
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SN
"F City of Pembroke Pines Attachment E

LOCAL VENDOR PREFERENCE CERTIFICATION

SECTION 1 GENERAL TERM

LOCAL PREFERENCE

The evaluation of competitive bids is subject to section 35.36 of the City’s Procurement Procedures which, except
where contrary to federal and state law, or any other funding source requirements, provides that preference be given to
local businesses. To satisfy this requirement, the vendor shall affirm in writing its compliance with either of the
following objective criteria as of the bid or proposal submission date stated in the solicitation. A local business shall
be defined as:

1. "Local Pembroke Pines Vendor" shall mean a business entity which has maintained a permanent place of
business with full-time employees within the City limits for a minimum of one (1) year prior to the date of
issuance of a bid or proposal solicitation. The permanent place of business may not be a post office box. The
business location must actually distribute goods or services from that location. In addition, the business must
have a current business tax receipt from the City of Pembroke Pines.

2.  “Local Broward County Vendor" shall mean or business entity which has maintained a permanent place of
business with full-time employees within the Broward County limits for a minimum of one (1) year prior to the
date of issuance of a bid or proposal solicitation. The permanent place of business may not be a post office
box. The business location must actually distribute goods or services from that location. In addition, the
business must have a current business tax receipt from the Broward County or the city within Broward County
where the business resides.

A preference of five percent (5%) of the total evaluation point, or five percent (5%) of the total price, shall be given to the
Local Pembroke Pines Vendor(s); A preference of two and a half percent (2.5%) of the total evaluation point for local, or
two and a half percent (2.5%) of the total price, shall be given to the Local Broward County Vendor(s).

COMPARISON OF QUALIFICATIONS

The preferences established in no way prohibit the right of the City to compare quality of supplies or services for
purchase and to compare qualifications, character, responsibility and fitness of all persons, firms or corporations
submitting bids or proposals. Further, the preference established in no way prohibit the right of the city from giving any
other preference permitted by law instead of the preferences granted, nor prohibit the city to select the bid or proposal
which is the most responsible and in the best interests of the city.

SECTION 2 AFFIRMATION
LOCAL PREFERENCE CERTIFICATION:

[] Place a check mark here only if affirming bidder meets requirements above as a Local Pembroke Pines Vendor.
In addition, the business must attach a current business tax receipt from the City of Pembroke Pines along
with any previous business tax receipts to indicate that the business entity has maintained a permanent place
of business for a minimum of one (1) year.

[] Place a check mark here only if affirming bidder meets requirements above as a Local Broward County Vendor.

In addition, the business must attach a current business tax receipt from the Broward County or the city within
Broward County where the business resides along with any previous business tax receipts to indicate that the
business entity has maintained a permanent place of business for a minimum of one (1) year.

Place a check mark here only if affirming bidder does not meet the requirements above as a Local Vendor.

Failure to complete this certification at this time (by checking either of the boxes above) shall render the vendor
ineligible for Local Preference. This form must be completed by/for the proposer; the proposer WILL NOT qualify
for Local Vendor Preference based on their sub-contractors’ qualifications.

COMPANY NAME: Dowling Construction Co

PRINTED NAME / AUTHORIZED SIGNATURE: Heywood A DOWLING

3/27/2019 BidSync p. 317



City of Pembroke Pines PL-18-06

3/27/2019 BidSync p. 318



City of Pembroke Pines PL-18-06

VETERAN OWNED SMALL BUSINESS (VOSB) PREFERENCE CERTIFICATION

SECTION 1 GENERAL TERM

VETERAN OWNED SMALL BUSINESS (VOSB) PREFEREENCE

The evaluation of competitive bids is subject to section 35.37 of the City’s Procurement Procedures which, except where
contrary to federal and state law, or any other funding source requirements, provides that preference be given to veteran
owned small businesses. To satisfy this requirement, the vendor shall affirm in writing its compliance with the following
objective criteria as of the bid or proposal submission date stated in the solicitation. A veteran owned small business
shall be defined as:

1. "Veteran Owned Small Business" shall mean a business entity which has received a “Determination Letter” from the
United States Department of Veteran Affairs Center for Verification and Evaluation notifying the business that they
have been approved as a Veteran Owned Small Business (VOSB).

A preference of two and a half percent (2.5%) of the total evaluation point, or two and a half percent (2.5%) of the total price,
shall be given to the Veteran Owned Small Business (VOSB). This shall mean that if a VOSB submits a bid/quote that is
within 2.5% of the lowest price submitted by any vendor, the VOSB shall have an option to submit another bid which is at
least 1% lower than the lowest responsive bid/quote. If the VOSB submits a bid which is at least 1% lower than that lowest
responsive bid/quote, then the award will go to the VOSB. If not, the award will be made to the vendor that submits the
lowest responsive bid/quote. If the lowest responsive and responsible bidder IS a "Local Pembroke Pines
Vendor" (LPPV) or a “Local Broward County Vendor” (LBCV) as established in Section 35.36 of the City’s Code of
Ordinances, entitled “Local Vendor Preference”, then the award will be made to that vendor and no other bidders will be
given an opportunity to submit additional bids as described herein.

If there is a LPPV, a LBCV, and a VOSB participating in the same bid solicitation and all three vendors qualify to submit a
second bid, the LPPV will be given first option. If the LPPV cannot beat the lowest bid received by at least 1%, an
opportunity will be given to the LBCV. If the LBCV cannot beat the lowest bid by at least 1%, an opportunity will be given to
the VOSB. If the VOSB cannot beat the lowest bid by at least 1%, then the bid will be awarded to the lowest bidder.

If multiple VOSBs submit bids/quotes which are within 2.5% of the lowest bid/quote and there are no LPPV or LBCV as
described in Section 35.36 of the City’'s Code of Ordinance, entitled “Local Vendor Preference”, then all VOSBs will be
asked to submit a Best and Final Offer (BAFO). The award will be made to the VOSB submitting the lowest BAFO providing
that that BAFO is at least 1% lower than the lowest bid/quote received in the original solicitation. If no VOSB can beat the
lowest bid/quote by at least 1%, then the award will be made to the lowest responsive bidder.

COMPARISON OF QUALIFICATIONS

The preferences established in no way prohibit the right of the City to compare quality of supplies or services for purchase
and to compare qualifications, character, responsibility and fitness of all persons, firms or corporations submitting bids or
proposals. Further, the preference established in no way prohibit the right of the city from giving any other preference
permitted by law instead of the preferences granted, nor prohibit the city to select the bid or proposal which is the most
responsible and in the best interests of the city.

SECTION 2 AFFIRMATION
VETERAN OWNED SMALL BUSINESS (VOSB) PREFEREENCE CERTIFICATION:

[] Place a check mark here only if affirming bidder meets requirements above as a Veteran Owned Small Business.
In addition, the bidder must attach the “Determination Letter” from the U.S. Dept. of Veteran Affairs Center.

Place a check mark here only if affirming bidder does not meet the requirements above as a VOSB.

Failure to complete this certification at this time (by checking either of the boxes above) shall render the vendor
ineligible for VOSB Preference. This form must be completed by/for the proposer; the proposer WILL NOT qualify for
VOSB Preference based on their sub-contractors’ qualifications.

COMPANY NAME: Dowling Construction Co

PRINTED NAME / AUTHORIZED SIGNATURE: Heywood A DOWLING
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1) Attachment G

City of Pembroke Pines

EQUAL BENEFITS CERTIFICATION FORM
FOR DOMESTIC PARTNERS AND ALL MARRIED COUPLES

Except where federal or state law mandates to the contrary, a Contractor awarded a Contract
pursuant to a competitive solicitation shall provide benefits to Domestic Partners and spouses of its
employees, irrespective of gender, on the same basis as it provides benefits to employees' spouses
in traditional marriages.

The Contractor shall provide the City and/or the City Manager or his/her designee, access to its
records for the purpose of audits and/or investigations to ascertain compliance with the provisions of
this section, and upon request shall provide evidence that the Contractor is in compliance with the
provisions of this section upon each new bid, contract renewal, or when the City Manager has
received a complaint or has reason to believe the Contractor may not be in compliance with the
provisions of this section. Records shall include but not be limited to providing the City and/or the
City Manager or his/her designee with certified copies of the Contractor’s records pertaining to its
benefits policies and its employment policies and practices.

The Contractor must conspicuously make available to all employees and applicants for employment
the following statement:

“During the performance of a contract with the City of Pembroke Pines,
Florida, the Contractor will provide Equal Benefits to its employees with
spouses, as defined by Section 35.39 of the City’s Code of Ordinances, and its
employees with Domestic Partners and all Married Couples”.

The posted statement must also include a City contact telephone number and email address which
will be provided to each contractor when a covered contract is executed.

SECTION 1 DEFINITIONS

1. Benefits means the following plan, program or policy provided or offered by a contractor to
its employees as part of the employer’s total compensation package which may include but
is not limited to sick leave, bereavement leave, family medical leave, and health benefits.

2. Cash Equivalent mean the amount of money paid to an employee with a domestic partner
or spouse in lieu of providing benefits to the employee’s domestic partner or spouse. The
cash equivalent is equal to the employer’s direct expense of providing benefits to an
employee for his or her spouse from a traditional marriage.

3. Covered Contract means a contract between the City and a contractor awarded
subsequent to the date when this section becomes effective valued at over $25,000 or the
threshold amount required for competitive bids as required in section 35.18(A) of the
Procurement Code.

4. Domestic Partner shall mean any two (2) adults of the same or different sex who have
registered as domestic partners with a governmental body pursuant to state or local law
authorizing such registration, or with an internal registry maintained by the employer of at
least one of the domestic partners. A contractor may institute an internal registry to allow for
the provision of equal benefits to employees with domestic partners who do not register their
partnerships pursuant to a governmental body authorizing such registration, or who are
located in a jurisdiction where no such governmental domestic partnership registry exists. A
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contractor that institutes such registry shall not impose criteria for registration that are more
stringent than those required for domestic partnership registration by the City of Pembroke
Pines.

5. Equal benefits means the equality of benefits between employees with spouses and/or
dependents of spouses and employees with domestic partners and/or dependents of
domestic partners, and/or between spouses of employees and/or dependents of spouses
and domestic partners of employees and/or dependents of domestic partners.

6. Spouse means one member of a married pair legally married under the laws of any state
within the United States of America or any other jurisdiction under which such marriage is
legally recognized, irrespective of gender.

7. Traditional marriage means a marriage between one man and one woman.

SECTION 2 CERTIFICATION OF CONTRACTOR

The firm providing a response, by virtue of the signature below, certifies that it is aware of the
requirements of Section 35.39 “City Contractors providing Equal Benefits for Domestic Partners and
all Married Couples” of the City’'s Code of Ordinances, and certifies the following (Check only one
box below):

[1 A. Contractor currently complies with the requirements of this section; or
B. Contractor will comply with the conditions of this section at the time of contract award; or
[1 C. Contractor will not comply with the conditions of this section at the time of contract award: or

[[1 D. Contractor does not comply with the conditions of this section because of the following
allowable exemption (Check only one box below):

[[1 1. The Contractor does not provide benefits to employees' spouses in traditional
marriages;

[] 2. The Contractor provides an employee the cash equivalent of benefits because the
Contractor is unable to provide benefits to employees' Domestic Partners or spouses
despite making reasonable efforts to provide them. To meet this exception, the Contractor
shall provide a notarized affidavit that it has made reasonable efforts to provide such
benefits. The affidavit shall state the efforts taken to provide such benefits and the amount of
the cash equivalent. Cash equivalent means the amount of money paid to an employee with
a Domestic Partner or spouse rather than providing benefits to the employee's Domestic
Partner or spouse. The cash equivalent is equal to the employer's direct expense of
providing benefits to an employee's spouse;

[1 3. The Contractor is a religious organization, association, society, or any non-profit
charitable or educational institution or organization operated supervised or controlled by or in
conjunction with a religious organization, association, or society;

[1 4. The Contractor is a governmental agency;

The certification shall be signed by an authorized officer of the Contractor. Failure to

provide such certification (by checking the appropriate boxes above along with completing
the information below) shall result in a Contractor being deemed non-responsive.

COMPANY NAME: Dowling Construction Co

AUTHORIZED OFFICER NAME / SIGNATURE: Heywood A DOWLING

3/27/2019 BidSync p. 322



City of Pembroke Pines PL-18-06

3/27/2019 BidSync p. 323



City of Pembroke Pines PL-18-06

N
"‘"E City of Pembroke Pines AttachmentH

VENDOR DRUG-FREE WORKPLACE CERTIFICATION FORM

SECTION 1 GENERAL TERM

Preference may be given to vendors submitting a certification with their bid/proposal certifying they have a drug-free
workplace in accordance with Section 287.087, Florida Statutes. This requirement affects all public entities of the State and
becomes effective January 1, 1991. The special condition is as follows:

IDENTICAL TIE BIDS - Preference may be given to businesses with drug-free workplace programs. Whenever two or
more bids that are equal with respect to price, quality, and service are received by the State or by any political subdivision for
the procurement of commodities or contractual services, a bid received from a business that certifies that it has implemented
a drugfree workplace program shall be given preference in the award process. Established procedures for processing tie bids
will be followed if none of the tied vendors have a drug-free workplace program. In order to have a drug-free workplace
program, a business shall:

1. Publish a statement notifying employees that the unlawful manufacture, distribution, dispensing, possession, or use of
a controlled substance is prohibited in the workplace and specifying the actions that will be taken against employees
for violations of such prohibition.

2. Inform employees about the dangers of drug abuse in the workplace, the business’s policy of maintaining a drug-fie
workplace, any available drug counseling, rehabilitation, and employee assistance programs, and the penalties that
may be imposed upon employees for drug abuse violations.

3. Give each employee engaged in providing the commodities or contractual services that are under bid a copy of the
statement specified in subsection (1).

4.  In the statement specified in subsection (1), notify the employees that, as a condition of working on the commodities
or contractual services that are under bid, the employee will abide by the terms of the statement and will notify the
employer of any conviction of, or plea of guilty or nolo contendere to, any violation of chapter 893 or of any controlled
substance law of the United States or any state, for a violation occurring in the workplace no later than five (5) days
after each conviction.

5. Impose a sanction on, or require the satisfactory participation in a drug abuse assistance or rehabilitation program if
such is available in the employee's community, by any employee who is so convicted.

6. Make a good faith effort to continue to maintain a drug-free workplace through implementation of this section.
SECTION 2 AFFIRMATION

[¥| Place a check mark here only if affirming bidder complies fully with the above requirements for a Drug-Free Workplace.

[Tl Place a check mark here only if affirming bidder does not meet the requirements for a Drug-Free Workplace.

Failure to complete this certification at this time (by checking either of the boxes above) shall render the vendor ineligible for Drug
Free Workplace Preference. This form must be completed by/for the proposer; the proposer WILL NOT qualify for Drug-fz
Workplace Preference based on their sub-contractors’ qualifications.

Heywood A DOWLING Dowling Construction Company
Authorized Signature Authorized Signer Name Company Name
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o Attachment I
_-1.‘ ' City of Pembroke Pines

SCRUTINIZED COMPANY CERTIFICATION
PURSUANT TO FLORIDA STATUTE § 287.135.

I, Heywood A. Dowling , on behalf of Dowling Construction Company,
Print Name and Title Company Name

certify that Dowling Construction Company:
Company Name

Does not participate in a boycott of Israel; and

Is not on the Scrutinized Companies that Boycott Israel list; and

Is not on the Scrutinized Companies with Activities in Sudan List; and

Is not on the Scrutinized Companies with Activities in the Iran Petroleum Energy Sector
List; and

5. Has not engaged in business operations in Syria.

B

Submitting a false certification shall be deemed a material breach of contract. The City shall provide notice,
in writing, to the Contractor of the City’s determination concerning the false certification. The Contractor
shall have ninety (90) days following receipt of the notice to respond in writing and demonstrate that the
determination of false certification was made in error. If the Contractor does not demonstrate that the City’s
determination of false certification was made in error then the City shall have the right to terminate the
contract and seek civil remedies pursuant to Florida Statute § 287.135.

Section 287.135, Florida Statutes, prohibits the City from: 1) Contracting with companies for goods or
services in any amount if at the time of bidding on, submitting a proposal for, or entering into or renewing a
contract if the company is on the Scrutinized Companies that Boycott Israel List, created pursuant to
Section 215.4725, F.S. or is engaged in a boycott of Israel; and 2) Contracting with companies, for goods
or services over $1,000,000.00 that are on either the Scrutinized Companies with activities in the Iran
Petroleum Energy Sector list, created pursuant to s. 215.473, or are engaged in business operations in
Syria.

As the person authorized to sign on behalf of the Contractor, | hereby certify that the company identified
above in the section entitled “Contractor Name” does not participate in any boycott of Israel, is not listed on
the Scrutinized Companies that Boycott Israel List, is not listed on either the Scrutinized Companies with
activities in the Iran Petroleum Energy Sector List, and is not engaged in business operations in Syria. |
understand that pursuant to section 287.135, Florida Statutes, the submission of a false certification may
subject the company to civil penalties, attorney's fees, and/or costs. | further understand that any contract
with the City for goods or services may be terminated at the option of the City if the company is found to
have submitted a false certification or has been placed on the Scrutinized Companies with Activities in
Sudan list or the Scrutinized Companies with Activities in the Iran Petroleum Energy Sector List.

Dowling Construction Company  Heywood A. Dowling President
Company Name Print Name/Signature Title
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RS Attachment J
=4 City of Pembroke Pines

PROPOSER’S QUALIFICATIONS STATEMENT

PROPOSER shall furnish the following information. Failure to comply with this requirement will render Bid
non-responsive and shall cause its rejection. Additional sheets shall be attached as required.

PROPOSER'S Name and Principal Address:
DOWLING CONSTRUCTION COMPANY

905 East Coast Drive

Atlantic Beach, FL 32233

Contact Person’s Name and Title: Heywood A. Dowling - President DOWLING CONSTRUCTION
CO

Contact Person’s E-mail Address: petedowlingl@comcast.net
PROPOSER'S Telephone and Fax Number: 9042198044 / No Fax

PROPOSER’S License Number: FL Cert Contractor #CBC006834
(Please attach certificate of status, competency, and/or state registration.)

PROPOSER’S Federal Identification Number: 20-0556224

Number of years your organization has been in business 44 (Inc 2002)

State the number of years your firm has been in business under your present business name 44
State the number of years your firm has been in business in the work specific to this solicitation: 13

Names and titles of all officers, partners or individuals doing business under trade name:
President - Heywood A. Dowling

Vice President - Jennifer Dowling
The business is a: Sole Proprietorship [] Partnership [] Corporation

IF USING A FICTITIOUS NAME, SUBMIT EVIDENCE OF COMPLIANCE WITH FLORIDA
FICTITIOUS NAME STATUTE.
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Under what former name has your business operated? Include a description of the business. Failure to
include such information shall be deemed to be intentional misrepresentation by the City and shall render the
Proposer non-responsive.

Incorporated in 2002, Dowling Construction Co has been operating under the same name
since its inception in 1974.
From 1974 through 2006, we performed Residential and Commercial Remodeling and New
Construction. In 2006, we performed a free sign installation for the USO in Mayport FL near
NAS Mayport. The success of that job evolved into our becoming an Independent Sign Supplier
& Installer for Florida School Systems and military bases throughout the USA, Hawaii and Puerto
Rico.

Mostly staffed by family members, we have been going strong ever since.....Heywood Dowling

At what address was that business located?
No former name but our business addresses in chronological order have been -
1. 1840 North Third Street, Jacksonville Beach FL 32250
2. 1202 North Third Street, Jacksonville Beach FL 32250
3. 202 Atlantic Blvd, Neptune Beach FL 32266
4. 910 Harbor Lake Court, Safety Harbor FL 34695

Name, address, and telephone number of surety company and agent who will provide the required bonds
on this contract:
SURETY CO - Merchants Bonding Co / (515) 243-8171
PO Box 14498
Des Moines, lowa 50306
AGENT - Cecil W. Powell & Company, Inc/(904) 353-3181
219 N Newnan Street
Jacksonville FL 32202

Have you ever failed to complete work awarded to you. If so, when, where and why?
NO

Have you personally inspected the proposed WORK and do you have a complete plan for its
performance?
YES, but ...IF awarded this job, I need to coordinate with the City of Pembroke Pines how
the electric circuits will be supplied to and terminated at the signs .
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Will you subcontract any part of this WORK? If so, give details including a list of each sub-contractor(s)
that will perform work in excess of ten percent (10%) of the contract amount and the work that will be
performed by each subcontractor(s).

ALL of the construction work including sign foundations and setting of the signs will be
personally performed by me and my crew. The only subcontractor, which will provide final electric
connections and Post- Installation Maintenance, Repairs & Warranty Support will be -

Bob Scott Light, Power & Sign (West Park, FL)

The foregoing list of subcontractor(s) may not be amended after award of the contract without the
prior written approval of the Contract Administrator, whose approval shall not be reasonably
withheld.

List and describe all bankruptcy petitions (voluntary or involuntary) which have been filed by or against the
Proposer, its parent or subsidiaries or predecessor organizations during the past five (5) years. Include
in the description the disposition of each such petition.

NONE

List and describe all successful Bond claims made to your surety (ies) during the last five (5) years. The list
and descriptions should include claims against the bond of the Proposer and its predecessor
organization(s).

NONE

List all claims, arbitrations, administrative hearings and lawsuits brought by or against the Proposer or its
predecessor organizations(s) during the last (10) years. The list shall include all case names; case,
arbitration or hearing identification numbers; the name of the project over which the dispute arose; and a
description of the subject matter of the dispute.

NONE

List and describe all criminal proceedings or hearings concerning business related offenses in which the
Proposer, its principals or officers or predecessor organization(s) were defendants.
NONE

Has the Proposer, its principals, officers or predecessor organization(s) been CONVICTED OF A Public

Entity Crime, debarred or suspended from bidding by any government entity? If so, provide details.
NO

Are you an Original provider sales representative distributor, broker, manufacturer other, of the
commodities/services proposed upon? If other than the original provider, explain below.
Dowling Construction Co is purchasing the signs from a Watchfire Wholesale Dealer.

Have you ever been debarred or suspended from doing business with any governmental agency? If yes,

please explain:
NO
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Describe the firm’s local experience/nature of service with contracts of similar size and complexity, it the
previous three (3) years:
1. City of Belle Glade (Monument Sign @ City Hall)

2. South Broward HS (Freestanding LED Sign on Fed Hwy)

3. Miami Central HS (Freestanding LED Sign)

4. Miami Carol City HS (Freestanding LED Sign)

Note: All within 7 years

5.NOT LOCAL BUT CURRENT - Pinellas County Schools (St Pete/Clearwater/Largo/ Tarpon
Springs) - Currently in the 5th Year of a Multi-Sign Contract to Supply & Install a total of 110
Freestanding LED Signs (71 Complete / 39 to Go).

The PROPOSER acknowledges and understands that the information contained in response to this
Qualification Statement shall be relied upon by CITY in awarding the contract and such information is
warranted by PROPOSER to be true. The discovery of any omission or misstatement that materially affects
the PROPOSER’s qualifications to perform under the contract shall cause the CITY to reject the Bid, and if

after the award, to cancel and terminate the award and/or contract.

Dowling Construction Company
(Company Name)

Heywood A DOWLING
(Printed Name/Signature)
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Attachment M
e :’J City of Pembroke Pines
REFERENCES FORM

Provide specific examples of similar contracts. References should be should be capable of explaining and
confirming your firm’s capacity to successfully complete the scope of work outlined herein. This form
should be duplicated for each reference and any additional information that would be helpful can
be attached.

Reference Contact Information:
Name of Firm, City, County or Agency: Pinellas County School Board

Address: Walter Pownall Service Center @ 11111 South Belcher Rd
City/State/Zip: Largo, FL 33773

Contact Name: Mike McClimonTitle: Project Manager / Electrical Planner
E-Mail Address: mcclimonm@pcsb.org

Telephone: (727) 638-3373Fax:

Project Information:
Name of Contractor Performing the work: Dowling Construction Co

Name and location of the project: Bid no. RFP #18-968-258-SS Electronic Digital Signs &
Installation

Nature of the firm’s responsibility on the project: All signs on this project are 13" to 15" Tall
Freestanding Digital Signs with Concrete Foundations.

Dowling Construction Co is the Bid Awardee and Prime Sign Contractor which entails turnkey
responsibility for engineering, specific-purpose land surveys, soil testing, foundation work, sign
supply & installation and electrical and data systems for each of approximately 70 sites since
2014.

Project duration: PHASE 1: 4 Years PHASE I1: 2 YearsCompletion (Anticipated) Date: August 2020
with TWO Possible One-Year Extensions

Size of project: PHASE 1: 60 Signs / PHASE 11: 40 Signs Cost of project: PH I: $2M / PH I1: $1.6M

Work for which staff was responsible: ALL work is performed, supervised or managed by Dowling
Construction Co although we subcontract the surveys, soils testing, electrical work and mostly
installation of the signs.
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Contract Type: Individual Lump Sign Contracts(Purchase Orders) with a Contingency Allowance
for each site
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The results/deliverables of the project: At the close of each school sign installation, we submit
Asbuilts, Soil Report and Warranty

REFERENCES FORM

Provide specific examples of similar contracts. References should be should be capable of explaining and
confirming your firm’s capacity to successfully complete the scope of work outlined herein. This form
should be duplicated for each reference and any additional information that would be helpful can
be attached.

Reference Contact Information:
Name of Firm, City, County or Agency: Guthman Signs

Address: 519 Interstate Court

City/State/Zip: Sarasota FL 34240

Contact Name: Mark GeorgeTitle: Sign Consultant
E-Mail Address: mark@guthman.com

Telephone: (904) 254-5982Fax:

Project Information:
Name of Contractor Performing the work: Dowling Construction Co

Name and location of the project: Multiple Signs on Military Bases throughout the USA including Ft
Bliss TX, Beale AFB, NB San Diego, Ft Jackson SC, Ft Polk LA, Ft Buchanan PR. Camp
Lejeune NC, Marine Base 29 Palms CA, Edwards AFB CA, NAS Mayport, NASA @ Cape
Kennedy FL, McDill AFB FL - List Available on Request

Nature of the firm’s responsibility on the project: Some Sign Installations included the cost of the sign
but most jobs were for ALL tasks related to the Installation Services only, including logistics and
cost related to a traveling crew, military base access, lodging, foundation work, crane work and
electrical and data connections.

Project duration: Typically 10 days per Sign ProjectCompletion (Anticipated) Date: All completed to
date.

Size of project: One to Seven Signs per Military Base Cost of project: Typically $10,000 per job

Work for which staff was responsible: Heywood Dowling personally performed all of these sign
installations with staff although certain tasks were subcontracted such as crane work and some of
the electrical work.

Contract Type: Lump Sum
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The results/deliverables of the project: Close-Out Docs - Quality Assurance Form and Photos
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REFERENCES FORM

Provide specific examples of similar contracts. References should be should be capable of explaining and
confirming your firm’s capacity to successfully complete the scope of work outlined herein. This form
should be duplicated for each reference and any additional information that would be helpful can
be attached.

Reference Contact Information:
Name of Firm, City, County or Agency:

Address:
City/State/Zip:
Contact Name: Title:
E-Mail Address:
Telephone: Fax:

Project Information:
Name of Contractor Performing the work:

Name and location of the project:

Nature of the firm’s responsibility on the project:
Project duration: Completion (Anticipated) Date:
Size of project: Cost of project:

Work for which staff was responsible:

Contract Type:

The results/deliverables of the project:
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REFERENCES FORM

Provide specific examples of similar contracts. References should be should be capable of explaining and
confirming your firm’s capacity to successfully complete the scope of work outlined herein. This form
should be duplicated for each reference and any additional information that would be helpful can
be attached.

Reference Contact Information:
Name of Firm, City, County or Agency:

Address:
City/State/Zip:
Contact Name: Title:
E-Mail Address:
Telephone: Fax:

Project Information:
Name of Contractor Performing the work:

Name and location of the project:

Nature of the firm’s responsibility on the project:
Project duration: Completion (Anticipated) Date:
Size of project: Cost of project:

Work for which staff was responsible:

Contract Type:

The results/deliverables of the project:
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REFERENCES FORM

Provide specific examples of similar contracts. References should be should be capable of explaining and
confirming your firm’s capacity to successfully complete the scope of work outlined herein. This form
should be duplicated for each reference and any additional information that would be helpful can
be attached.

Reference Contact Information:
Name of Firm, City, County or Agency:

Address:
City/State/Zip:
Contact Name: Title:
E-Mail Address:
Telephone: Fax:

Project Information:
Name of Contractor Performing the work:

Name and location of the project:

Nature of the firm’s responsibility on the project:
Project duration: Completion (Anticipated) Date:
Size of project: Cost of project:

Work for which staff was responsible:

Contract Type:

The results/deliverables of the project:
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